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License & Copyright 
Maxsurf Program  
© 1985-2006 Formation Design Systems 
Maxsurf is copyrighted and all rights are reserved. The license for use is granted to the 
purchaser by Formation Design Systems as a single user license and does not permit the 
program to be used on more than one machine at one time. Copying of the program to 
other media is permitted for back-up purposes as long as all copies remain in the 
possession of the purchaser. 
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All rights reserved. No part of this publication may be reproduced, transmitted, 
transcribed, stored in a retrieval system, or translated into any language in any form or by 
any means, without the written permission of Formation Design Systems. Formation 
Design Systems reserves the right to revise this publication from time to time and to 
make changes to the contents without obligation to notify any person or organization of 
such changes. 
 
DISCLAIMER OF WARRANTY 
Neither Formation Design Systems, nor the author of this program and documentation 
are liable or responsible to the purchaser or user for loss or damage caused, or alleged to 
be caused, directly or indirectly by the software and its attendant documentation, 
including (but not limited to) interruption on service, loss of business, or anticipatory 
profits. No Formation Design Systems distributor, or agent, or employee is authorized to 
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About This Manual 
This manual describes the Maxsurf program and is divided into five chapters. It uses a 
learn-by-example method and introduces you to the features of Maxsurf in a step-by-step 
manner. 
 
Many of the examples given use designs supplied with your Maxsurf application and 
contained in a folder titled 'Sample Designs'. 
 
If you are unfamiliar with your computer you should read your owner's manual. This will 
introduce you to commonly used terms such as click and drag, and the basic methods for 
using any Windows application.  
 
The chapters in this manual are as follows: 
 
Chapter 1 Introduction: What is Maxsurf? 
 
Chapter 2 Basic Principles: An introduction to the concept of the NURB surface and how 
its shape is controlled by a net of control points.  
 
Chapter 3 Getting Started: A learn-by-example session of Maxsurf's fundamental surface 
modelling features resulting in the creation of your first design.  
 
Chapter 4 Maxsurf Windows: Outline of different features available in each of the 
windows in Maxsurf. 
 
Chapter 5 Using Maxsurf: Further explanation on how to manipulate surfaces, do 
calculations and import and export data.  
 
Chapter 6 Maxsurf Reference: A list of each menu item and command, which may be 
used as a quick reference whenever you are using the program. 
 
Many of the examples given in the manual have intentionally been kept as simple as 
possible so that you can clearly see how each of Maxsurf's functions behaves. By reading 
the manual and experimenting with the sample designs, you will very quickly become an 
expert user. 

Note 
In case you are new to Maxsurf it is highly recommended to read the first 
two chapters of this manual as well as work through chapter three. This will 
give you a good understanding of fundamental concepts and functions in 
Maxsurf. 
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Chapter 1 Introduction 
Maxsurf is a powerful three-dimensional surface modelling system for use in the field of 
marine design. It provides you with a clear and familiar environment in which to work, 
allowing for systematic experimentation and rapid optimisation of any new design.  
 
Maxsurf's multiple surface capabilities, allowing any number of surfaces to be modelled 
in any given design, offer scope for the creation of a wide range of hull forms. Combined 
with the built-in hydrostatic calculations, you have the tools to experiment with shapes 
and explore design parameters.  
 
Highly accurate output is produced in the form of hull lines, transfer files for other 
programs, and comprehensive offsets tables. Data transfer to other programs in the 
Maxsurf suite is from a Maxsurf design file, alleviating the need for the re-entry of data 
once a design has been finalized, and removing the possibility of loss of accuracy 
through the use of incomplete hull offset files. 
 
The above features offer you a truly integrated system. Each of the modules in the 
Maxsurf range work from the same data file and each share a common user interface.  
 
Continue reading: 

• Chapter 2 Basic Principles on page 5 
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Chapter 2 Basic Principles 
This chapter outlines the concepts on which the program is based. 
 
Hulls, appendages and superstructures are defined in Maxsurf using one or more 
surfaces. Typically a surface is used between discontinuities in the design. For example, 
a three surface design of a sailing yacht might be made up of one surface for the hull, one 
for the keel and one for the rudder. A five surface design for a workboat might use one 
surface for the upper hull from sheer line to chine, a second surface for the chine, a third 
surface for the lower hull from chine to keel, a fourth surface for the deck and a fifth 
surface for the transom. Designs may contain any number of surfaces. 
 
Surfaces are defined in Maxsurf by the position of a set of control points that collectively 
form a control point net. Movement of these control points allows you to manipulate a 
surface into a desired shape.  
 
Central to the process of modelling designs using Maxsurf is an understanding of how 
control points may be used to attain the surface shapes that you wish to achieve, and this 
is best explained by the following analogy. 
 
In this chapter: 

• The Spline and Spring Analogy 
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The Spline and Spring Analogy 
Historically, naval architects have used flexible battens, or splines to draw smooth two-
dimensional curves. By fixing the end points of the spline and applying a load at one or 
more points along the spline, a curve is created that can then be traced onto a drawing. 
The curve's smoothness will depend on the stiffness of the spline and the exact placement 
of the loads, but as long as a few simple rules are followed, the resulting curvature will 
be smooth. 
 
The spline will initially lie straight on the drawing board. 

 

After dragging the spline at a number of points, the natural stiffness of the spline will 
result in the smooth curve used for drawing. 

 

To generate its curves, Maxsurf uses a mathematical equation, the B-spline, which is 
analogous to this procedure. As with drafting splines, curves are defined by the position 
of their end points, the location and number of controlling points along the curve, and the 
stiffness of the spline.  
 
Rather than a row of weights that sit along the spline, Maxsurf's curves are shaped by 
control points, which can be thought of as being attached to the spline by springs. When 
the control points are moved the inherent stiffness of the spline and the springs combine 
to keep the curve smooth. An obvious effect of this is that the control points do not lie on 
the curve created but rather the curve is attracted toward the position of the control 
points. 
 
Thus, a spline, which is initially straight, is dragged to a new shape at a number of 
points. 

 

The resulting curve is smooth with only the two end control points lying on the curve. 
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By moving the controlling points about, you can bend the spline to a given shape. The 
curvature of the spline would be free from irregularities, due to the elasticity of the 
springs and the stiffness of the spline itself. If the spline were made more flexible or 
stiffer, the curvature would correspondingly increase or decrease. 
 
Although this is a two-dimensional example, Maxsurf uses an analogous procedure to 
generate its splines in three dimensions to form a surface.  
 
Just as a row of two-dimensional control points can define a two-dimensional curve, a 
network of three dimensional control points can define an entire three-dimensional 
surface.  
 
If you consider a network of three-dimensional controlling points, you can imagine that 
splines could be held along and across the net, hence defining a surface. Maxsurf does 
just this, and uses a network of three dimensional control points to generate a surface. 

 

The net is formed by rows and columns of control points and has four edges and four 
corners. Up to 25 rows of control points may be used, depending on the complexity of 
the desired surface. Note that this limit is for manually defined surfaces, those surfaces 
which have been imported from other CAD programs (in IGES format) may have any 
number of control points. There is no restriction on the number of columns of control 
points. The surface may have different stiffness in the row and column directions. 
 
A surface is created by the generation of splines in three dimensions from the control 
points that make up the net.  
 
The effect a control point has on a surface depends firstly on whether it is a corner, edge 
or internal control point. 
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• Corners of a surface are defined exactly by the position of the corresponding 
corner of the net. 

• Edges are defined only by the control points on the corresponding edge of the net. 

• Internal points of the surface may be influenced by many or all of the control points 
in the net. 

 

 

 

Any number of independent surfaces may be used in the definition of a design in 
Maxsurf, each with its own control point net. A control point only influences the surface 
to which it belongs. The only exception to this is the case where two surfaces are bonded 
together along a common edge. If a control point is moved on a bonded edge it will 
affect both of the surfaces sharing the bonded edge. 
 
When using Maxsurf, remember that you are changing the position of control points 
relative to one another in the net to achieve a desired change in the surface. Maxsurf will 
then recalculate and display the new surface shape. Just as in the spring analogy you may 
only change the shape of a surface by moving control points in the net rather than 
directly moving the surface itself. 
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Chapter 3 Getting Started 
In this chapter you will be guided step by step through installation of the software, shown 
the basic control and display functions of Maxsurf and then guided through the 
development of a simple single surface design. 
 
In this chapter: 

• Installing, Starting and Opening 

• Creating your first Design 
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Installing, Starting and Opening 
This section contains: 

• Installing Maxsurf 

• Starting Maxsurf 

• Opening an Existing Design 
 

Installing Maxsurf 
Install Maxsurf by inserting the CD and running the Setup program, and then follow the 
instructions on screen. 

Starting Maxsurf  
When you start the program, Maxsurf will show its title screen before displaying all 
currently open windows. For the time being you will only be concerned with the drawing 
windows, which show the shape of a design. The drawing windows are titled: 

• Plan 

• Profile 

• Body Plan 

• Perspective 
 
Other windows exist for the input or display of data and may be accessed by selecting 
their name from the Windows Menu. The data windows are titled: 

• Calculations 

• Control Points 

• Markers 

• Surfaces 

• Offsets 

• Curve of Areas 
 
Their individual functions will be described in full later in this manual. 
 
All the windows will be blank until you open a design, but you may click any window to 
make it the top or active window. A window may also be brought to the top by selecting 
its name from the Windows menu. The number of open windows and their respective 
positions are saved every time you exit Maxsurf and recalled the next time you open the 
program.  

Windows Registry 
Certain preferences and settings used by Maxsurf are stored in the Windows registry. It 
is possible for this data to become corrupted, or you may simply want to revert back to 
the default configuration. To clear the Maxsurf preferences, start the program with the 
Shift key depressed. You will be asked if you wish to clear the preferences, click OK. 
 
This will reset the following back to the default values or settings:  
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• Window sizes and ordering 

• Colour settings from the Colour picker dialog in the view menu 

• Fonts and Toolbars 

• All Maxsurf preferences from the Preferences dialog in the view menu 

• Units 

• Surfaces that have been added to the Add Surface menu by the user 

• Print Scales added by the user and paper setup 

• Light settings used in perspective view when rendering is turned on 

Note: 
If you just want to reset your windows layout and toolbars it is 
recommended to use the Restore Default Layout command from the 
Windows menu. See Customising Toolbars on page 194 for more 
information.  

Menu Items, Keyboard Shortcuts and Toolbars 
All Maxsurf's commands are accessed through menu commands or dialog boxes, which 
are displayed as a result of selecting a menu command. In this manual, references are 
made to the menu commands. However, to facilitate the ease of use of the program, there 
are many keyboard shortcuts and toolbar buttons for frequently used commands.  
 
The keyboard shortcuts, when available, are displayed next to the menu item, which they 
invoke. The toolbar functions are documented in Chapter 6 Maxsurf Reference, in 
addition some other special features, which require special keystrokes, are summarised in 
Appendix C Command Keys. 
 
When you learn about a new command, it is worth familiarising yourself with its 
keyboard shortcut and toolbar button as this will greatly improve your productivity. To 
display a short hint about what a particular toolbar button does, simply place the mouse 
pointer over the button; a more detailed explanation is given in the status bar at the 
bottom left of the main window. 
 
Some of the windows have special context menus, which are enabled by clicking the 
right mouse button whilst in the window. This can be particularly useful for copying and 
pasting data into tables that are in dialogs, since the main menu will be unavailable. 

Opening an Existing Design 
To familiarise yourself with the basic functions of Maxsurf you should now open an 
existing design.  

• Select the Profile window from the Windows menu. 

• Click in the zoom box in the upper right hand corner of the windows, or drag the 
bottom right hand corner of the window to expand the window to full screen size.  

• Select Open from the File menu. 

• Select the design called Maxsurf Sample_Trawler from the Program 
Files\Maxsurf\Sample Designs directory. 

 
The design will be displayed by the outline of its surface edges, represented as solid 
lines. The first thing to do is unlock the model; 
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• Go to Locking in the Surfaces menu.  

 

• Either click on the surface name, or use the “Unlock All” button to unlock all 
surfaces.  

• Click OK 
 
The profile view of your model should now look like this:  

 

Together with the surface edges you will also see some squares joined by light blue lines. 
These squares are the control points that affect the surface shape. Four of the control 
points on each surface will be painted purple indicating that they are surface corner 
points. Across the window is a yellow line, this is the Datum Waterline (DWL). 
 
At the bottom of the Profile window there are four position indicators, which give the on 
screen position of the cursor in real world coordinates. The first two indicators show the 
longitudinal and vertical location of the cursor, and the second pair of indicators show 
the angle and distance of the cursor from the last point clicked. The indicators are 
updated as you move the cursor. The position indicators are also present in the Body Plan 
and Plan windows. 
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Moving a Control Point 
To change the shape of an edge or any other part of a surface, you must select a control 
point or group of control points by using the cursor. When a control point is selected it 
becomes highlighted by a surrounding white square and the interior of the control point 
is filled with black. The selection may then be moved by dragging it to a new location. 
You may de-select any selection by clicking in the background of any of the drawing 
windows. 
 
Several options are available to you for the selection of control points: 

Individual Point 
An individual control point may be selected and moved by pointing to it and then 
pressing the left mouse button and dragging the control point to a new location.  
 
The control point will invert its colour to indicate that you have selected it.  

Continuous Group of Points 
Alternatively, use the selection box to select a group of control points by pressing the 
mouse button and dragging the selection box around the group that you wish to move. 

 

Discontinuous Group of Points 
A discontinuous selection of control points may be made by holding down the Shift or 
the Ctrl key and adding to the selection by clicking on control points that you wish to be 
included in the selection.  

 

 
Having found out how to select control points with the cursor, you may now go ahead 
and modify the profile view of the design that you have just opened by performing the 
steps in the following example: 
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• First save the design to a new file by selecting “Save as” and naming the file 
differently or saving it to a different folder.  

• Select the indicated control point with the cursor. 

• Click and drag the control point to a new location as shown. 

 

If you make a mistake, you may wish to undo the change that you have just made to the 
design and return it to its shape prior to the control point movement. To do this: 

• Select Undo from the Edit menu (You can also use the Ctrl + Z shortcut). 
 
Most of the Maxsurf commands may be undone in the same way. Commands may be 
redone by selecting Redo from the Edit menu, or by using the Ctrl Y shortcut. 
 
A control point may be constrained in its movement by holding down the Shift key while 
dragging the point. The constraint restricts movement to the longitudinal, transverse or 
vertical directions.  
 
To perform a constrained move: 

• Select a control point 

• Click and drag, while holding down the Shift key 
 
Movement will be constrained to either the horizontal or vertical direction depending on 
the movement of the mouse. If you release the shift key, you are returned to 
unconstrained movement. 
 
To produce small movements, the control points may be nudged using the arrow keys. 
 
Experiment with the various methods for selecting and moving the control points to 
modify the sheer line of the IOR yacht. 
 
Control point movement in any other of the drawing windows works in exactly the same 
way. 
 
For symmetrical surfaces, when moving a control point, a group of control points, or 
complete surfaces, movement is constrained by the centreline to prevent you from 
dragging the points across the line of symmetry. You can hold down the Ctrl key while 
dragging to override this constraint. 
 
Having examined the basic functions of Maxsurf, you can now go on to learn how a 
simple net of control points may be used to develop your first design. 

• Select Close from the File menu. 

• Reply No to the Save Design Changes prompt. 
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Creating your first Design 
In this first example, we will use only one surface, but modelling hulls with multiple 
surfaces is a simple extension of the techniques that follow. The number of surfaces 
available in Maxsurf Pro is limited only by the memory configuration of your computer. 
However, in the other versions, the maximum number is fixed. 
 
A design begins with one of the standard surfaces (or an existing design). You then 
modify the shape of the surface's four edges, followed by its interior. The longitudinal 
edges are best modelled before the transverse edges, and it is generally best to form the 
edges in the horizontal plane (the Plan view) prior to the vertical plane (the Profile view). 
Having defined the edges you may then go on to manipulate internal points in the net to 
create the required surface shape, this is best done in the Body Plan view. 
 
The control point net is made up of longitudinal rows and transverse columns. Columns 
of control points may be added and deleted in the Plan and Profile views, while rows of 
control points may be added and deleted in the Body Plan view. 
 
The addition of control points increases the density of the control point net and the local 
control of the surface shape. Increasing the number of control point rows enables greater 
control of the transverse curvature and is useful for hulls, which have complex section 
shapes; increasing the number of control point columns, enables greater control of the 
longitudinal curvature of the hull. 
 
This section contains: 

• Adding a Surface 

• Setting up your Units 

• Modelling Edges 

• Setting your Frame of Reference 

• Setting up your Grid 

• Viewing in 3D 

• Saving Your Design 

• Showing the Net 

• Inserting Control Points 

• Setting Surface Stiffness 

• Removing Control Points 
 

Adding a Surface 
To begin your first design close any design that is currently open and then make sure the 
Plan window is in front.  

• Select New Design from the File menu.  
 
This creates a new design with no surfaces 

• Select Default from the Add Surface sub-menu under the Surfaces Menu.  
 
This inserts a new U-shaped surface into your design. 
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This surface is created with a simple 3 by 3 net of control points. This surface is half U-
shaped in cross-section; since it is symmetrical it forms a full U-shaped ‘hull-like’ 
surface. 
 
The shape of the new surface is shown below. Examine it by selecting the drawing 
windows from the Windows menu, you may wish to use the Zoom, Shrink and Pan 
commands to fit the surface inside the window.  

 

In this first design you are aiming to design a simple canoe body with a closed bow and 
open transom. 

 

Your task is to modify the default surface into the above shape. This may be done by 
manipulation of control points in the Plan, Profile, and Body Plan windows. The 
following sections guide you through the necessary steps. 

Setting up your Units 
Before you start modelling, you should set up the units and overall dimensions for your 
design. 

• Choose Units from the Data menu. 

 

• Select either Metres or Decimal Feet as your preferred units 

• Click OK 
 
Next set up the overall starting size of the surface you have inserted into the design. 
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• Choose Size Surfaces from the Surfaces menu. 

 

Type in the following dimensions 
 
Value Feet Meters 
Length 24 7.32 
Beam 12 3.66 
Depth 2 0.61 

• Click OK 
 

Modelling Edges 
To modify the sheer line plan you should move control points in the Plan window.  

• Bring the Plan window to the front by choosing Plan from the Window menu. 

• Select the top right hand corner points of the surface. 
 
Use the selection box to do this. In this selection you have in fact selected two control 
points, one being the corner control point and the other being an intermediate control 
point in the right hand edge. 

 

• Drag the selected points down to the centreline so that they lie on top of the other 
point there.  

 
This closes the bow by placing all the forward points on the centreline. Note how the 
sheer line plan changes shape. 
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You have now successfully completed the closure of the bow, as all control points on the 
right hand edge now lie on the centreline.  
 
You may now proceed to model the transom. 

• Select the top left sheer line control points using the selection box 
 
Again, with this selection, you have selected a corner point and an intermediate control 
point directly beneath it. 

 

• Click and drag them down slightly to the new location as shown 

 

You have now defined a suitable sheer line plan. All that remains is to generate the 
profile view. Remember that the default surface already has a sectional shape and we 
will simply use this shape to satisfy this first design. 

• Select the Profile window. 

• Select the Shrink command from the View menu to reduce the size of the image. 
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In the Profile window you will see the following shape. The sheer line edge is 
uppermost, and the centreline edge is below it. 

 

You may now model the sheer line profile.  
• Select the bow corner point as shown. 

 
There are no intermediate points here so it is not necessary to select the point with a box. 

• Click and drag it up slightly to the new location. 
 
Note how the sheer line profile moves with it. 

 

To model the foot of the bow, you must separate the corner and intermediate control 
points at the foot of the bow. 

• Select and drag the two superimposed control points, one by one, to positions 
shown below. 

 

You may model the rest of the centreline profile by dragging the intermediate control 
point downwards. 
 
The transom may be completed in a similar manner. 
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• Select the upper transom corner point. 

• Drag it to a new location to model the desired sheer line profile. 

• Select the lower transom corner points using the selection box. 

• Drag them downwards to a new location to model the lowest point of the transom 
on the centreline. In this selection you are moving both the corner point and the 
intermediate control point of the left hand edge. 

 
The resulting shape will look similar to the diagram below. 

 

Finally you will need to position the design in the correct location relative to the DWL 
(Datum Water Line). This is the horizontal yellow line running across the window. 

• Select Move Surface - Freeform from the Surfaces menu 

• Click on any control point and drag the surface upwards until the bottom of the 
bow and the bottom of the transom are just below the yellow line (DWL). 

 

Setting your Frame of Reference 
Many of the dimensioning and calculation functions in Maxsurf require you to correctly 
set up the frame of reference which describes the location of key points such as baseline, 
amidships, forward perpendicular and aft perpendicular. 
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• Choose Frame of Reference from the Data menu 

 

• Click on the Find Base button 
 
This will automatically set the baseline to be at the lowest point of the design 

• Click on the Set to DWL button 
 
This will automatically set the forward and aft perpendiculars to lie at the ends of the 
DWL. Amidships will be positioned at the point mid way between the AP and FP. 

• Click the OK button 
 

Setting up your Grid 
To view the shape of your design, you need to display contours on the hull such as 
sections, waterlines, and buttock lines. These contours are defined by a grid, which 
contains spaced longitudinal, vertical and transverse coordinates. These define the 
locations of the sections, waterlines and buttock lines respectively. 

• Choose Grid Spacing from the Data menu 

 

• Click on the Add button 
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A dialog will appear allowing you to specify the number of sections to be added 

 

• Type in 10 to add 10 sections 

• Click OK 
 
This will return you to the Grid Spacing dialog box. 

• Click on the Space button 
 
The Spacing dialog will appear. The default setting, which you will use, is to evenly 
space the sections along the DWL. 

 

• Click OK 
 
This will return you to the Grid Spacing dialog box. 

 

• Click OK 
 
You will now see your grid displayed behind the design in the Profile window. 
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The Stations (or Buttocks, Waterlines, Diagonals) can be sorted according to their 
position by clicking the “Sort” button. Repeated clicks will toggle between sort 
ascending and sort descending. 

Viewing in 3D 
Change to the Perspective window and you will see that you have already achieved the 
required shape. 

 

To better visualise the shape of your design: 
• Choose Hide Grid from the Grid sub-menu under the Display menu 

• Choose Contours… from the Display menu 

• Turn on the Sections check box 

• Click OK 
 
Your completed design will be displayed along with the sections you have defined. 
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Saving Your Design 
You should now save your first design. If you are using the Maxsurf demo, saving is 
disabled and you should skip this section. 

• Select Save Design As from the File Menu. 
 
Type in the name of your design and select the folder that you wish to store it in, then 
click the Save button.  
 
Maxsurf design files are extremely small in size, typically less than 20K. 

Showing the Net 
Whenever you move control points you must be aware of how they relate to the position 
of other control points in the net. The net should generally be set up so that a row or 
column of control points lie in, or close to, the same plane. 
 
To show the net of control points 

• Use the Contours command from the Display menu to turn off the display of 
sections 

• Select Net - Show Net from the Display menu to turn on the net 

• Select Half from the Display menu so that only one half of the symmetrical design 
is displayed 

 
Note the position of the intermediate control point in this simple 3 by 3 net, and relate the 
surface shape to the control point positions. 

 

Click to the other drawing windows and examine how the net relates to the shape by 
examining the shape and net displays. 

Maintaining a Clean Net 
In the development of your first design, control point movements were kept very simple, 
since you only moved the edges of the surface. The result was what is termed a 'clean 
net'. All the control point rows and columns were positioned in an ordered fashion with 
no irregularities in the net.  
 
In most cases you should restrict control point movement to the vertical and horizontal 
directions in the Profile and Plan windows respectively. This prevents the following 
situation, where a badly placed net shows an irregular parametric surface, and distorted 
waterlines. 
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The diagrams below show how the net should be arranged, with columns running in near 
straight lines, and rows running close to the waterline shape that is described in the 
Shape display. 

  

A good way of familiarizing yourself with the way in which nets should be arranged is to 
examine the designs supplied with Maxsurf in the Sample Designs folder. 

Body Plan  
So far you have only worked with control point movement in the Plan and Profile views. 
We will now look at some techniques for manipulating the transverse shape of the design 
by working in the Body Plan view. 

• Make the Body Plan window topmost 

• Turn on the net using the Net command from the Display menu 

• Turn off Half using the Half command from the Display menu 
 
The sections of your design can be viewed in this window. Note the control box, which is 
displayed in the upper right hand corner of the window: 
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The Body Plan window with the Net displayed and Half display turned off. Note the control box in the top right.  

The Control Box 
The control box provides a means of accessing the transverse columns of control points 
for the current surface allowing you to modify sectional shape. 

Station indicator Current section

Current column of current surface Column indicator  

For example, to modify a section near the bow, you would wish to change the position of 
the control points in the column closest to that section. The control box allows you to 
choose which column you wish to work on and which section you wish to see displayed 
with it. 
Changing the Current Section 

Across the control box there is a vertical line. This line is the current section, and 
corresponds to a section taken through the hull that is displayed in the Body Plan 
and Perspective windows. By clicking in the top of the control box, the current 
section can be moved to a new location. 
 
The section positions are set by the Sections option of the Grid Spacing dialog in 
the Data menu. When all the sections are displayed the control box will show lines 
under all the station indicators. 

Changing the Current Column 
Underneath the control box is a row of small pointers. These are column pointers 
and correspond to the columns of control points running transversely around the 
current surface. One pointer is highlighted, indicating the current column of 
control points displayed in the Body Plan window.  
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Note:  
If the Net is turned on, all columns will be visible rather than just the current 
column. Normally you will want the Net turned off if you wish to work with 
one column at a time. 

By selecting the appropriate column pointer you may vary sectional shapes along 
the length of the design. Whenever you select a column pointer the station nearest 
to that column is displayed. 
• Turn off the net using the Net command from the Display menu 

• Select the middle column pointer. 
 

This will display the middle column of control points and the section closest to it. 
The other control points you see on the screen are the surface edge control points 
that define the deck, transom, bow and profile shape. 
• In the Body Plan window, drag the middle control point to modify the section 

shape.  
 

This will modify the sectional shape of the current section, which will be redrawn 
while you move the control point in the current column. 

 

Inserting Control Points 
It is always advisable to use the minimum number of carefully placed control points to 
achieve the desired features. This is preferable to inserting a large number of control 
points, as this will lead to many control point movements to achieve the same result. 
 
Your first design used a simple 3 by 3 control point net, and you will now go on to 
increase this to a 4 by 4 net. There is no need for the number of controls to be the same in 
both directions, a 16 by 3 or a 10 by 2 is equally usable; a 4 by 4 is used purely for the 
sake of this example. 
 As you have previously learned, rows run longitudinally and columns run transversely in 
the control point net. To insert a column you must add a control point in the Plan or 
Profile window, while to insert a row, you must add a control point in the Body Plan 
window. 

Note:  
The number of rows of control points is limited to 25. 
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Adding a Row 
Your existing 3 by 3 net configuration looks like this. 

 

A row or column is always inserted into the current surface. To make any surface the 
current surface, simply select any control point in that surface. In your first design this 
will not be a problem as you are only using one surface so it will always be the current 
surface.  
 
To increase control of the sectional shape, you should add another control point row into 
the design. For clarity, ensure that the Net display is turned off. 

• Select the middle column pointer at the bottom centre of the control box. 
 
It is not mandatory to choose this pointer, but we will for this example. 

• Select Add Row from the Controls menu. 
 
The Add cursor allows you to select a suitable location for the new row. 

 

• Click the mouse button to insert the control point row. 

Note: 
The current section changes shape slightly and the column is redrawn with 
the new control point included. You can then drag the control points to get 
the shape amidships that you require. 
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Change to the Perspective window and display the net view. Note that the additional row 
has been inserted through all the existing columns. 

 

If you wish to insert a control point row with the whole net visible, you need to tell 
Maxsurf which column the point is to be inserted into. Do this by first highlighting 
any control point in the column you will insert the new row into.  

  
 

 
To make sure Maxsurf inserts the row in the right location, first select a control point and then add a control 

point row. 

Note: 
Selecting a control point on the control point net, will activate the associated 
column and row. For example selecting a control point on row 2, column 4 
will activate row 2 and column 4.  
 
Maxsurf will add the row to the active column. This works the same for 
adding columns to active rows.  

Adding a Column 
You may now go on to add a column of control points into your first design. This will 
increase your control over the sheer line and centreline edges.  
 
You may add a column in the Plan window. Remember, the new column is inserted into 
the current surface, so first of all, select a control point belonging to the surface into 
which you want to insert the new column. 
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• Select the Plan window from the Windows menu. 

• Select Add Column from the Controls menu.  

• Position the Add cursor at the point where you wish to insert the new column on 
the sheer line edge. 

 

 

• Click to insert the new column.  
 
Control points will be added through all existing rows in the net. This will change the 
shape of the design considerably. In the next section you will see how to change the 
stiffness of the surface to improve the surface shape. For now, you have successfully 
completed the expansion of the net to a 4 by 4 net.  
 
Obviously more controls can be inserted to increase the control over the surface shape. 
This is simply a case of repeating the process of inserting control point rows or columns 
in either the Body Plan or Plan windows respectively. 
 
Whenever you are inserting control points, be sure that you have made the surface the 
current surface by selecting one of its control points. 

Setting Surface Stiffness 
To improve the fairness of the hull, now would be a good time to adjust the stiffness of 
the surface. The stiffness of a surface can be controlled independently in the transverse 
and longitudinal directions. 
 
 The stiffness is analogous to the stiffness of the wooden battens used in traditional naval 
architecture. This helps you control how fair the surface is, and how much shape can be 
put into the surface. A more flexible surface will allow more shape, but may be less fair. 
A stiffer surface will help ensure fairness but will not allow you to put so much shape 
into the surface. 
 
In this case we wish to make the design fairer in the longitudinal direction. 

• Select Properties from the Surfaces menu and choose Default from the sub-menu 
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The Properties dialog box for this surface will appear. 

 

• Choose 4 from the Longitudinal Stiffness menu 

• Click OK 
 

Note 
You can only set the surface stiffness in longitudinal direction to 4 if you 
have at least 4 control point columns on that surface. See the Surface 
Stiffness section on page 95 for more information. 

The resulting shape and net will be as shown below. 

 

The sheer line plan may now be redefined by modifying the position of the control 
points. Similarly, in the Profile window, the sheer line and centreline control points may 
be repositioned.  
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Removing Control Points  
Rows may be deleted from the Body Plan window and columns may be deleted from the 
Plan and Profile windows. Control point rows or columns are always deleted from the 
current surface. 
 
For example, to delete a control point column from the Profile window: 

• Select the Profile window from the Windows menu 

• Select Delete from the Controls menu. 
 
When Delete is selected you may choose which row or column you wish to delete by 
placing the 'jaws' of the cursor around any control point in the row or column 

• Click the control point column you wish to delete 

 

This will delete the chosen column.  
 
This completes this brief introduction to Maxsurf. The following chapter provides step 
by step details of all of the functions available in the program. The last chapter provides 
a command reference for all of the menu commands. 
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Chapter 4 Maxsurf Windows 
This chapter explains the many functions available in the Maxsurf windows.  
 
View Windows - General: Generic features in Maxsurf that apply to all view windows, ie 
Body Plan, Profile, Plan and Perspective window.  
 
View Windows: A detailed explanation of the different windows that Maxsurf uses to 
display hull shapes, together with explanations of the various controls within the each of 
them.  
 
Assembly Window: Describes how to use the assembly window to organise surfaces and 
access to some surface commands. 
 
Table Windows: Explains both generic features available when working in any of the 
Table windows in the Maxsurf suite, together with explanations of Table window – 
specific features. 
 
Graph Windows: Explains both generic features available when working in any of the 
Graph windows in the Maxsurf suite, together with explanations of the Curve of Areas 
graph in Maxsurf.  
 
Calculations Window: Explains how to use the Calculations window to create custom 
calculations inside Maxsurf.  
 
Maxsurf Settings: Explains the Maxsurf preferences and display settings. 
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View Windows - General 
The purpose of this section is to cover the various controls and special features that each 
of Maxsurf’s windows contain.  
 
This section describes:  

• Maxsurf Coordinate System 

• Setting the Frame of Reference 

• Setting the Zero Point 

• Setting the Vessel Type  

• Taking Measurements 

• Setting up the Grid 

• Zoom, Shrink, Pan and Home View 
 

Maxsurf Coordinate System 
Maxsurf has defined its views to be consistent with Naval Architecture standards 
throughout all view windows.  

 

+ve forward  -ve aft 
+ve starboard -ve port 
+ve up  -ve down 

 

Window View direction 
Body plan Looking forward from the stern 
Profile view Looking from starboard, bow to the right 
Plan view  Looking from below, starboard above the centreline 

Setting the Frame of Reference 
The Frame of Reference dialog is used to specify the positions of the key locations used 
in ship design. These positions are: 

• Forward Perpendicular 

• Aft Perpendicular 

• Amidships 

• Datum Waterline (DWL)  

• Baseline 
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The DWL is used for all calculations in the Calculations window, calculation of the 
Sectional Area Curve in the Curve of Areas window and calculation of surface areas. 

 

The Frame of Reference dialog has functions to automatically locate the Baseline at the 
lowest point of the hull (the Find Base button) and to set the Fore and Aft Perpendiculars 
to the extreme ends of the DWL (the Set to DWL button). 
 
In all cases where the Forward or Aft Perpendicular is updated, the Amidships position is 
calculated to be at the midway position between the perpendiculars. 

Note:  
All values are entered relative to the Zero Point. However, it may be that the 
zero point is set to the position of one of the elements in the Frame of 
Reference. In this case, the Zero Point is not updated until you click OK in 
the Frame of Reference dialog. 

Setting the Zero Point 
The zero point is the reference point that all measurements are taken from. You may 
choose the position of the longitudinal zero coordinate by selecting from the available 
options: 
Forward Extremity. 

The forward most point of all existing surfaces. 
Forward Perpendicular. 

This is specified in the Frame of Reference dialog where it may be automatically 
positioned at the intersection of the design waterline with the bow. 

Amidships. 
Midway between the fore and aft perpendiculars. 

Aft Perpendicular. 
This is specified in the Frame of Reference dialog where it may be automatically 
positioned at the intersection of the design waterline with the stern. 

Aft Extremity. 
The aft most point of all existing surfaces. 
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The vertical position of the Zero Point may be set to the Datum Waterline or to the 
Baseline. The positions of the forward and aft perpendiculars, Datum Waterline and 
Baseline are all specified in the Frame of Reference dialog. 
 
The forward and aft extremities are recalculated every time you change the design. If you 
have used either of these points to define the longitudinal position of the zero point, then 
the zero point will move as the design is changed unless it is locked. Even if locked, the 
zero point will be recalculated if you set the frame of reference again. 
 
The Zero point is always displayed in the Plan, Profile, Body Plan and Perspective 
Windows as a small vertical cross. 
 
Also see:  

Maxsurf Coordinate System on page 36. 

Setting the Vessel Type 
The vessel type: monohull, catamaran or trimaran, is defined in the Vessel Type dialog. 
This additional model information is used in other programs in the Maxsurf suite. 
Currently Hullspeed uses this information to define the panel arrangement for the slender 
body analysis. The other programs in the Maxsurf suite do not use the vessel type 
information yet. 
 
You should set up the Frame of Reference and Zero Point first. Then, when the design is 
finished, the Vessel Type can be setup. None of this data is changed automatically, so if 
you were to increase the demihull separation of a catamaran, it would be necessary to 
return to this dialog to update the data manually. 
 

Monohull 

 

 



Chapter 4 Maxsurf Windows 

Page  39  

For the monohull vessel type there is nothing more to specify other than that the vessel is 
a monohull from the ‘Number of hulls’ radio items. 

Catamaran 

 

 

In the case of a catamaran, you should select the appropriate radio button and specify the 
offset of the local demihull centreline. Analysis programs, such as Hullspeed, will use 
the local demihull centreline when computing the analysis mesh for the model. 

Trimaran 

 

For trimarans, you must specify the centreline offset location of the outer hull and also 
the transverse extents of the main hull. Again these data are used in analysis programs 
such as Hullspeed. The transverse extents of the main hulls are used to clip the sections 
used in the analysis programs so it is generally sufficient to only include the underwater 
part of the main hull. 
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Setting Units 
The Units that Maxsurf will use to display measurement data and calculation results can 
be set in the Units dialog from the Data menu.  
 
Also see:  

Setting up your Units on page 18, and 
Units on page 210 on how the unit conversion is done in Maxsurf. 

Taking Measurements 
In the design views, other than the perspective view, Maxsurf displays a number of co-
ordinates and measurements in the bottom-left corner of the design views: 

 

These give you the horizontal and vertical co-ordinates of the cursor and the angle and 
distance from the last clicked position. These are displayed in the current units. The 
angle is measured counter-clockwise from the positive horizontal axis. 
 
The horizontal and vertical measurements depend on the current view: If you are in the 
plan view, they will be the longitudinal and transverse co-ordinates; in the profile view, 
the longitudinal and vertical co-ordinates; and in the body-plan view the transverse and 
vertical co-ordinates. 
 
Both the Profile and the Body Plan windows display a horizontal line representing the 
Datum Waterline (DWL). The DWL is set using the Frame of Reference dialog in the 
Data menu. It is used as the waterline for computation of all data listed in the 
Calculations window, as well as the sectional area curve in the Curve of Areas window. 

Setting up the Grid 
The positions of the Sections, Waterlines, Buttocks, and Diagonals form what is called 
the Grid. The grid can be displayed on any window by selecting the Grid command from 
the Display menu. Elements can be added to the Grid by using the Grid Spacing function 
from the Data menu. 
 
The positions for each of the grid elements are stored in individual lists, which may be 
selected by clicking on the labelled buttons in the top right hand corner of the Grid 
Spacing dialog box. 
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The positions of Grid elements are as follows: 
Sections  

Position of each section relative to the longitudinal zero point. Positive numbers 
are to the right (forward), negative numbers to the left (aft) of the zero point. 

Buttocks  
Position of each Buttock relative to the centreline of the hull.  

Waterlines  
Position of each waterline relative to the vertical zero point. Positive numbers are 
above, negative numbers below the zero point.  

Diagonals  
Two columns of figures are provided, centreline height and angle. The centreline 
height is the position of the origin of each diagonal relative to the vertical zero 
point. Positive numbers are above, negative numbers below the zero point. The 
angle is the angle between the diagonal and the centreline as shown below. Angles 
above 90 degrees will give diagonals above the centreline height. 

 

Editing Grid Lines 
To edit a grid line position 

• Select the cell corresponding to the position you wish to edit. 

• Type in a new value.  
 
Dimensions entered in units other than the current units are converted automatically. 
 
Grid Labels can be specified by entering text into the first column of the table. Grid 
labels are used for labelling the grid when printing or plotting, and for inclusion in the 
Table of Offsets. 

Sorting Grid Lines  
To sort grid lines 

• Click the Sort button. 
 
Sorting occurs as follows: 
 

Stations: Longitudinally. 
Buttocks:  Transversely. 
Waterlines:  Vertically. 
Diagonals:  Vertically - centreline height only. 
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Copying and Pasting Grid Lines  
The Grid Spacing dialog allows copy and paste operations to take place on the tables of 
grid names and positions. As the main menu bar is not accessible from within the dialog, 
copy and paste are achieved using the standard command key equivalents, Ctrl C for 
copy and Ctrl V for paste. 

Adding Grid Lines  
To add one or more grid lines 

• Select the row after which the new grid lines are to be added.  

• Click the Add button. 

• Enter the number of grid lines to be added to the list. 

 

All new position fields will be initialized to zero. 
 
The number of Grid elements is limited to the following maxima: 

• 1000 Stations 

•   100 Waterlines 

•   100 Buttocks 

•     50 Diagonals 

Deleting Grid Lines 
To delete one or more grid lines 

• Select the row corresponding to the last of the set of grid lines to be deleted. 

• Click the delete button. 

• Enter the number of grid lines to be deleted. 

• Click OK. 
 
If a range of rows is selected in the Grid Spacing dialog, the corresponding number of 
rows is automatically set in the deletion dialog. These rows will be deleted when you 
click the OK button. 
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Spacing Grid Lines 
To space a group of stations along the Datum Waterline or overall length of the design, 

• Click the Space button. 
 
A dialog will appear with options for spacing the stations. 

 

• Select Evenly Along Datum Waterline or Evenly along the length of the model, as 
desired. 

• Click OK. 
 

To space grid lines at a specific intervals 
• Select From and enter the numbers of the grid lines to space 

 

• Enter the required interval between grid lines. 

• Enter a starting position to space from. 

• Click OK. 
 
You may also specify the range of grid positions by simply selecting those rows in the 
Grid Spacing dialog. In this case, the start and finish grid lines, a default spacing and a 
starting position are set up automatically. 
 
Similar functions are available for spacing the waterlines and buttocks. 

Displaying Contour Lines 
The Contours option allows you to select which contours are drawn on the screen at any 
given time. Any combination of contours may be chosen from the contours dialog. 
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Contours may be passed through your design to give greater definition of the surface. For 
example, you might wish to see your design with the sections displayed at the frame 
spacing you have chosen. To do this you would set the Grid to the required frame 
spacing and then show the section contours for the design. The selected contours are 
displayed on all visible surfaces. 
 
You can set the colour of contour lines by selecting Colour from the View menu. When 
drawing the contours on the surface, Maxsurf uses the Precision as set in Surfaces | 
Precision. See Surface Precision on page 103 for important information on precision. 
 
You may choose to display: 
Sections 

When the Sections are activated, all sections will be shown in the Body Plan and 
Perspective windows, otherwise only the current section will be displayed. 
 
Shown below is a design with 100 stations auto-spaced along the Datum 
Waterline. 

 

Sections 

Buttocks 
Buttocks can be displayed in the Profile and Perspective windows. 

Datum Waterline 
The shape of the Datum Waterline will be displayed in the Perspective window. 

Waterlines 
 Waterlines can be displayed in the Plan and Perspective windows.  
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Diagonals 
When the Diagonals are activated, Diagonals will be displayed in the Plan, Profile 
and Perspective windows. Diagonals are shown as true diagonals in all windows, 
except for the Plan view where they are displayed as perpendicular projections so 
that the diagonal's transverse offset in the Plan view is in fact the distance along 
the diagonal from the centreline to the hull surface. 
 
When both waterlines and diagonals are selected, the Plan will separate them with 
the waterlines above the centreline and the diagonals below the centreline, in the 
traditional manner. 

Edges 
Normally all surface edges will be displayed. However in some cases you may 
wish to hide the surface edges in order to show only the sections. In this case, 
turning off the Edges display will give the following result.  

 

Bonded Edges 
Show or hide all bonded edges. 

Feature lines 
Feature lines are created whenever sufficient control points are compacted together 
to form a hard edge within the surface. To display these features, select the feature 
lines option. The illustration below shows the use of a feature line to create a 
knuckle in a set of bow sections. 
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Parametrics 

Selecting Parametrics displays the parametric surface, or the surface data 
calculated by Maxsurf from which other surface contours are derived. This view is 
useful for the examination of the surface as a whole.  
 
Parametric lines do not lie in any particular plane and give a good indication of 
any inconsistencies in surfaces that might arise due to misplaced control points. 
 
The colour of the parametric curves may be either the colour of the surface or the 
colour defined for parametric curves. Use the option in the Preferences dialog to 
select which you prefer. 

 

Intersections 
Selecting Intersections calculates and highlights all intersection lines between 
surfaces in the Plan, Profile, Body Plan, and Perspective windows. Shown below 
is the intersection line of a bowthruster with the hull. 

 

Trimming curves 
Trimming curves can exist only in models that have been imported from Rhino 
using the File | Import | .3DM Rhino file format. See Importing Rhino .3dm files 
on page 183 for more information.  

Surface Curves 
Surface Curves are curves that are embedded within the surface. At the moment 
these are generated only by the Workshop program, where they are used to define 
stringer paths and plate boundaries. However, a design that has been saved using 
Workshop can display these curves in Maxsurf.  
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Inclined Sections 
Workshop also allows the intersection of arbitrarily inclined planes with the hull. 
The resulting inclined sections can be displayed in Maxsurf.  

Deducted Sections 
These are sections, which have had the skin thickness of intersecting surfaces 
deducted. Skin thicknesses are calculated normal to the surface. For more 
information, see Outside Arrows on page 100 and Surface Materials and Skin 
Thickness on page 101. 

Selecting Contour Lines  
You may select contours in the same way as you select control points (by clicking on 
them or by dragging a selection box around them). Once selected, it is possible to look at 
the curvature of the contour, see Curvature on Contours on page 109. 
 
When the pointer is over a contour or surface edge, the name of the contour or edge will 
be displayed in the status bar at the bottom left of the main window. 

Zoom, Shrink, Pan and Home View 
The Zoom, Shrink, Pan and Home View commands allow you to change the size of the 
drawing in the front window. 

Zooming 
The Zoom function allows you to work on any part of your design by enlarging a 
particular area to fill the screen. 
 
The zoom function works in any of the Maxsurf drawing windows. To zoom in on a 
design: 

• Select Zoom from the View menu (or the keyboard equivalent Ctrl E). 

 

A set of cross hairs will appear that follow the movements of the mouse. These are used 
to set the starting position of the zoom rectangle. 
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• Click and drag the mouse in any direction. 

 

The zoom rectangle will appear and grow as the mouse moves.  
• Release the mouse button. 

 

The view contained in the zoom rectangle will be enlarged to fit the screen. 
 
There is a limit on how far you can zoom, and you will find that after continual zooming 
the image will not enlarge any further. 

Note:  
If, before releasing the mouse button, you decide that you do not wish to use 
Zoom, or that you wish to change the starting position of the zoom 
rectangle, simply return the cursor to within a few pixels of the starting 
position, release the mouse button, and the cross hairs will reappear. 

Shrinking 
Choosing Shrink will reduce the size of the displayed image in an active drawing 
window by a factor of two.  
 
To shrink the displayed image: 

• Select Shrink from the View menu 
or 

• Use the keyboard equivalent, Ctrl R. 
 
Multiple shrinks may be achieved by striking key R the amount of times that you wish to 
shrink while holding down the Ctrl key. 
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Panning 
Choosing Pan allows you to move the image around within a drawing window.  
 
To Pan an image: 

• Select Pan from the View menu. 
 
Move the arrow cursor to anywhere within the window. 

 

• Click and drag to a new position. 
 
The image will move with the cursor until the mouse button is released. 

Mouse Wheel Support 
You can use the mouse wheel to easily zoom into and out of a design. You can use this 
feature if you have a mouse with a ‘wheel’ in the centre of the mouse, i.e. Microsoft 
Intellimouse or Logitech Wheelmouse.  
 
Holding down the mouse wheel to pan is also supported. 
 
Zooming will be directed towards the current mouse position, for example if the mouse 
is above the bow zooming will be directed towards the bow. 

Home View 
When you select Home View a zoomed or panned image is returned to its original state. 
This state may be set at any time for any combination of zooming and panning by 
selecting Set Home View from the View menu.  
 
Maxsurf starts up with default Home View settings, which are based on the Home Views 
in use the last time the program was operated.  
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View Windows 

Body Plan Window 
The body plan window displays the transverse sections as seen from aft of the model. 
Starboard is on the right of the centreline and Portside on the left.  
 
The number of sections and their longitudinal positions is specified in the Grid Spacing 
dialog in the Data menu. 
 
In body plan view there are a number of options to visualise the model shape 

• Display all sections 

• Display one section at a time and use the control box to navigate through the 
sections 

• Display half of the model, with or without split sections 
 

Display All Sections 
To display all the sections, simply tick the sections box in the Contours dialog in the 
Display menu.  
 
If the stations are turned off, only the current station will be displayed in the Body Plan 
and Perspective windows. In the Body Plan window the control box in the top right hand 
corner is used to navigate through the sections. 

Control Box 
In the top right hand corner of the Body Plan window is the control box containing a 
miniature view of the plan shape of all currently visible surfaces. The purpose of the 
control box is to allow you to specify precisely what part of a surface you wish to view 
or modify, by allowing you to select different cross sections and columns of control 
points in that surface.  

 

At the top of the control box several short vertical lines are drawn. These are the station 
indicators; there is one indicator for each of the stations specified in the Grid Spacing 
dialog.  
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The section marker line shows which section is currently displayed.  
The “triangles” on the bottom display the control point columns for the surface you are 
currently working on. The triangles are spaced evenly along the bottom of the control 
box. 
 

 

By selecting the triangles you select a column of control points and display the section 
that is closest to that column. Alternatively, a column is made the current column of its 
respective surface whenever one of its control points is selected in any of the drawing 
windows. 
 

 

 
By clicking at the desired longitudinal position well inside the control box, the section 
closest to that longitudinal position is displayed. By using the arrow keys on your 
keyboard you can then scroll through the sections. The right arrow displays the next 
station forward and the left arrow displays the next station aft. 

Note 
When the cursor is within the control box the horizontal cursor coordinate at 
the bottom of the window refers to the cursor’s longitudinal position on the 
plan shape. 

Markers Display Options In Body Plan Window 
If markers are defined, there are three display modes, chosen from the Markers sub-menu 
in the Display menu: 

• Hide all markers — all defined markers are invisible 

• Markers for current station —only markers with the same longitudinal position as 
the current station are displayed 

• Show all markers — all defined markers are displayed 
 
These display modes are particularly useful when trying to fit a surface to a table of 
offsets. 

Half Hull Display 
The half hull display selects whether both halves of a symmetrical surface are displayed. 
If half is turned on, only the starboard side of symmetrical surfaces will be displayed. 
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When the Half function is not activated, both sides of each symmetrical surface will be 
displayed. However, when Half is activated, the Body Plan window will show either a 
split section view or all sections on one side depending on whether Split Section Display 
is setup correctly. The Split Section Display option is described in greater detail in the 
next section. 

 

Note 
Activating Half function changes the hull display in all view windows. 

Split Section Display  
The Split Section Display affects the way in which sections are displayed in the Body 
Plan window; if enabled, aft sections are displayed on the left and forward sections on 
the right. 
 
The Split Section Display option is only enabled when the half hull display is turned on. 
If Split Section Display is chosen for any surface, it will be displayed with the forward 
side of the hull on the right of the centreline and the aft half of the hull on the left. The 
split section option is specified independently for each surface in the surface's Properties 
dialog and the Surfaces window. 
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If Split Section Display is not chosen, all stations will be drawn over half of the hull on 
the right hand side of the centreline. 

Defining Section Splitting 
It is possible to specify at which section the body plan view will be split using a column 
in the Grid Spacing titled Split. Clicking in this column selects the station where the 
displayed station will change side in the Body Plan window. 

 

The Control box in the body plan window will be drawn with the sections staggered to 
show where the split has been placed. 

 

Plan and Profile Windows 

Plan Window 
The plan window displays the model as seen from below, with Starboard above the 
centreline and Portside below. 
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Profile Window 
Displays the hull as seen as seen from the Starboard side, with the bow to the right of the 
screen.  

Compress Function 
By choosing Compress it is possible to foreshorten the display of the design in the Plan 
and Profile windows. This foreshortened display is valuable for fairing long slender hulls 
on screen. 

 

 

The vertical axis is expanded relative to the longitudinal axis by a factor of four. 

Perspective Window 
The Perspective window is bordered by three rulers containing pointers that control the 
rotation of the displayed design. If the mouse is clicked anywhere in a ruler, the pointer 
will move to that angle and the design will be redrawn in the new orientation. 
Alternatively, you may drag any of the sliders to the desired angle. You may rotate the 
design in the Perspective window within the following limits: 
 
Pitch ±    30° 
Roll ±  180° 
Yaw ±  180° 
 
The zero position for each ruler is at its centre and markers are given at 15°. The Yaw 
and Roll rulers also have elongated markers at 30° intervals. 
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Moving Control Points in Perspective view 
As it is not possible to uniquely determine a three-dimensional coordinate from a two-
dimensional screen position, Maxsurf limits movement of control points to a particular 
plane. It does this by determining which plane is most perpendicular to the direction of 
view, and only allows movement in that plane. You will see an axis indicator in the 
lower right corner of the window showing the current plane of movement. 
 
For example, if the bow of the hull was pointing almost towards you, the sections plane 
would be most perpendicular, and points could be moved in the same plane as they could 
be in the Body Plan window (i.e. transversely and vertically, but not longitudinally).  
 
In the perspective view, the control point constrain function (holding the Shift key whilst 
dragging the control point) constrains movement to longitudinal, transverse or vertical 
motion in the design's co-ordinate system (not the screen's horizontal and vertical 
directions). 

Rotate 
The Rotate function in the view menu activates the Rotate command, which is a virtual 
trackball, which lets you freely rotate a design in the perspective view. 
 
After selecting the Rotate tool, move the mouse to a location in the Perspective window 
and press the left mouse button. With the left button depressed, you can rotate the image 
by dragging the mouse around and the rotation is performed by projecting the 
movements onto a virtual sphere on the screen – essentially like a virtual trackball. 
Generally speaking, moving the mouse left and right rotates about a vertical axis while 
moving the mouse up and down rotates about a horizontal axis. The Rotate mode is 
exited when the left button is released. 

Interrupting Maxsurf 
When Maxsurf is redrawing a complex design, or when it is rendering with simple 
shading in the perspective window, you may interrupt the drawing by pressing Esc or by 
clicking with the mouse. 
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Assembly Window 
The Assembly Window adds the ability to organise surfaces into groups in Maxsurf and 
a quick access to surface related commands and settings such as visibility, locking and 
trimming. Grouping surfaces allows changing the settings for several surfaces with one 
right click action. 
 
The assembly window in Maxsurf can be in different states:  

• Floating 

• Docked 

• Pinned – Auto Hide 

• Hidden 
 

 
Floating 

 
Docked 

 
Pinned -  
Auto Hide 

 

Opening the Assembly Window 
The Assembly window may be brought to the front by selecting View | Assembly 

window, pressing F2, or using the  button on the view toolbar. 
 
The Assembly Window is a floating palette window that contains a tree view of the 
surface hierarchy.  

Docking the Assembly Window 
To dock a floating assembly window, simply left click on the top window border and 
drag it onto any of the stickers that appear.  

 

Drag the Assembly Window onto the sticker to dock it. 

When the Assembly Window is docked, this process can easily be reversed to switch 
back to a Floating Assembly window. Simply select the top border of the docked 
window and drag it to any location on the screen.  
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Tip: when the Assembly Window is docked, you can use the “Tile Horizontal” or “Tile 
Vertical” commands from the Windows menu to automatically fill the rest of the window 
with your favourite working windows. 

Pinning or Auto Hiding the Assembly Window 
You can change the Assembly window from Docked to Pinned or Auto Hide and visa 
versa by clicking on the Pin icon on the top right of the window. 

 

When the Assembly Window is in the Auto Hide state, it will automatically hide itself to 
the outside of the screen if it is not being used. To show the dialog again, simply move 
your mouse cursor over the bar on the side of the screen (or click on it) and it will 
appear. 

Editing Surfaces and Assemblies 
The tree view has full support for inline editing, so names of assemblies and surfaces can 
be changed easily simply by slowly clicking twice on the name. Surfaces properties can 
also be edited by double clicking on the name, which then brings up the Surface 
Properties dialog box. You can also right-click on any item in the tree to modify it via 
context sensitive menus. Further, a surface’s properties may be edited by double clicking 
on the surface name in the Assembly window. 

Drag and Drop  
You can move a surface into an assembly by dragging and dropping the surface icon in 
the tree onto the assembly. You can move an assembly into another assembly in the same 
way. 
 
You can repeat this process as required to create any arrangement of assemblies you may 
require. 

Context Sensitive Menus 
Right clicking on an item in the tree view brings up a menu with commands for that item. 
 
For surfaces this context sensitive menu contains:  
 

Add New 
Assembly 

Adds a new assembly, with the same parent as the 
current surface.  

Rename Renames the currently selected surface  
Lock/Unlock Locks or unlocks the currently selected surface (if 

possible to do so)  
Show/Hide Shows or Hides the currently selected surface  
Properties Shows Surface Properties Dialog for the current 

surface 



Chapter 4 Maxsurf Windows 

Page  58  

 
Assembly window – Context Sensitive Menu for Surfaces 

 
For assemblies this context sensitive menu contains: 
 

Add Adds a new assembly, with the same parent as the 
current assembly  

Delete Deletes the currently selected assembly  
Rename Renames the currently selected assembly  
Hide Hides all surfaces that belong to the currently selected 

assembly, including any surfaces belonging to sub-
assemblies of this assembly. 

Show As per Hide Assembly, but instead showing surfaces 
that belong to the currently selected assembly, 
including any surfaces belonging to sub-assemblies of 
this assembly. 

Lock As per Hide Assembly, but instead locking all surfaces 
that belong to the currently selected assembly, 
including any surfaces belonging to sub-assemblies of 
this assembly. 

Unlock As per Hide Assembly, but instead unlocking surfaces 
that belong to the currently selected assembly, 
including any surfaces belonging to sub-assemblies of 
this assembly. 

 



Chapter 4 Maxsurf Windows 

Page  59  

 
Assembly window - Context Sensitive Menu for Assemblies 

Assembly window Icons 
Icons are used next to each item to show its current state – i.e. unlocked/locked, 
visible/hidden, and also for assemblies, i.e. collapsed/expanded. Icons allow you to see at 
a glance what state a surface is in at any time. The tick icon indicates that the surface is 
visible; the padlock icon indicates that the surface is locked. 
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Table Windows 
There are several windows in Maxsurf and other programs in the Maxsurf suite that 
display tabulated data.  
 
This section will first discuss the generic features available when working in Table 
windows in the Maxsurf suite and then discuss the following specific Table windows 
available in Maxsurf: 

• Control Points Window 

• Markers Window 

• Surfaces Window 

• Offsets Window 
 

Table Windows – General 
This section describes general features of tables in the Maxsurf suite. 

Display Area  
Using the scroll bars on the right and bottom-right of the window changes the displayed 
area. These will disappear if the whole table is visible. In addition, it is possible to use 
the zoom and shrink functions to increase or reduce the size of the table.  

Selection 
There are a number of ways of selecting data from the tables. You may wish to select 
data for copying or pasting to or from another application.  

Single Cell 
A single cell is selected simply by clicking once in the cell. The selected cell will be 
highlighted with a bold outline: 

 

Single Row 
A single row is selected by clicking once in the grey, row number cell in the left-most 
column. The selected row will be highlighted by making the background black and the 
text white: 
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Single Column 
A single column is selected by clicking once in the grey, column-heading cell in the top-
most row. The selected column will be highlighted by making the background black and 
the text white: 

 

Contiguous Rows and Columns 
Contiguous rows or columns are selected by clicking in the grey, row number cell or the 
grey, column heading cell and dragging the mouse over the other rows or columns to be 
selected. Alternatively, you may click in the first row or column header and then click in 
the final row or column header with the Shift key depressed. All the columns between, 
and including, the first and last will be selected. You may also use the scroll bars if you 
use the second method. 

 

Block of Cells 
A rectangular block of cells may be selected by clicking and dragging over the cells to be 
selected. Alternatively you may click in the first cell and then click in the final cell with 
the Shift key depressed. You may also use the scroll bars if you use the second method. 
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Complete Table 
The complete table may be selected simply by clicking in the blank, grey, top-left cell: 

 

Sizing Columns 
The width of the columns may be adjusted by two different methods. In either case, the 
column widths will be save when you exit the program. When you re-start the program, 
the saved column widths will be re-loaded. 

Dragging 
The column widths may be adjusted by placing the cursor over the line between the two 
columns, in the greyed column heading area. The cursor will chance to a re-sizing cursor 
and the column may now be re-sized by clicking and dragging the line to the new desired 
position. The column to the left will be adjusted. You may re-size several columns 
together by first selecting a group of columns and then adjusting the width of any of 
them. When you release the mouse, all the selected columns will be re-sized. 

Size to Text 
Alternatively, the column widths may be sized according to the width of the text 
displayed in the column's header. To do this, select the columns to be re-sized and then 
right-click in one of the grey header cells of one of the selected columns. Select Size 
Column/s to text from the context menu: 



Chapter 4 Maxsurf Windows 

Page  63  

 

Customizing the Display 
In some tables the format of the displayed data may be customised. In most tables it is 
possible to hide columns and sort rows. Some programs also have additional features, for 
further details of these additional functions please see the documentation for the relevant 
program. 

Column Hiding 
To hide a column or selection of columns, select the columns and right-click in one of 
the grey header cells of one of the selected columns. Choose Hide Column/s from the 
context menu: 

 

 
To unhide the columns, select the columns on each side of the hidden columns, right 
click and choose Show Column/s: 
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If all the columns are hidden, right-click in the top-left grey cell and choose Show All 
Columns from the menu: 

 

Row Sorting 
The rows may be sorted according to the data in a particular column. Right-click in the 
grey header row of the column you wish to sort by, then select Sort Rows ascending or 
Sort Rows descending as required. To return the rows to their original order, right-click 
anywhere in the grey column header row and select Unsort Rows 

Font 
The font used in the table may be changed using the Font command in the View menu. 

Editing 
There are several tools which aide editing data in a table. These are described in greater 
detail below. 

Typing 
Data may be typed in a cell by clicking in the cell and typing in the new data. This will 
overwrite the original entry in the cell. If you wish to edit the data in a cell, double-click 
to place the cursor at the position in the cell where you wish to start typing. Once editing, 
you can use the mouse to move the cursor by clicking once at the new insertion point or 
you can use the left and right cursor keys. If you wish to select certain characters in the 
cell, click and drag the mouse over the characters to be selected, these will be highlighted 
with a blue background and white text. 

Copy 
The entire contents of a cell or group of cells may be copied to the clipboard for pasting 
into another application or Maxsurf table. Select the cells to be copied and choose Copy 
from the Edit menu, or use the keyboard shortcut Ctrl+C or Ctrl+Ins. 
 
If a group of cells have been selected, they will be copied in tab delimited format which 
enables direct pasting into applications such as MS Excel. 

Note 
Use Ctrl+Shft+C to include the table column-headings. 
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Paste 
Data may be pasted from other tables or other applications such as MS Excel. Once the 
data has been copied, select the top-left cell of the area you wish to paste the data into. 
Choose Paste from the Edit menu, or use the keyboard shortcut Ctrl+V or Shift+Ins. 
 
Make sure the table you are pasting into contains more or an equal number of rows and 
columns as the table you copied the data from. 

Fill Down 
The data from a cell, or group of cells, may be copied into the cells below it. Select the 
group of cells you wish the new data to be copied into; include also the cells which 
contain the data you wish to fill down with. Right-click and select Fill Down or use the 
keyboard shortcut Ctrl+D. 

 
Selection and data before Fill Down 

 

 
Modified data after Fill Down 

Fill Right 
In a similar manner, data may be filled to the right using the Fill Right command: 
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Selection and data before Fill Right 

| 
Modified data after Fill Right 

Multiple Tables 
 
The tables used in the Maxsurf suite are similar to the Worksheets in MS Excel. Just like 
in Excel, you can switch between tables by clicking on the tab of the desired table at the 
bottom of the window (if there are multiple tables available in that window). Use the 
scroll arrows in the bottom left hand corner to view more tabs. The scroll bar on the 
bottom right is used to scroll through the currently displayed table.  
 

 

 
Example of multiple tables in one window (from Hydromax). 
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Control Points Window 
The Control Points window allows the user to specify the control point positions directly 
using the keyboard rather than by using the mouse in one of the design windows. 
Whenever the Control Points window is selected the highlighted row is that of the 
current control point in the current surface. 
 
Only the control points of visible surfaces will be displayed. Those of locked, visible 
surfaces will be displayed in grey and cannot be edited. Only the control points of 
unlocked, visible surfaces can be changed. 

 

The position, offset and height of a control point may be edited by selecting the relevant 
cell. It is also possible to copy and paste data from other applications such as 
spreadsheets. You may select rows, columns, the whole window, or an individual cell by 
using the mouse. 
 
The Surface, Column, and Row columns are not editable. The Surface column displays 
the surface name as specified in the Properties dialog. The Column and Row columns 
specify the row and column numbers in the same order as their position in the net. 

Control Point Weighting 
If the Surface is a NURB surface, it is possible to have control point weights other than 
unity. This is necessary for producing true conical and spherical surfaces, but should 
otherwise be left as unity. See the section on Surface Types on page 90 for further 
details. 

Editing Control Points 
To edit a control point position numerically 

• Select the control point you wish to edit. 
Select the control point from any of the drawing windows. 

• Select the Control Points window. 

• Scroll through the list. 
The selected control point will be highlighted. 

• Edit the control point position. 

Note:  
Addition and deletion of control point rows and columns may not be 
performed in the Control Points window. To add and delete rows use the 
Add and Delete functions from the Controls menu in their respective 
drawing windows. 
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Setting Control Point Display format 
In the Control Points window it is possible to view the points listed by row then column 
or by column then row. This is achieved by setting the Row then Column or the Column 
then Row items in the Preferences dialog (in the View menu). 
 
This is an advantage when you wish to paste a single row of data into a surface such as in 
the case of an airfoil section being imported from a spreadsheet. In other cases you may 
wish to paste only a single column of data. 
 
Alternatively, you may sort the data by any column by right clicking in that column's 
header and selecting from the pop-up context menu. Or you may sort in ascending order 
by double clicking the column's header. 

Synchronization of Control Points and Design windows 
Single control points selected in the design view are selected in the Control Points table 
and control points selected in the Control Points table will be selected in the design 
views. This can make it easier to verify visually which control point is which. 

Markers Window 
Markers are reference marks displayed on the screen. They may be offset data that has 
originated from an existing hull or simply limiting dimensions that need to be visible 
while developing a design.  

 

Markers are purely graphical and have no effect on the calculation of surfaces. The 
maximum number of markers you may use is 30000. In practice you will usually use 
many fewer than this. 
 
Markers may either be read in with a design from Prefit, read directly from a text file or 
by Importing DXF Markers. Markers can also be entered manually using the Add Marker 
function in the Edit menu or copied and pasted into the markers table from another 
application such as a spreadsheet. They are stored as three-dimensional points in space 
and may be added, moved or deleted. All marker positions are stored in the design file 
whenever you save a design.  
 
Each marker can be associated with a station in your design. Usually if you are importing 
markers that form the offsets of an existing design, you will set up the grid in Maxsurf to 
match the station spacing of the original design, and then set the station number of each 
marker to match its station in the offsets table. See Generating a Grid from Markers on 
page 138 for more information on automatically generating a grid from a set of markers. 
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Markers may also be associated or linked to a specific surface and location in that 
surface. Once linked to a surface, the marker takes on the colour of that surface. This 
function may be controlled with "Use Surface Colour for Drawing Parametrics" control 
in the View | Preferences dialog. If this control is turned off, markers that have been 
linked to a surface will be displayed in the same colour as the surface parametrics. This 
is not only useful for display purposes but can also be used to Measure Surface Errors 
and utilise the Fit Surface to Markers Command that is available when you 
Activate/Deactivate Prefit. 

Displaying Markers 
To turn all markers on or off 

• Select the Markers function from the Display menu. 
 
You can choose to display all markers or no markers, or you may choose to only show 
those markers whose station number is the same as the current station. 

Marker Selection 
In the design views, markers may be selected in a similar manner to the control points: 
by simply clicking on them with the left mouse button or by dragging a box around them. 
Holding down the Shift or Control key while making the selection allows you to add 
more markers to the current selection or remove previously selected markers from the 
selection.  
 
Selected markers are highlighted in the highlighting colour. 

Note: 
You may have to lock the surfaces to hide the control points, as selection of 
control points takes precedence over selection of markers; i.e. if the drag 
box contains control points, these will be selected rather than the markers. 

In the Markers table, you may only make a continuous selection. However, data may be 
sorted by right clicking in the column header and choosing from the pop-up menu to sort 
ascending or descending based on the contents of that column. The markers may be 
unsorted by right clicking in any of the column headers and selecting Unsort Rows from 
the pop-up menu: 

 

Adding Markers 
To add a marker to a drawing window 

• Select Add Marker from the Marker menu or use the Ctrl+M shortcut key. 
 
A pencil cursor will be displayed. 
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• Click the mouse at the position of the new marker. 
 
Use the position indicators to place the marker at the required position. The added 
marker will be associated with the current station as displayed in the control box. 
 
Markers may also be placed graphically in the Plan or Profile views. For these 2D views, 
the third dimension takes the value of the last entered marker. For example, if you 
wanted to enter makers on the 2m waterline, first switch to the Plan view. Add a marker 
in the Plan view; double click the marker so that you can specify its height as 2m, then 
any subsequently added markers (in the Plan view) will have their height at 2m. Markers 
on Buttock lines may be entered in a similar fashion in the Profile view. 
 
Alternatively, a marker can be added directly into the Markers window. To do this 

• Select the Markers window. 

• Highlight a row by clicking in the far left hand column. 

 

• Select Add Marker from the Edit menu. 

• Enter the number of markers you wish to add and hit Return. 
 
Rows will be added after the row selected, with cells initialised to zero. 

Note: 
You must have a design open before you can add markers. 

Deleting Markers 
To delete a marker from a drawing window 

• Select the marker(s) to be deleted 

• Select Delete Marker from the Marker menu or use the Delete key on your keyboard 

• Click yes to confirm you want to delete the selected markers. 
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The marker will be deleted. 
 
To delete a marker from the Markers window 

• Select the Markers window 

• Select the row(s) of the marker(s) that you wish to delete 

• Select Delete Marker from the Marker Menu or use the Delete key on your keyboard 

• Click yes to confirm you want to delete the selected markers. 
 
Rows will be deleted from the Markers window. 

Modifying Markers 
The co-ordinates in the Markers window may be edited to move a marker in space. To 
edit a marker 

• Click on a cell in the Markers window. 

 

• Enter the changed Station Number, Longitudinal Position, Offset, or Height. 
 
Alternatively, to edit a marker directly 

• Double click on a marker in one of the drawing windows. 

 

A small dialog box will appear containing data about the marker. You may select and 
edit any of the marker's co-ordinates. When you click OK the marker will be updated to 
the new position. 
 
You may also set the data for a number of markers together: 

• Select the markers in one of the drawing windows. 

• Select Properties from the Markers menu. 
 
If you have selected several markers, those fields that contain exactly the same data for 
all the selected markers will be displayed with the common data. If the data differs, the 
field will be left blank. Editing the data in any field will update all the selected markers. 
This can be useful for making sure that all the markers on one station have identical 
longitudinal positions, or for specifying which section they should be linked to. 
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Reading Markers Files 
It is possible to read a text file of markers into Maxsurf. This text file may be created 
from the Save Markers or Save Offsets commands in Maxsurf or created in a 
spreadsheet, word processor or other application. 
 
The format for the Markers file is tab delimited text. Each coordinate is separated by a 
Tab character, and each line ends with a Carriage Return character. An example would 
be: 
 

1 2.33 -0.2 1.2 
1 2.33  0.1 2.4 
2 4.66 -0.7 1.0 
3 7  0.3 1.4 

 
Column 1 is the station number with which the marker is associated. This controls when 
the marker is displayed and when it is hidden when the Show Markers for Current 
Station command is active. Column 2 is the longitudinal position from the zero point, 
Column 3 the offset from the centreline and column 4 the height above the zero point. 
 
Alternatively you may create markers by Importing DXF Markers. The DXF file is 
imported by choosing File | Import | DXF markers. 

Sorting Markers 
The order in which markers are sorted along a section line can be important when the 
marker data is used in Prefit to automatically generate a surface, or when you want to use 
the marker-connection-lines as a reference during manual surface fitting tasks. 
 
Markers that have been assigned to the same Station Index can be sorted for each station 
using the Sort Marker Stations command from the Markers menu. This sorting uses a 
nearest neighbour sort, which works in most instances, but can be confounded if the 
section shape is complex and/or the spacing between markers varies significantly. To 
view the connectivity (and ordering) of the markers turn on the Display | Connect Marker 

Stations option: Ctrl+J, . This is best done in the Body Plan view, with the Display | 

Show Markers for Current Station option selected ( ). 
 
A single marker can be moved along the ordering by using Ctrl+Cursor keys; left and 
down keys move the point one positions towards the start of the ordering whilst up and 
right keys move the point one position towards the end of the ordering; the Home key 
makes it the first point and the End key makes the it the last point: 

                     

Before and after: Moving the selected point one position towards the start of the curve corrects the marker 
ordering 
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To re-order a range of markers, select them in the new desired order (from the keel 
outwards towards the deck edge (or deck centre line) and select Markers | Re-order 
Selected Markers (Ctrl+Shift+R). If the new order is the reverse of what is required, 
simply repeat the command without changing the selection, and the order will be 
reversed. 

  

Markers incorrectly ordered Start selecting Markers in correct order 

  

Start with marker that should be closest to keel in the 
group 

Markers selected in correct order. Use Re-Order 
Selected Markers command to re-order 
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Points are now ordered in the selection order, if this is the inverse of what is required, simply repeat the Use 
Re-Order Selected Markers command without changing the selection. 

 
When a marker is added, it will be inserted to so as to minimise the increase in section 
length. This normally ensures that it is inserted in the correct location. 

                     

Generating Markers for Developable Surfaces 
To generate markers that describe the shape of the developable surface you have to first 
set the surface type to Developable. This will create ruling lines from the surface edges 
from which the markers can be generated using the Markers | Generate Markers for 
Developable Surfaces command. This command is only available if there is at least one 
surface in the design with the surface type set to developable surface. 
 
See Surface Types on page 90 for more information 
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Markers are calculated for the surfaces selected in the list on the left of the dialog (only 
developable surfaces are listed). Markers can be generated where the ruling lines 
intersect stations previously defined in the Grid Spacing dialog, or at equal intervals 
along the ruling lines. The number of ruling lines calculated depends on the current 
surface precision setting, but during the generate markers command the precision is 
increased temporarily to highest. 

 

Markers generated at equal intervals along the ruling lines – this is useful for the automated surface fitting 
(Markers | Fit surface to Markers) as it ensures that markers are generated even when the rulings are vertical 

and do not interest stations. 

 

Markers generated where they intersect the sections. This is useful when manually fitting the surface to the 
markers in the body plan view. 

Surfaces Window 
The surfaces window provides quick and flexible access to all the surfaces' properties. 
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Column hiding and sorting may be used in this window and this may be used to reduce 
the size of the window. This window may then be used as a very convenient way of 
turning on and off the visibility and locking of surfaces in a complicated design. Copy, 
Paste and Fill down may also be used in this table. 
 

Offsets Window 
The Offsets window allows you to calculate and view the offsets for a design on screen. 
Offsets are found for the given grid spacing as set in the Grid Spacing dialog from the 
Data menu. 

 

The offsets are displayed for one station at a time. See the Displaying Offsets section for 
instructions on how to change this display. 

Calculating Offsets 
To calculate offsets 

• Select the Offsets window. 

• Select Calculate Offsets from the Data menu. 
 
A dialog will appear allowing you to choose whether or not to include skin thickness 
deduction and/or to automatically create a table of markers from the calculated offset 
points. 
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Offsets calculation may take some time depending on the number of surfaces and grid 
lines in use. Offsets are sorted by station position. 

Skin Thickness Deduction  
The skin thickness is deducted on a surface-by-surface basis. In order to ensure this is 
done correctly please check the following:  

• Thickness specification of each surface 

• Thickness direction of each surface 

• Outside arrows direction of each surface 
 
For more information on how to specify the above please refer to the Outside Arrows 
and Surface Materials sections.  
If you have chosen to deduct skin thickness, Maxsurf will add or deduct that thickness 
perpendicular to the surface at each point on the hull, so that areas of the hull that are not 
parallel to the centreline will be correctly calculated. 
 
Where an offset is for an edge or feature line, the following rules apply: 
 
Edges 

Skin thickness is taken along the surface perpendicular at the edge, rather than 
along a waterline, buttock or diagonal. An example of this would be for a sheer 
line, where the topside was not vertical, with the resulting offset higher than the 
original point. Builders should be made aware that the height specified does not 
correspond to the height of the sheer line. 

 

Feature lines 
Offsets at feature lines such as knuckles and chines within a surface are taken at 
the intersection of the projection of the deducted surface, rather than on a radius 
around the feature point.  

Displaying Offsets 
To display different pages of the offset table: 
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• Choose Go To Offset… from the Data menu 

 

• Enter the number of the station whose offsets you wish to view. 

• Click OK 
 
The Offsets window will change to display the offsets for the station requested. 

Copying Offsets 
Offsets may be copied for transfer to other programs. To do this 

• Click in the top left hand corner of the Offsets table. 
 
This selects and highlights the entire Offsets window for copying. 

• Select Copy from the Edit menu. 
 
Switch to your word processor or spreadsheet and choose Paste. 

Customizing Offsets 
Once a table of Offsets has been calculated in Maxsurf, it is possible to customize the 
names used for waterlines, buttocks, diagonals, feature lines and edges. Simply type the 
text required into the required cell in the Offsets window. These names will be used 
when the table of offsets is printed or written to a file. 

Writing an Offsets File 
It is also possible to write out a text file of the complete table of offsets. This can be read 
directly into other programs such as word processors or spreadsheets. To do this 

• Make sure the Offsets window is in front. 

• Select Save Offsets from the File menu. 

• Specify a name for the offsets file and click on the save button. 
 
The offsets will be saved in a TEXT file of that name and may be opened by any word 
processor or spreadsheet. 
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Graph Windows 
There are several windows in Maxsurf and other programs in the Maxsurf suite that 
display Graph data. The Graph Windows - General section discusses generic features of 
graph windows in the Maxsurf suite. You can also find specific information on how to 
select different view options for the Curve of Areas Window.  

Graph Windows - General 

Data Interpolation 
Data may be read off the graph by clicking on the curve of interest. A slider is then 
displayed which may be dragged along the curve. The abscissa and ordinate are 
displayed in the bottom-left corner of the window. 

Graph data 
The graphed data in any graph can be displayed in tabulated format by double clicking 
on the graph. This can be used to obtain the sectional area curve data for example. The 
complete set of data can be copied by right clicking on the top left grey cell to select the 
entire table, then selecting copy from the menu. If you wish the Copy operation to 
include the column headings, hold down the Shift key at the same time as you select the 
Copy command. The dialog may also be resized to best display the tabulated data. 

 

Graph legend 
A graph legend may me displayed in the various graph windows. Right click in the graph 
view to obtain the context-menu that gives the various display options: 
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Scaled graph printing 
You can specify whether a graph should be printed to a scale (to facilitate taking 
measurements from the graph). Holding down the Shift key while selecting Print from 
the File menu, or using the toolbar button will display the following dialog. Answering 
“Yes”, will mean that the graph is scaled so that one grid unit is a sensible number of 
centimetres or inches: either 1, 2, 2.5 or 5. The use of centimetres or inches will depend 
on whether the units used for length are metric or imperial. The setting will be 
remembered once the selection has been made; to change the setting, hold down the shift 
key again when selecting print to display the dialog. Choosing “No” will cause the graph 
to be printed filling the page and is the default behaviour. 

 

Scaled print dialog if length units are metric 

Curve of Areas Window 
When a design is open the Curve of Areas window may be used to determine the 
Sectional Area Curve for the current datum waterline. 
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The form of Sectional Area Curve displayed may be chosen in the Preferences dialog in 
the View menu. 
 
Three choices exist: 

• Section Area. 
Graphs sectional area against longitudinal position from the zero point. 
• Section Area / Maximum Section Area. 
Graphs sectional area normalised by maximum sectional area to allow the 
comparison of sectional area curves from different designs of similar 
displacement. 
• Section Area / Volume. 
Graphs sectional area normalised by volume2/3. This allows the comparison of 
sectional area curves of designs with different displacements. 

 
The Sectional Area Curve is made up from a number of sectional areas. Most are spaced 
equally along the datum waterline with additional half stations at each end. You can 
specify the number of sections used to display the curve by choosing the appropriate 
Sectional Area Curve Stations button in the Preferences dialog. 
 
To display sectional area values along the curve, simply click on the movable crosshair 
and move it to the required position. The station position and current value for the curve 
will be displayed in the bottom left hand corner of the window. 
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Calculations Window 
Maxsurf has two ways of performing calculations on the model: 

• Calculations from the Data menu 

• Calculations in the Calculations Window 
 
In this section the Calculations window will be discussed. For more information on the 
calculations available from the data menu, see the Calculations section on page 169. 
 
In the Calculations window, Maxsurf is capable of evaluating calculations entered by the 
user and solving them in a form much like a simple programming language. These 
calculations may be simple arithmetic expressions, or may include variables that are pre-
calculated by Maxsurf. Formulae, together with relevant comments, are displayed on the 
left, with the result of each calculation displayed in the second column. You can also add 
comments (e.g. units of the result) in the right hand column. 

 

Note:  
- Although the calculations window allows user customisable calculations, 
more accurate results can be achieved by using the calculations from the 
data menu. This is recommended in case there is no need for customised 
calculations. 
 
- The calculations sheets provided with Maxsurf are examples only. They 
should be checked thoroughly before use in your office, and your attention 
is drawn to the conditions of use outlined in the disclaimer at the front of 
this manual. Also ensure that you are using the Calculation sheet consistent 
with your current Units setting. 

Expressions  
Expressions use standard arithmetic notation and are evaluated based on the level of 
precedence of their operators, and their left to right ordering. Precedence levels 
determine the order of computation of expressions. For example, a multiplication (level 
three) would be computed before an addition (level four). The operators and their 
precedence levels are: 
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( ) PARENTHESES Level one 
^ EXPONENTIATION Level two 
*,  
/ 

MULTIPLICATION, DIVISION Level three 

+, 
- 

ADDITION, SUBTRACTION Level four 

Statement Syntax  
Syntax for each statement should be similar to the following: 

 

Built-in Variables  
Built-in variables contain information about the volume enclosed by the surfaces being 
designed, and the plane specified by the Datum Waterline (DWL). Once the DWL has 
been positioned and the Frame of Reference set up correctly, Maxsurf determines the 
waterline length and calculates data for 13 immersed stations (stations 0 to 10, plus half 
stations 0.5 and 9.5), in addition to several general variables. Station 0 is the forward-
most station and Station 10 the aft-most. The variables available to be included in 
calculations are: 
 

SPACING Immersed Station Spacing 
MAXA Maximum Immersed Sectional Area 
MAXB  Maximum Waterline Beam 
MAXD Maximum Draught 
STAT0. .STAT10 Immersed Station Position 
SA0 . . SA10 Immersed Sectional Area 
DR0 . . DR10 Draft 
WLB0 . . WLB10 Waterline Beam 
IGIR0 . . IGIR10 Immersed Girth 
TGIR0 . . TGIR10 Total Girth 
CAH0 . . CAH10 Transverse Centre of Immersed Area 
CAV0 . . CAV10 Vertical Centre of Immersed Area (above 

DWL) 
 
Half stations at 0.5 and 9.5 have the following variable names: 
 

STAT0.5 Immersed Station Position at position 0.5 
STAT9.5 Immersed Station Position at position 9.5 
Likewise for the 
fields : 

SA, DR, WLB, IGIR, TGIR, CAH, CAV. 
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Note:  
- The station positions used for the volumetric analysis of the hull in the 
calculations are completely independent of the station positions set up by 
the Grid Spacing function from the Data Menu. Maxsurf determines the 
position of the STAT0 to STAT10 variables, and therefore the SPACING 
variable, purely on the position of the Datum Waterline you have specified. 
 
- The calculations performed in the Maxsurf calculations window use 13 
sections. The Hydrostatic and Area calculations available from the data 
menu use a number of sections that is dependent on the precision setting in 
Maxsurf, where for example medium uses 50 sections. The calculation 
results will be different each time a different number of sections are used. 
The hull shape is approximated most accurately at highest precision (200 
sections). For more information see Calculations. 

Built-in Functions  
Built-in functions provided are: 
 

PI Pi 
SIN(x) Sine of x 
COS(x) Cosine of x 
TAN(x) Tangent of x 
LN(x) Logarithm to base e of x 
ARCTAN(x) ArcTangent of x 
SQRT(x) Square root of x 

Calculation Units 
Calculations are solved in the current units as set by the Units function in the Data Menu. 
Please ensure that any expressions used are correct for the units in use. 

Solving Calculations 
To open and solve an existing calculations sheet 

• Select the Calculations window. 

• Select Open Calculations from the File Menu. 

• Select a file of calculations to open from the disk. (Samples are provided in the 
Maxsurf\Calcs directory.) 

• Click Open and the calculations sheet will be opened and displayed in the 
calculations window. 

• Choose Solve Calculations from the Data menu. 

 

A dialog appears that allows you to specify a longitudinal range over which to perform 
calculations. The dialog will have the Use current DWL option selected. If you click the 
OK button, calculations will proceed using the current waterline length of the hull. 
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If, however, you select the Set range option and specify new fore and aft limits for the 
analysis, the calculations performed when you click OK will be restricted to this zone of 
the hull. The Simpson's stations created by Maxsurf are displayed on the screen as a 
visual check. Note that calculations using Simpson’s stations are approximate. While 
these are usually sufficient for initial design checks, for accurate calculations you should 
use Hydromax, which uses more accurate integration and allows a much larger number 
of stations to be used. 
 
Note: When you are setting the range you may refer to stations on the grid directly by 
typing S followed by the number of the station you want. For example, if S3 is typed in, 
the longitudinal position for Station 3 of the grid will be automatically substituted. 
When you click OK, Maxsurf will evaluate the arithmetic expressions in each statement 
of the calculation window and calculate the result, which is displayed in the second 
column.  
 
Maxsurf also assigns the result to the variable name on the left, so that the result may be 
referred to in later statements. 
 
If a division by zero has been found, NAN (not a number) will be displayed in the results 
column. If there is an error in your entered expressions, an error message will be 
displayed. Locate and correct the error and solve again to continue. 
 
You may insert comments into your calculations by preceding a comment line with a $ 
symbol. This line will then be ignored by the calculations routines. 
 
There is no practical limit to the size of the calculations sheet that can be solved. To 
enable you to see all of a large sheet of calculations you may use the scroll bar on the 
right hand side of the Calculations window. 

Saving Calculations 
To save a calculations sheet 

• Select the Calculations window. 

• Select Save Calculations or Save Calculations As from the File menu. 
 
If you choose Save As you will be prompted to enter a name for the new calculations 
sheet. 
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Maxsurf Settings 
Maxsurf has a number of settings that give you control over how the program operates 
and displays results:  

• Maxsurf Preferences 

• Colour and Font 
 

Maxsurf Preferences  
Maxsurf has a number of global preferences, which affect how the program works. These 
may be changed by selecting Preferences from the View menu. 

 

The different settings are described below: 
Control Point Size  

The control point size may be set to either: huge (6 pixels), large (4 pixels), or 
small (2 pixels). 

Graph Type  
The Sectional Area Curve graph may be set to be a filled graph, a line graph, or a 
graph made up of discrete data points. 

Sectional Area Curve Type 
The sectional area curve may be set to graph: 
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• Section Area. 

• Section Area / Maximum Section Area. 

• Section Area / Volume2/3. 
 
Control Point Window Column Ordering.  

In the Control Points window it is possible to view the points listed by row then 
column or by column then row. The reason for doing this is to simplify the pasting 
of single rows or columns into the Control Points window. 

Sectional Area Curve Stations.  
The sectional area curve may be set to use 13, 25 or 39 stations. For complex hulls 
it is better to use more stations, while for simple hulls it will be faster to calculate 
fewer stations. 

Refresh Options 
Depending on the speed of your computer, select between: Update Frontmost 
Window Only; Update All Windows or Update All Windows Dynamically. On a 
slow computer, Update All Windows Dynamically may be too slow to use the 
program effectively. 

Contour Tolerance 
This value is used when computing surface contours using Highest Precision. A 
lower tolerance value will give more precise contours. 

Curvature Porcupine Size 
This value is used to scale the curvature porcupines displayed on contours. 

Outside Arrow Size 
This value is used to scale the outside arrows displayed on surfaces. 

No. of Undo Levels 
This sets the maximum number of ‘undos’, which are stored and may be set to a 
value between 2 and 100. Setting too high a value may cause your computer to 
slow down since this will require considerable memory, the amount of memory 
used depends on the complexity of the model. 

Sub-menu Length 
This sets the maximum number of items in the surfaces sub-menus before the 
More Surfaces… item is displayed. 

Use Surface Colour for Drawing Parametrics 
The parametric surface contours may be displayed in the global parametric contour 
colour or in the colour of the surface. This option can be useful for better 
visualising the design and distinguishing the different surfaces. 

Colour and Font 
The colour and font used in the windows may be changed with the Colour and Font 
commands in the View menu. 

 
The Colour command allows you to set the colour of lines, controls, and graphs. 
 
Remember to always be careful when using colour. It is very easy to get carried away 
with bright colours and end up with a garish display that is uncomfortable to work with. 
In general it is best to use a neutral background such as mid Gray or dull blue and use 
lighter or darker shades of a colour rather than fully saturated hues. 
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To change the colours, select Colour from the View menu. 

 

From the scrollable list, select the item whose colour you wish to change. The item’s 
current colour will be displayed on the left of the dialog. To change the colour, click in 
the box and select a new colour from the palette. 
 
The colours of items in the four design views are all consistent. The colours used in the 
graph window may also be changed with the colour command. 
 
The Font command allows you to set the size and style of the text in the current window; 
the font may be independently set for all the windows. 
 
Select Font from the View menu and select the desired font, style and text size. 
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Chapter 5 Using Maxsurf 
The previous chapter covered a lot of the functions that are available to you when you 
are working in one of the windows. This chapter will discuss specific functions in 
Maxsurf to manipulate the shape of the design, do calculations and work with external 
data.  
 
Working with Surfaces: The characteristics of the surfaces used in Maxsurf to define its 
designs, commands that apply to surfaces, including methods for generating true conic 
curves.  
 
Trimming Surfaces: How and when to use surface trimming.  
 
Bonding Surfaces: How and when to use bonded surfaces.  
 
Fitting Surfaces: Tools available in Maxsurf to fit a surface to an existing design. 
 
Modelling Developable Surfaces: Tools available in Maxsurf to help you model a surface 
so that it can be build with no or minimal strain.  
 
Control Points: Tools available for manipulating a control point or group of control 
points to achieve the desired surface shapes. 
 
Calculations: How to calculate hydrostatics, girths and surface areas in Maxsurf. 
 
Using Parametric Transformation: Numerical modification of critical design parameters 
where Maxsurf will automatically modify the parent hullshape to match required 
parameters. This function is available in Maxsurf Pro only. 
 
Input of Data: Different types and methods of input data. 
 
Output of Data Different types and methods of output data. 
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Working with Surfaces 
Maxsurf allows you to create complex designs using any number of a range of surface 
types. You can use B-Spline, NURB, Developable or Conic surfaces. 
 
Many different surface types have been proposed over the years for use in Computer 
Aided Design systems. You may be wondering why Maxsurf uses B-spline surfaces and 
NURB surfaces, rather than any of the alternative methods such as Bezier Surfaces or Bi-
cubic spline patches. 
 
The simple answer is that the B-spline definition encompasses many of these other forms 
as special cases of the B-spline. For example, a Bezier curve is exactly the same as a B-
spline where the order has been set to be equal to the number of control points minus 
one. Similarly, a B-spline curve of order 4 stiffness is a piece-wise cubic spline. 

 

B-splines are a powerful and mathematically elegant formulation that retain a high level 
of numeric stability, while encompassing many of the curve types that have gone before. 

Surface Types  
Maxsurf is capable of creating complex surfaces using B-spline surfaces with up to 25 
rows of control points. Conventional B-spline surfaces are ideal for many applications. 
However, they do have the disadvantage that they are not able to precisely represent 
simple conics such as circular, elliptical or parabolic curves. Maxsurf offers an 
alternative surface definition that overcomes this disadvantage and allows you to 
combine conic curves with free form surfaces at will. 
 
Maxsurf allows the use of four surface types, which are all members of the NURB 
family: 
B-Spline 

This type of NURB surface has all control point weights set to unity. It has the 
advantage of being faster computationally, at the expense of not being able to 
precisely represent conics. However, this type of surface is applicable to most 
situations. 

NURB 
With this surface type, it is possible to precisely represent conic curves and 
surfaces. This is achieved by the addition of weights, which may be varied for 
each control point. 
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Conic 
When this surface type is selected, a NURB surface is used and the control point 
weights are automatically calculated by Maxsurf to produce a precise conic 
surface. Use this surface only if you require precise conic surfaces, such as for a 
bow cone. 

Note  
The control point weights are only computed automatically for 3-point 
forms. If you are using 4-point forms you will need to make your surfaces 
NURB surfaces and type in the weights manually. 

Developable Surfaces 
A NURB surface of which the edges determine the internal surface shape. Maxsurf 
draws ruling lines based on the edges and lets the user determine the shape of the 
internal surface. 
Use this surface type as an intermediate design aid, then change back to a B-Spline 
surface. 

B-Splines and NURBs  
Non Uniform Rational B-Spline (NURB) surfaces have an additional shape control 
parameter, called a weighting value, available at each control point. In Maxsurf, the 
weighting value is shown in the last column of the Control Point window.  
 
When all of the weighting values in a control point net are set to one, the surface will be 
identical to a conventional B-spline surface.  

 

When a control point has its weighting value increased, the surface, in the vicinity of that 
control point, will be attracted towards the control point. Conversely, a decrease in the 
weighting value will result in the surface being pushed away from that control point. 
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This is true to the extent that a negative value will give a curve that balloons outward 
from the polygon of control points. 
 
In general you should only use weighting values to exactly model a conic curve. It is not 
usually a good idea to use the weighting value to control the shape of free form curves. 

Circular Arcs  
The primary use for the weighting values in a NURB surface is to allow you to create 
true arcs of circles and ellipses. There are two standard formulations for these curves, 
one using three control points and Order 3 (quadratic) stiffness, and one using four 
control points and Order 4 (cubic) stiffness. In both cases, there is an equation that 
describes what the weighting value should be, based on the angle of the arc. 
 
Note that when a surface is defined as a conic, Maxsurf only automatically computes the 
control point weights correctly for three-point-forms. Weights will be incorrect for four-
point-forms and you must change the surface type to NURB so that you can enter the 
weights manually. 
 
For the three point case, the distances between control points are kept equal and the 
weighting value for the centre point is set to 

w = COS (θ/2)  
where θ is the included angle of the arc.  
 
For example for a 90° arc,  

w = COS 45° = 0.7071.  

 

For a 45° arc, 
w = COS 22.5° = 0.9239. 
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The four point form again has the control points forming an equally spaced polygon 
around the curve. In this case, the equation for the weighting value is  

w = (1 + 2 Cos (θ/2) ) / 3 
where θ is the included angle of the arc. 
 
For example, for a 90° arc, 

w = (1 + 2 (Cos 45°))/3 = 0.804738 
For a 180° arc,  

w = (1 + 2 (Cos 90°))/3 = 0.3333' 

 

The three point form of circular arc can be used for any arc from 0° to 180°. However, as 
the angle approaches 180°, the weighting value approaches 0 and the position of the 
centre control point approaches infinity. It is best applied to arcs between 0° and 90°. 
 
The four point form has a more complex equation for the weighting values, but is an 
elegant form for 180° arcs. It is best used for arcs between 90° and 180° 
 

Elliptical Arcs 
NURBS can represent elliptical as well as circular arcs simply by stretching the control 
point polygon in a linear fashion. 

 

When this is done the weighting values remain the same as those for the circular arc on 
which the ellipse is based. 
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Circular and Elliptical Surfaces 
The extension of the NURB curve to the surface allows cylinders, spheres, cones etc. to 
be modelled exactly. For a cylinder or cone, one row is set to the weighting value 
required for the arc. 

 

In the case of a toroidal or spherical surface where curvature runs in both directions on 
the surface, the weighting values are set as follows: 

 

The central control point has its weighting value set to the product of the weighting 
values of the row and column that intersect it. In this case 0.7071 x 0.7071 = 0.5.  
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By combining these surfaces, it is possible to build up complex designs made up of true 
circular and elliptical segments, such as a submarine. The submarine example is in the 
Sample Designs folder, which comes with Maxsurf. (Maxsurf\Sample 
Designs\Naval\Submarine\Submarine.msd) 

 

Developable Surfaces 
A developable surface is one that can be formed from a flat sheet without stretching the 
material. This material may be aluminium, steel, wood or even paper - the material 
chosen has no effect on whether or not the surface is developable. Examples of simple 
developable surfaces are cylinders and cones, as opposed to a sphere which is clearly not 
developable. 
 
A developable surface is created from the edges of a B-spline surface and a set of offset 
points can be generated at each station. These offsets can then used to manually or 
automatically fit the B-spline surface to the developable shape. This allows you to create 
a surface that is developable within practical tolerances. 
 
See Modelling Developable Surfaces on page 146 for more information. 

Surface Stiffness 
The choice of surface stiffness is analogous to the selection of a different weight of 
spline when drawing a curve on the drawing board. When drawing a smooth shallow 
curve you would select a stiff spline, and when drawing a curve featuring a high rate of 
change of curvature you would select a flexible spline. 
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Flexible splines are useful for modelling knuckles and discontinuities, otherwise try and 
work with the stiffest spline possible. Often a good compromise is to use flexible splines 
transversely and stiffer splines longitudinally. 
 
Two factors influence the stiffness of a surface: 
Setting of stiffness through the Properties dialog. 

A number of stiffness settings allow for the specification of stiffness in the 
longitudinal (row) or transverse (column) direction. 

 
Linear Order 2 
Flexible Order 3 
…. ….. 
Stiff Order 10 

There is no absolute value for the recommended surface stiffness since it is very 
much dependent on the surface shape you wish to achieve. In general, a 
longitudinal stiffness of 5 and a transverse stiffness of 4 offers a good starting 
point from where you can go up or down dependent on the surface shape you wish 
to achieve. 
The stiffer the surface, the easier it is to get a fair surface. At the same time, a stiff 
surface is more difficult to achieve high curvature shapes with.  

Number of control points. 
You need at least the same number of control points in the direction of the surface 
stiffness. For example: for a longitudinal stiffness of 6 you need at least 6 columns 
of control points and for a transverse stiffness of 5 you need at least 5 rows of 
control points. 
 
To get an idea why this is necessary, imagine a 2 column surface (only a forward 
and an aft edge column without any control points columns in between): the 
surface stiffness can only be linear.  
 
Maxsurf will make sure the stiffness of the surface cannot be greater then the 
number on control points in that direction; i.e. if you have an order 6 surface and 
you reduce the number of columns from 6 to 5, Maxsurf automatically reduces the 
surface stiffness from 6 to 5. 

Tip: 
Use as little control points as possible on a surface that is as stiff as possible 
whilst achieving the required shape. This will result in a fair surface model. 

The example below shows a surface with the same net but with two different stiffness’s. 
One surface is set to flexible in both the longitudinal and transverse directions and the 
other is set to stiff. 
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Local Influence 
When using few control points, a control point movement may influence the whole 
surface, but when using many control points the control point's area of influence will be 
more local. 
 
This is illustrated below, showing the extent to which the surface deforms due to a 
control point movement using a rectangular 3*3 control point net.  
 
The movement of the middle control point on the top edge would result in, the following 
deformation.  

Note: 
The influence of the control point movement may be seen across the full 
width of the parametric surface. 
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If the net is increased to 9*3, keeping the stiffness (as set in the Properties dialog) the 
same, the result of a similar control point movement would be as follows. 

 

Through the addition of extra control points: 
• the surface has become more flexible 

• the influence of the control point movement is much more localized. 
 

Note:  
The surface stiffness actually relates to the number of continuous 
derivatives of the surface. There are two special cases: 

1. If the spline is order 4, the curvature is continuous and the spline is the 
same as a piece-wise cubic spline. 

2. If the order is one less than the number of control points, it is a Bezier 
spline. 

Surface Appearance 
The surface appearance may be used to change the colour of the smooth rendered view 
and the parametric curves of the surface. 
 
To change the surfaces' appearance: 

• Select Appearance from the Surfaces menu. 

• In the dialog, select the surfaces whose appearance you wish to modify. 

• To modify the colour, click in the coloured square and select the new colour from 
the pallet. 
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Note: 
Some graphics cards may ignore the transparency option. 

Surface Properties 
Each surface that is created within a Maxsurf design has a unique set of properties 
associated with it. The Properties command allows you to view and modify these 
properties.  

Note: 
The properties of all the surfaces may be quickly viewed and modified in 
the Surfaces window. 

 

It is possible for you to modify: 
 
Surface Name 

This may be any name typed in from the keyboard up to twenty characters long.  
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Surface Type 
May be set to conventional B-spline, NURB, Conic or Developable surface.  

Surface Use 
This tells Maxsurf and Hydromax whether the surface is an internal structure or 
not. Surfaces that are to be used for internal tank or compartment walls in 
Hydromax must be defined as Internal Structure.  

Note:  
It is very important to specify “surface use” in order for Hydromax and 
Workshop to interpret the Maxsurf model correctly. 

Visibility 
This determines whether the surface is visible or not. Visibility may also be set in 
the Visibility dialog from the Surfaces Menu. 

Locking 
This determines if the surface is locked or not. If a surface is locked none of its 
control points are displayed, and the surface may not be modified. Locking may 
also be set in the Locking dialog from the Surfaces menu.  

Symmetrical 
This determines whether a surface is displayed with its image reflected about the 
longitudinal centreline or not. 

Split Section Display 
Split Section Display is only activated in the Body Plan window, when the Half 
option is in effect. In this situation, if Split Section Display is activated, the surface 
will be shown with the forward sections on the right hand side and the aft sections 
on the left, as one would expect in a traditional hull body plan. 

 
The position chosen for the break in the display of the sections depends on the 
station you have selected in the Grid Spacing dialog. 

Stiffness 
Sets the surface stiffness in the longitudinal (row) or transverse (column) 
direction. See also Surface Stiffness on page 95. 

Material 
This tells Maxsurf, Hydromax and Workshop what material is used for 
construction, and how the thickness is calculated in regards to the hull shape. 

Note  
A materials library file must have been loaded when Maxsurf was started 
for there to be a list of materials to select. If no materials are available, you 
may simply type in the thickness. Further details are in the next section, 
Surface Materials. 

Outside Arrows 
Another surface property is the Outside Normal Direction. This direction is displayed in 
Maxsurf with Outside Arrows, which can be displayed from the Display menu or the 
Outside Arrows toolbar button.  
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The Outside Arrows tell Maxsurf which is the inside and which is the outside of a 
surface. This is important for the following Maxsurf functions:  

• Skin Thickness direction 

• Curvature display 

• Correct interpretation of model in Workshop and Hydromax 
 

Setting Outside Arrows 

• Select Outside Arrows from the Display menu. 
 
Selecting this menu item displays surface normal arrows in all of the display windows. 

 

By clicking on the circles at the heads of these arrows it is possible to reverse their 
direction. Do this until all arrows point to the outside of the hull. It may be necessary to 
look at different views or to rotate the hull in the perspective window in order to see the 
directions clearly. Once you have specified the outside directions, save the design; these 
directions will be saved in the Maxsurf design file and are used automatically by 
Workshop and Hydromax. 

Note: 
The length of the outside arrow may be changed in the Preferences dialog. 

Surface Materials and Skin Thickness 
Maxsurf provides a method for specifying skin thickness and material properties that are 
consistent and compatible with both Hydromax and Workshop. This also allows sections 
with skin thickness deductions to be displayed in Maxsurf, printed from Maxsurf or 
exported to a DXF file. 
 
Thickness can be either specified directly or selected from the Material pop-up menu. 
The Material pop-up menu will contain materials that have been loaded from the 
Workshop materials library. Workshop may be used to modify the library; users who do 
not have Workshop will have the default library. 
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The direction that the thickness projects from the line of the designed surface needs to be 
specified. Three choices are available: 

• inside the designed surface 

• centred on the designed surface 

• skin outside the designed surface.  
 
To do this Maxsurf needs to know what the inside and what the outside of each surface 
is. Make sure the Outside Arrows are set up correctly (pointing outwards, generally 
towards the “wet side” of the vessel). For more information on outside arrows see 
Outside Arrows on page 100.  

Note: Skin thickness and hydrostatic calculations 
In Maxsurf skin thickness is used for creating the table of offsets, however 
for hydrostatic calculation purposes, skin thickness is ignored. Hydromax 
can be used to calculate the effect of skin thickness on the vessel’s 
hydrostatics by selecting “include skin thickness” in the opening dialog.  

Skin Thickness Projected to the Inside 
An example of a thickness deducted inside the hull would be a hull made of foam 
sandwich, where the Maxsurf surface modelled the outside of the hull. The skin 
thickness deduction would then give the line of the inside of the foam core and 
laminations. 

 

Maxsurf Surface section 
line 

Skin thickness 
projected inside / 
deducted section line

Female mould

Female mould GRP example 

Skin Thickness Projected to the Outside 
A typical steel or aluminium boat is designed to a moulded line, to the outside of the 
framing, but the inside of the hull plating. Another example is a GRP boat build from a 
male mould. The Skin Thickness would then be added on to give the line of the outside 
of the plating. 
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Skin thickness projected outside 
/ Hydromax Section line with 
surface thickness included.  

Moulded line / Maxsurf surface 
section line 

Construction Frame 

Frame construction method (Same for male GRP mould method) 

Centred Skin Thickness 
Plating centred around the designed surface would be unusual for the hull shell, but has 
been included for possible use in the specification of internal structure. 

Display Skin Thickness and Direction 
You can see the effect of the skin thickness and direction you have specified by 
displaying deducted sections. To display deducted sections  

• Choose Contours from the Display Menu and select Deducted Sections.  
 
If this option is selected, deducted sections will be displayed on screen and included in 
DXF and IGES file output. 

Surface Precision 
Each curve drawn by Maxsurf is made up of a number of short straight lines.  
 
The precision selected corresponds directly to the number of line segments shown in a 
surface edge or contour, and also equates directly to the number of parametric lines 
shown when displaying parametric contours. 
Lowest Precision 

Lowest Precision may be used early in the design process for general design 
layout. It allows for fast modification of the shape, but lacks the necessary detail 
for optimising a design. It uses an 8 by 8 parametric mesh. 

Low Precision 
Low Precision is the suggested working precision for your design development 
and modification if you have a slow computer. It uses a 16 by 16 parametric mesh. 

Medium Precision 
Medium Precision is the suggested working precision for designs with more 
curvature, or with discontinuities, which need more precision for display. It uses a 
32 by 32 parametric mesh. 

High Precision 
High Precision may be used for complex shapes, or during printing or zooming 
when more curve definition is needed. It uses a 64 by 64 parametric mesh. 
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Highest Precision 
Highest Precision may be used when extremely high definition is required, 
typically for plotting final lines plans. Highest Precision will take much longer to 
calculate than Low precision.  
 
High and Highest precision are not fixed precisions, but adapt the number of 
segments to the amount of curvature in a surface. 

 

Data Insertion and Reduction 

Data Insertion 
High and highest precisions start with a 64 by 64 parametric mesh and then insert 
points into the curve to reach the curve tolerance you have specified using the 
Contour Tolerance field in the Preferences dialog. 

 

Data Reduction 
At Highest Precision redundant points are also removed from the curve. For 
example, if a surface is flat, all of the co-linear points along the middle of a line 
will be removed, just leaving the required end points. This can considerably 
increase display speed in Maxsurf and reduce the size of the DXF or IGES file. 
This makes the curves much faster to manipulate in your CAD system. 

 
Precision Number of segments Data reduction Data insertion 
Lowest 8 

  
Low 16 

  
Medium 32 

  
High 64 

  
Highest 64 
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The number of curve segments apply both to lines drawn to the screen, Clipboard, and 
IGES files, as well as to output devices such as printers. 

Surface Curvature 
Maxsurf has two different ways of displaying surface curvature. First, rendering of the 
surface can be used to display a colour shading which indicates the curvature across the 
surfaces. Secondly, curvature along a selected contour or contours can be displayed as a 
porcupine; see Curvature on Contours on page 109. 

Curvature Display Using Rendering 
Maxsurf has four different ways of calculating and rendering curvature on a surface. You 
control these settings using the Rendering command from the Display menu. Before you 
use Rendering, make sure that you have used the Outside Arrows command to set up the 
surface normal direction for each of the surfaces. Render may only be selected when the 
Perspective window is active. 

 

To display the rendered view, it is necessary to turn on hidden surface elimination. It is 
then possible to display a shaded view of the design, or to use false colouring to highlight 
the curvature of the surfaces. 
Hidden Surface Elimination 

Selecting Hidden Surface Elimination performs surface shading over the surface, 
using a fixed light source. If Smooth Shading is selected, the base colours of the 
surfaces are those chosen in the Appearance option from the Surface menu. 

Simple Shading 
Shading using polygons is utilised. Surface contours may also be displayed with 
this option. 

Smooth Shading 
An alternative shading algorithm is used to provide smoother rendering. The 
colours of the surfaces may be changed in the Appearance dialog. 
 
To examine the fairness of your design, Maxsurf can use false colouring to display 
four types of surface curvature. These have different uses and are described below: 

Gaussian Curvature 
Is the product of the maximum and minimum curvatures at a point on the surface. 
Gaussian curvature will indicate whether the surface is locally elliptical (positive 
Gaussian curvature, i.e. both curvatures in the same direction), whether it is 
hyperbolic (negative Gaussian curvature, curvatures with opposite signs i.e. saddle 
shaped), or whether it is developable (zero Gaussian curvature).  
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Gaussian curvature is a useful indicator of areas of twist in a surface, but is not 
directly linked to surface fairness. It is possible for a surface to be quite unfair and 
still be developable, yet the Gaussian curvature display will not reveal any 
problems. 
 
Gaussian curvature can be used as an indication of whether a surface is 
developable. A developable surface is one that can be formed out of a flat sheet 
material by bending or rolling, without stretching or distorting the material. In this 
case, the surface will have a Gaussian curvature of zero at all points; i.e. the 
surface is only curved in one direction and straight in the direction orthogonal to 
that. See Developable Surfaces on page 95 for more information on what 
developable surfaces are and Modelling Developable Surfaces on page 146 for 
information on how to model developable surfaces in Maxsurf. 

 
You can adjust the brightness value to make the display more or less sensitive to 
the Gaussian curvature values. See Brightness Level on page 107 for more 
information. 

Note: 
The Gaussian curvature gives an indication of developability, but only 
should only be used to isolate areas where the plate will be less developable.  
If you want to be certain of a plates’ developability, load the surface into 
Workshop and develop a surface plate. You can then examine the strain 
distribution on the plate; the plate is developable if there is no strain. A 
small amount of strain can be acceptable dependent on the builders’ plate 
bending equipment and production techniques. 
 
See the Workshop manual for more information, especially regarding 
precision settings during plate development. 

Longitudinal Curvature 
This is a display of the curvature of each longitudinal parametric curve, taken 
perpendicular to the surface at each point along the curve. 

 
This display is extremely useful for determining the longitudinal fairness of a 
design. You should look for an even graduation of colour along the hull. 
Inflections can be detected by looking for changes from blue (positive curvature) 
to red (negative curvature). If you choose to show positive curvature values only, 
do so by using the following settings: 

 

This will reveal areas of negative curvature by painting them black. 
Transverse Curvature 

Is the curvature of each transverse parametric curve, also taken perpendicular to 
the surface at each point along the curve. 

 
This display is extremely useful for determining the transverse fairness of a 
design. You can mask off areas of positive or negative curvature in the same way 
as with the longitudinal curvature display.  
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Convexity  
The convexity check highlights any areas of negative curvature. 

 
The convexity check calculates and displays the minimum curvature for each point 
on the surface. If this minimum curvature is less than zero, the surface is locally 
concave. 

Brightness Level  
The brightness level referred to in the dialog affects the way in which the colours in the 
display are mapped onto the curvature values.  

 

Because the range of colours is small and the range of curvatures infinite you may need 
to change the colouring to suit the curves you are looking at. Changing the brightness 
level re-maps the colours - if the image is very dark and it is difficult to distinguish 
different curvatures, try using a smaller number. On the other hand if the image tends to 
be all pale colours, try a darker tonal value. 
 
For Gaussian curvature, a higher brightness level will make the display more sensitive to 
non-zero Gaussian curvature, highlighting more areas. See Curvature Display Using 
Rendering on page 105 for more information.  

Lighting Options  
Maxsurf allows the user to edit the lighting settings used in the perspective window when 
rendering is turned on.  
Light Positions 

Maxsurf has the option to use four different light sources. These can be turned on 
and off by clicking in the Render toolbar.  

 

   
 

It is possible to vary the location of these lights by editing values in a lighting 
dialog. This dialog is displayed by clicking on the right most icon in the Render 
toolbar when the Perspective window is active and rendering is turned on. 
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Each light is specified by three values, distance, bearing and elevation. Distance is 
measured from the centre of the view in the perspective window. Bearing is taken 
relative to the direction from the eye to the object being viewed. For example, a 
light at 0 degrees is pointing in the same direction as the eye is looking at the 
object, 90 degrees is to the right of the object, -90 degrees is to the left of the 
object and 180 degrees is behind the object. Elevation is in degrees above the 
horizontal. A negative elevation value defines a light shining up from below the 
horizontal. 

 
Light Intensities 

Ambient, Diffuse and Specular values define what kind of reflection will be seen 
on the surface. If only ambient light values are specified, the object will be lit 
evenly from all directions and its reflected light will not appear to change in 
brightness as it is rotated. This is analogous to the sort of light seen on an overcast 
day. The result is no differentiation of colour or brightness across the surface. 

 
Diffuse light is directional but is made up of parallel rays. The effect on an object 
illuminated with a diffuse light is that it changes in brightness as it is rotated due 
to the change in the incident angle of the surface. 

 
A specular light is one that comes from a specific point such as a light bulb. When 
an object is lit with specular lights, definite highlights will be seen moving across 
the surface as it is rotated. 

 
In practice, the ideal combination seems to be a small amount of ambient light, and 
roughly equal contributions from the diffuse and specular lights. 

OpenGL 
Smooth shading rendering uses OpenGL. OpenGL supports transparency and this may be 
specified on a surface by surface basis using the Appearances dialog in the Display 
menu. 
 
OpenGL should work correctly with all versions of Microsoft Windows, except for the 
earliest releases of Microsoft Windows 95. These users, who are using a version of 
Windows 95 prior to OSR2, will need to download the OpenGL DLL. This is a free 
download, available from www.microsoft.com. Users should install the OpenGL drivers 
supplied with their video card or the default driver installed with Microsoft Windows. 
 
OpenGL requires suitable driver software to run correctly. The driver required depends 
on the operating system and video card you have on your computer. The driver is 
normally supplied by Microsoft, or the video card or video card chipset manufacturer. 
Occasionally there may be problems with the driver, which prevent Maxsurf from 
rendering the image correctly or may even cause the computer to crash. This is more 
likely for very new video cards and/ or new, or less popular, operating systems such as 
MS Windows 2000 or MS Windows NT. This is because the drivers will have had less 
testing. If a problem occurs, one way of helping to determine if the driver or Maxsurf is 
at fault is to try running other OpenGL software such as the OpenGL screen savers; if the 
OpenGL screen saver crashes, the problem is probably with the OpenGL driver and you 
should try to update it. Video card manufacturers regularly update their drivers and these 
are normally available from their web sites. Another web site, which can be very helpful, 
is: www.opengl.org.  

http://www.microsoft.com/
http://www.glsetup.com/
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Curvature on Contours 
The second way to display curvature on a Maxsurf design is to select a contour or group 
of contours, and use the Show Curvature command from the Display menu. Curvature 
may be displayed on all surface contours except intersection lines. 
 
To select a contour, click on the contour. It will be highlighted with a different line 
thickness and colour. To select more than one contour, shift-click on other contours. 
 
When you choose Show Curvature, "Porcupines" are displayed perpendicular to the 
curve, and their lengths are inversely proportional to the square root of the radius of 
curvature at that point on the curve. Therefore the longer the porcupine line, the tighter 
the curve. 
 

Note:  
The value of the smallest radius (tightest bend) on a given curve is displayed 
numerically at the end of the porcupine located at the corresponding 
position on the curve. 

 

To hide the display of curvature porcupines, choose Hide Curvature from the Display 
menu. 
 
The lengths of the curvature porcupines may be scaled in the Curvature Scaling Factor 
field in the Preferences dialog. 

Surface Operations 
Maxsurf contains several commands that allow you to manipulate whole surfaces. These 
commands generally apply to the current surface, that is the last surface selected or 
modified. If you are unsure as to which surface is the current surface, you can check the 
list of surfaces in the additional menu that appears when you place the cursor on the 
Properties item in the Surfaces menu. Alternatively, you can ensure that the surface you 
wish to work on is the current surface by selecting any control point in the surface. 

Adding Shapes 
Maxsurf has a number of standard shapes, which may be added to a design. They are as 
follows: 
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Box  
This is a box shaped prism; the primary axis may be selected to be orientated in 
the longitudinal, transverse or vertical direction, this will determine where the 
open ends are. The length, width and height are the dimensions in longitudinal, 
transverse and vertical directions respectively. 
 
Additional surfaces to close the open ends of the prism may be added if desired. 
 
The box is placed on the centre line of the design. If the Symmetrical box is ticked, 
either a full or half model may be selected. For shapes that lie symmetrically on 
the centreline, it is best to select the Half Model on Centreline option. To add a 
complete box, away from the centreline, tick the Symmetrical box and select the 
Full Model button, then move the box away from the centre line to its desired 
location using the Move command from the Surfaces menu. If the box appears 
symmetrically on both sides of the vessel, you can then turn on the symmetry flag 
for the box's surfaces. 

Cylinder  
This is a circular or elliptical cylinder, the options work in the same way as the 
box. 

Sphere  
This is a circular sphere of specified radius. The various symmetry options are the 
same as for the box. 

Hemisphere  
This is a circular hemisphere of specified radius, which may or may not be closed 
with a disk. The hemisphere may be orientated in the longitudinal, transverse or 
vertical direction. 
 

The illustrations below show the different effects that may be achieved with the 
symmetry options. In addition, the front and back ends of the box could have been closed 
with two additional surfaces if the Close Ends option had been ticked. (Box#1 is the top 
part of the box and Box#2 is the bottom; Box#3 and Box#4 are the mirrored surfaces.) 
 

 

  

Non-symmetrical model  
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Symmetrical half model on centreline  

  

Symmetrical full model on centreline made up of four non-symmetrical surfaces  

  

Symmetrical model offset from centreline after move command and changing symmetry flags 

Adding Surfaces 
When adding a surface, it is possible to select from a range of different surfaces in the 
Add Surface menu. 
 
To add or delete surfaces from the list, which appear in the Add Surface menu, use the 
Edit Surface List command from the Add Surface sub-menu under the Surface menu. 
 
To delete surfaces from the Surfaces list, select the surfaces to be deleted then click the 
Delete button. 
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To add surfaces from your existing design to the surface list, click the Add button then 
choose the surfaces from your design that you wish to add to the list. 

 

Deleting Surfaces 
Choosing Delete Surface presents a dialog that allows you to select surfaces for deletion. 
Simply click on those surfaces you wish to delete and click OK. 
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Multiple surfaces may be deleted at the same time, and a surface that is bonded to 
another may be deleted without the need to unbond first. 

Duplicating Surfaces 
This command duplicates the selected surfaces. 

 

• Select Duplicate Surface from the Surfaces menu. 

• Select the surfaces to be duplicated. 

• Click OK 
 
A number of duplicates may be made at one time and these can be offset from the 
original, and one another, by the specified longitudinal, transverse and vertical spacings. 
If the Respect Bonding box is ticked, surfaces which are bonded will be selected and 
copied together. 

Moving Surfaces 
Surfaces may be selected and moved relative to one another. This can be achieved by 
freeform dragging of the surface or by typing in a numerical offset. 
 
Freeform Movement: 
Movement is made in the plane of the window that is being used, or in the case of the 
Perspective window, in the plane most perpendicular to the current view. To select a 
surface for movement 

• Select Move Surface - Freeform from the Surfaces Menu. 
 
The move cursor will be displayed.  

 

• Position the cursor over any control point. 

• Click and drag the surface to the new location. 
 
An outline of the surface will display the position of the surface while it is being moved. 
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• Release the mouse button. 
 
On releasing the mouse button the surface will be displayed again at the new location. 
 
Move Surface will move all surfaces bonded to the surface that is being moved. Note that 
all these surfaces must be unlocked. 
 
Numerical Movement: 
To move surfaces by a specified amount: 

• Select Move Surface - Numerical from the Surfaces Menu.  

• Select the surfaces to be moved and specify the amount that they should be moved 
in the longitudinal, transverse and vertical directions. 

Locked surfaces or those which are bonded to locked surfaces cannot be selected. 

 

Size Surfaces 
The Size function allows a designer to scale and re-proportion a surface or group of 
surfaces by their principle dimensions. This function is particularly useful when 
modelling geometrically similar variations from a parent design, and also allows precise 
specification of principle design parameters. 
 
To resize a design 

• Select Size from the Surfaces menu. 

• Select which surfaces you wish to resize. 
 
Do this by selecting the surface names from the check boxes on the left hand side of the 
dialog. When a single surface is selected the size displayed will be the overall 
dimensions of that surface. When multiple surfaces are selected the size displayed will be 
the overall dimensions of all selected surfaces. 

• Select whether you wish to use proportional scaling. 
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For example, if you wish to maintain a length/beam ratio, tick the boxes of the dimension 
to be scaled proportionally (length and beam). When any of the dimension boxes are 
changed all boxes selected for proportional scaling will be changed in proportion. 
 
Similarly, length, depth and beam may be scaled simultaneously, to produce a 
geometrically similar vessel, by ticking all three boxes. The desired length, depth or 
beam may be entered and all dimensions will be scaled proportionally. The dimensions 
will follow in proportion from the time that their proportional scaling boxes were ticked. 

• Select and edit the appropriate size boxes to alter the size. 
 
You may do this by either editing the text directly or by using the scale up / scale down 
arrows at the right hand side of the size boxes. Dimensions may be entered in any units 
by specifying the appropriate suffix. 

Note: 
Only the actual surfaces are changed by resizing. The grid spacing does not 
change as the hull is resized. This means that you may need to reset the grid 
to accurately reflect a new waterline length. 

Markers may be scaled in the same proportion as the hull or may be left as they are. Tick 
the re-scale markers box to scale the markers with the surfaces. 
 
You can size different surfaces by different amounts. This can be done by: 

• Selecting the first surface(s) you wish to resize 

• Resize them (as described above) 

• Deselect these surfaces and select the other surfaces you wish to resize 

• Resize these surfaces 

• Repeat for all the surfaces you wish to resize 

• Click OK 
 

Flipping Surfaces 
Surfaces may be flipped about specified planes: longitudinally, transversely or vertically. 
The actual mirror plane may also be specified, and need not be about the origin. At the 
same time you may also create a duplicate of the original surfaces. 

• Select Flip Surfaces from the Surfaces menu. 

• Select the surfaces you wish to flip. 
 
If you are duplicating the surfaces, they need not be unlocked since the original surfaces 
will remain unchanged. If you are not duplicating the surfaces then they must be 
unlocked. If you choose Respect Bonding, bonded surfaces will be selected together. If 
you are not making duplicates, all the bonded surfaces must be unlocked. 

• Specify the reflection plane. 
 
For example, if you wished to make a symmetrical catamaran hull, with a centreline 
spacing of 8m, you would design one side of the hull, move it transversely 8m then flip 
and duplicate it about the 8m transverse plane. 
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Flipping about the longitudinal direction could be used to produce a double-ended 
design. 

Rotating Surfaces 
The rotation dialog allows multiple surfaces to be rotated simultaneously around a 
specified centre of rotation. Surfaces to be rotated are selected by clicking in the list of 
surface names.  

 

The centre of rotation is specified numerically, and is displayed in the drawing windows 
as a small circle: 

 
 
The selected surfaces will be rotated about the rotation point by the angles chosen. 
 
The centre of rotation (Reference Point) may be moved by double clicking on it in one of 
the design views and entering its new position numerically: 
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Aligning Surfaces 
Two surfaces can be aligned by selecting one control point from each surface. The 
second control point will be moved, along with its entire surface, so that it aligns exactly 
with the first control point. 
 
To align two surfaces 

• Select a control point from the surface to remain fixed.  

• Hold down the Shift key.  

• Select a control point from the surface to be moved.  

• Select Align Surfaces from the Surfaces menu. 
 
The second surface you selected will be moved so that the two control points become 
coincident. 
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Trimming Surfaces 
A surface's boundary and any intersections with other surfaces create regions which may 
be made visible or invisible. A surface that has invisible regions is said to be trimmed. A 
surface that intersects the trimmed region may be referred to as the trimming surface.  

When to Use Trimming 
Trimmed surfaces allow complex shapes to be modelled in Maxsurf. Trimming is most 
likely to be useful when the surface is fair but there are discontinuities in the edges of the 
surface or a hole has to be cut in the interior. 

 

Typical applications:  
• Deck edges 

• Transom 

• Propeller tunnel 

• Bowthruster 

• Non-tangential Skeg / Keel - hull transitions 

• Superstructure penetrations through decks 
 
Another reason to use trimming could be when two surfaces are combined to form one 
shape, while they do not have the same properties such as stiffness or number of control 
point columns.  

 

An example of a Chined hull using trimmed surfaces. It is difficult to control the shape of the intersection line 
using two trimmed surfaces. In this case it is often preferable to use bonding.  
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The disadvantages of using trimming for this purpose are: 
• No or little control over the shape of the intersection line of the two surfaces, 

especially if the intersection line is quite shallow (eg a propeller tunnel with a 
smooth transition with the hull) 

• It is more difficult to make changes to the model whilst maintaining trimming 
information. The trimming is easily lost. 

 
It is often better to use bonded surfaces when two surfaces have to be combined into one 
shape.  

Note: 
In general it is recommended to use trimming to create discontinuities in the 
surfaces edge or holes in the surface interior.  

Instead of trimming you can often also choose to use bonded surfaces. One of the main 
advantages of using bonded surfaces is the ability to join two surfaces and have control 
over the intersection shape. Models with bonded surfaces are easier to make changes to 
and export to other programs. See When to Use Bonding on page 127.  

Trimming Concept 
Maxsurf uses the concept of a 'region' to define an area of a surface that may be visible 
or invisible (trimmed off). These regions are defined by the boundaries of the surface and 
any intersections that the surface has with any other surfaces. 
 
Before trimming any surfaces, it is useful to check that the surfaces intersect properly. 
Since, if this is not the case, it will not be possible to correctly trim the surfaces. To 
display the surface intersections,  select Contours from the Display menu and place a tick 
next to the Intersections item. Surface intersections are normally displayed in yellow. 
Check that these are as required. 
  
Consider the sample shape below. The left picture below shows four surfaces: a planar 
surface which we wish to trim, a cylindrical surface and two arc-shaped surfaces. We 
wish to trim the planar surface to the boundaries defined by its intersections with the 
other three surfaces. 

 

Initially, all of the regions on the surface are visible and selected. We need to de-select 
the regions that need to be trimmed off. 
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All regions are initially selected, regions to be trimmed off are removed by clicking in 
the unwanted region. 
 
Once we trim off the unwanted regions we are left with the required shape. 

   

Perhaps the most important thing to remember is that for a region to be used as a 
trimming region, it must be fully bounded. In other words, the perimeter of the region 
must be fully closed. If a perimeter is not closed, a region cannot be properly formed. 
The diagrams below explain the difference between closed and unclosed regions. 
 
GOOD: (Closed regions) 

 

POOR: (Unclosed regions)  
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Note:  
Maxsurf will find all the closed areas defined by the surface edges and any 
intersections. Even though two of the three intersections do not define fully 
bounded regions, when placed together, Maxsurf will find both regions 2 
and 3. 

  

In this example, the intersections do not define fully closed regions, so Maxsurf will find 
a single region, which covers the entire surface. 

Trimming a Surface 
First have a look at the following flowchart giving an overview of the trimming steps:  
 

Start State

Surface Trimmed

Maxsurf in Trim mode

Step 2: Start Trimming & Select 
Surface

2 a. Surfaces | Start Trimming | <Surface>
2 b. Right click on any contour/edge/intersection
2 c. Right click on surface in Assembly window

Surface regions 
highlighted

Surface Regions 
Selected

Step 3: Select Regions to trim
Regions in grey will remain visible

Step 4: Trim Surface
4 a. Ctrl + T
4 b. Right click anywhere in screen and 
select Trim <Surface>
4 c. Surfaces | Trimming | Trim <Surface>

Step 5: Repeat
Trim other surfaces (optional) 

Step 1: Turn trimming on
     1 a. Trimming Gray
     1 b. Trimming Invisible

 

Note 
It is important to note that after you have taking step 2, you have to do steps 
3 and Step 4 as well. Maxsurf will continue to ask you to select your regions 
and trim the surface until you finished Step 4. 
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Example: 
The following example shows a chined vessel. The boat has been modelled with a hull 
and a transom. The transom will be used to trim off the aft most sections of the hull. 
 
To trim the hull surface 

• Turn on trimming by selecting Trim Gray or Trim Invisible from the Display - 
Trimming menu.  

• Select the surface to be trimmed from the Surface - Start Trimming menu. (e.g. 
Hull) 

 
Maxsurf will show the hull surface with all the currently visible regions selected. In this 
case since the whole surface is visible, the whole surface will be selected. A selected 
region is shown with Gray shading.  

 

To change the visibility of a region, click inside that region. The shading will be turned 
off or on as appropriate to show whether it is selected or not.  
 
In this case, to trim off the area behind the transom (i.e. make it invisible), simply click 
on the region defined by the edges of the hull, and the hull's intersection with the 
transom. When this region is clicked on, the shading will disappear.  
 
After clicking in the region to be trimmed off, the screen looks like this: 
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The window may be zoomed, panned or rotated while regions are being selected. 
 
Now that all the regions to be trimmed off have been selected 

• Choose Trim from the Surface menu (or use Ctrl T). 
 
The contours on the design will now be recalculated and trimmed to the visible regions 
of the hull surface. 
 
Trimming is often easiest in the perspective window with the “Half” display option 
turned on. This way you will only see the actual surfaces and not their mirror images. 
Rotate the view direction so that you can select the desired region. You can zoom and 
pan the design whilst trimming; however, you cannot change window. 

Displaying Trimmed Surfaces 
Maxsurf provides the option of displaying trimmed contours in Gray or ignoring 
trimming altogether.  
 
The Trimming command in the Display menu controls how Maxsurf will display 
trimmed surfaces. If Trimming Off is selected, Maxsurf will not display or recalculate 
any trimmed surfaces. This provides a method for making changes to the design without 
the overhead of recalculating the surface trimming after each change. 
 
If Trim Gray is selected, Maxsurf will trim off any parts of the contours that are not in 
the visible regions of the surface, and show the trimmed off parts in grey. 
 
If Trim Invisible is selected, Maxsurf will trim all contours to the visible regions of the 
surface and not display the trimmed contours. 
 
If the trimming mode is set to off, and then turned on (or Gray), Maxsurf will find all the 
intersections, and attempt to reform any trim regions that you have selected. For 
example, you could work in low precision with trimming turned off, and switch to high 
precision with trimming turned on to have a more accurate look at the design without 
having to re-trim the design. 
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In some cases, if the design has been substantially changed, it may be necessary to re-
trim some surfaces. It is possible for a complete surface to be trimmed away and hence 
invisible when trimming is turned on, if this happens use Trim Gray to make the surface 
visible or untrim the surface; see Untrim Surface in the next section. 
 
A good design will trim consistently at all precisions. If you find that the trimming 
behaviour changes at different precisions, your surfaces may not intersect consistently as 
you change the precision. The best way to overcome this type of problem is to increase 
the amount by which surfaces overlap. 
 
Also be aware that you may loose or change trimming information if you add new 
surfaces or move existing surfaces or control points so that the trimming regions change 
considerably. It is generally best to do the trimming when you have virtually completed 
the design. 

Untrim Surface 
The trimming information for any surface may be removed by selecting Untrim - Surface 
name from the Surfaces menu. Only surfaces that have been trimmed are listed in the 
Untrim menu. 

Note 
Only visible surfaces are listed in the trim menus. 

Trimming Rules 
Trimming is an extremely powerful tool to model a wide variety of shapes using 
surfaces. However, trimming is also a common cause of difficulties with the surface 
model that can easily be prevented by following the guidelines below.  
 
1: Closed regions 

Make sure the region you wish to trim is completely enclosed by intersection lines 
or edge lines.  
• Symptom: the region cannot be selected 

• Check the intersection line carefully by zooming in.  

• Check the centreline control points are on the centreline (do a multiple selection 
and a control properties, check offset = 0). 

 
2: Overlap 

Use sufficient overlap on the trimming surface. Plenty of overlap helps to identify 
remnants of untrimmed surfaces, makes trimming easier, makes it easier to change 
the trimmed surface without losing trimming information etc. 
• Symptom: region cannot be selected, precision settings affect trimming. See 

images below for explanation why precision can affect trimming. 

• Never put the trimming surface’s edge exactly in the plane of the surface that you 
want to trim. 

 
3: Over-compacted control points 

Do not over-compact control points to create knuckles in the surface. See 
Discontinuities and Feature Lines on page 166. 
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4: Surfaces exactly on top of each other 
Do not place two surfaces exactly on top of each other. This often happens during 
a Duplicate surface command without adding any spacing between the surfaces. 
• Symptom: nothing happens after Start trimming is selected 

• Make sure the surfaces are sufficiently spaced so that there is no maze of 
intersection lines visible. 

5: Make sure trimming works at medium & highest precision  
It is important to make sure the model trims at medium and highest Surface 
Precision. This guarantees that the model can be transferred to other programs 
without any problems. Sometimes it may be better to use bonded surfaces as well, 
see When to Use Bonding on page 127. 

 

No trimming region at lowest precision 
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Trimming region at medium precision 

Not only Maxsurf uses the trimmed surfaces for its calculations, also the other programs 
in the Maxsurf suite require the model to be trimmed properly. 
 
All trimming rules originate from the trimming concepts, so make sure you have read the 
Trimming Concept section on page 119. 
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Bonding Surfaces 
Maxsurf allows you to join two surfaces together along a common edge so that the two 
surfaces behave as one larger surface. This procedure is referred to as Bonding. The 
edges may be in the same surface, or in separate surfaces.  
 
Bonding is an extremely powerful tool to help you create all kinds of features such as 
areas with specific radiuses, chined transitions etc. Aside from that Maxsurf has the 
capability to enforce specific tangential continuity across a bonded edge.  

Bonding Rules 
Two rules govern which edges may be bonded together: 
 
1. The two edges that are to be bonded must share the same number of control points 
along their respective edges. 
 
2. The two edges must share the same stiffness in the direction of the edge. 

 

When to Use Bonding 
Bonded surfaces are typically used to achieve particular design features where different 
types of surfaces or surfaces with different properties have to be used. 
 
Typically a bonded surface is used to achieve a combination of regular hull surfaces:  

• Areas with a specific radius using conic surfaces: bilge, bowcone, transom-hull 
transition 

• Areas with no curvature using linear surfaces: flat plate 

• Areas where you require a different stiffness in the direction other than the 
direction of the edge. For example a transition from transverse stiffness 5 to 
transverse stiffness 3 along a longitudinal bonded edge.  

 
Example applications 
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• Knuckles in the hull, chines 

• Bowcones 

• Bilge radiuses 

• Flat of sides, flat bottom plate 

• Box shaped models, deckhouses that require plate expansion 

• Bulbous bow transition into hull 

• Tangential keel – hull transitions  

 

Example of a model using bonded surfaces; bow cones, swim platform, radiuses and large fillets. 

The advantages of using bonding are:  
• Tangent transitions between surfaces with different properties. 

• Control over the shape of the bonded edge. 

• Knuckles can be created without adding a lot of extra control points as opposed to 
using compacted control points.  

• Model transfers into other programs more easily (no trimming problems) 

• By dividing the model up into different panels, the plate development can be a lot 
easier in Workshop. You can use the Develop Surface command in Workshop 
without having to subdivide the surface. 

 
The disadvantages of using bonding are:  

• It can sometimes be difficult to change the surface shape of the bonded surfaces 
due to tangency constraints. Applying the tangent transition at a later design stage 
and some practice can solve this.  

• Certain changes, such as changing the number of control points on the edge or the 
stiffness of the edge, affect both surfaces. This may result in:  

o A large number of surfaces (use the Assembly window to manage large 
number of surfaces) 

o A large number of control points 
 

Bonding two Surfaces 
Two edges need to be selected for bonding. The first edge selected will remain stationary 
in space while the second edge is moved to exactly match it. The process of bonding may 
be performed by using the following steps: 
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• Select the edge that you wish to remain stationary first, 

• While holding the Shift key down, select the second that you wish to move and 
bond to the stationary edge, 

• Choose Bond Edges from the Controls Menu and select the type of tangency you 
wish to apply to bond the edges together. 

Or,  
• Select any control point, excluding corner points, from the edge that you wish to 

remain stationary first, 

• While holding the Shift key down, select any control point, excluding corner points, 
from the edge that you wish to move and bond to the stationary edge, 

• Choose Bond Edges from the Controls Menu and select the type of tangency you 
wish to apply to bond the edges together. 

 

 

Corner points cannot be used to select edges, as they fall on two edges simultaneously, 
and so do not uniquely define one particular edge. Hence edges that you wish to bond 
must contain at least one intermediate control point. 
Only two edges may be bonded together. However, if you wish more surface edges to be 
bonded you can manually bond the third edge by compacting and grouping the control 
points and make the surface stiffness’s the same. 
 
Also see: 

Advanced - Transpose on page 168 for information on how to swap rows and 
columns. 

Bonding with tangent continuity 
Maxsurf has additional options for bonding together two surface edges while maintaining 
overall fairness across the surface edge. This is particularly useful in situations where it 
is necessary to create a number of surfaces in an area of the hull but no discontinuities 
are desired. Maxsurf has three options to bond together two edges 

• No Tangency 

• Approximate Tangency 

• Strict Tangency 
 
No Tangency: 

Ensures that each control point along the bonded edge maintains the same location 
as the corresponding point on the other surface and the surface has the same 
stiffness in the direction of the bonded edge.  
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Original surfaces to be bonded 

 

Bonding with No Tangency, points on edge share same location 

Approximate Tangency: 
Ensures that the two control points in the same row or column perpendicular to the 
edge remain in a straight line. This is the same effect you can get by using the 
Align to Vector command and it helps ensure that the surfaces share a common 
tangent direction across the edge. In some cases, particularly when there is 
significant twist in the surface, this is not sufficient to guarantee tangency and the 
third bonding option must be used. 

 

Approximate Tangency – Rows are colinear across the surface edge 
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Strict Tangency: 
Ensures both that each row or column running across the surface edge is kept in 
alignment with the corresponding row or column on the other surface, and also 
that the next control point on each side of the edge is kept at an equal distance 
from the edge. This guarantees tangent continuity in all cases. 

 

Strict Tangency – Rows are co-linear across surface edge and points are equal distance from the edge 

After bonding with a tangency constraint, and points either side of the edge are moved, 
the points on the opposite side of the bonded edge will move in the opposite direction to 
maintain continuity. If a point on the edge is moved, then both adjoining points will be 
moved in the same direction and by the same amount. 

 
When bonding two edges together using tangency constraints, some control points will 
be moved by Maxsurf to ensure continuity. In this case, the rule as to which points 
remain unchanged and which points are modified is the same as that used with simple 
bonding. The first surface selected is treated as the master surface and is not modified in 
any way. The second surface selected is regarded as the slave surface, meaning that 
Maxsurf will modify points in this surface as required to meet the constraints. 

Viewing bonding types 
Positioning the mouse cursor over a bonded edge will display both edge names and the 
continuity constraint in the bottom left of the status bar: 

 

The following types of bonding annotations are possible: 
• C0 = No Tangency 

• C1 Lenient = Approximate tangency 

• C1 Strict = Strict Tangency 
 
If a bonded edge is selected, the bonding constraint will be displayed ticked in the 
Bonding menu: 
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Changing bonding types 
You can change the type of tangency easily by simply selecting a bonded edge or a 
control point on that edge, excluding corner points, and re-apply the bonding. 

 

Selecting a shared control point on a bonded edge. 

Tip:  
In practise you may find it more convenient to use “no tangency” in early 
stages of design and then apply tangency later when you get to the fairing 
stage of design. This is mainly because the control points move on both 
sides of the bonded edge when tangency constraints are used.  

Unbonding 
Any two edges may be unbonded by selecting the bonded edge or a control point on that 
edge, excluding corner points, and choosing Unbond from the Controls menu. Once the 
edges are unbonded they are free to move independently. 

Bonding within a Surface 
Edges within a surface may also be bonded to one another as long as they follow the 
requirements of number of control points and stiffness. If you wished to form a closed 
surface, you might start off with the following net arrangement, with the object being to 
bond the two edges as indicated. 
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This net would generate a closed surface joined along the bonded edge. To highlight the 
bonded edge as shown, select the Bonded Edges option from the Contours dialog.  

 

Commands Affected by Bonding 
Bonding can effectively combine two surfaces to form a larger surface. As a result, 
commands that previously worked on single surfaces treat bonded surfaces as one. 
Examples of this are: 
 

Adding and Deleting of controls, where the row or column extends across a 
bonded edge. 
 
Surface locking, where all surfaces that are bonded together are locked or 
unlocked in unison. 
 
The Size Surface function, i.e. bonded surfaces cannot be sized independently. 
 
Surface movement commands such as Move, Flip, Rotate and Align. 
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Fitting Surfaces  
Maxsurf has some extremely powerful built in tools for fitting surfaces to existing 
marker data. These marker data may be from an existing design which has been imported 
from a DXF file or perhaps a table of offsets. 
 
This version adds a new surface fitting function to Maxsurf. This function differs from 
Prefit in that it uses a Genetic Algorithm to optimise both the surface fit and net fairness, 
resulting in better quality control point nets.  It is however significantly slower than 
Prefit with quality fits taking several hours. At the moment it is restricted to fitting one 
surface at a time, however this will be changed in future to fit multiple surfaces. 
 
There are also various tools to assist with manual fitting to existing designs. Users will 
see many additional features relating to markers, and these have been collected in the 
new Markers menu. 
 
Other main features include the ability to load scanned images into the background of the 
design views, OpenGL rendering and a Assembly window, which is very useful for 
managing complex, multi-surface designs. These features are described in greater detail 
below. 

Surface Fitting with Genetic Algorithms 
The Genetic Algorithm (GA) is an advanced optimisation method based on a simulation 
of the process of evolution. Although slow, GAs are excellent for solving problems with 
large numbers of dimensions and constraints. The surface fitting problem falls into this 
category, as it is not sufficient to simply create a surface that is a close fit to the data 
points provided, it is also desirable that the surface be fair and that the control point net 
be smooth and regular. 
 
Genetic Algorithms start by creating a population of individuals with a small amount of 
random variation. In the case of surface fitting, a population of usually 25 to 50 surfaces 
is created based on an initial example surface. Each individual in the population is made 
unique by randomly moving one or more control points a small distance. 
 
Once the initial population has been created the system simulates evolution by repeating 
the following steps until a solution is found that meets the fitting criteria sufficiently 
well. 
 
Measure the fit of each individual surface to the data points and give it a score based on 
its quality of fit, fairness and net regularity. Rank all the individuals from best to worst. 
Repeatedly choose two individuals as parents, with individuals being chosen in 
proportion to how highly they were ranked in step 1. This means that the most successful 
individuals produce the most offspring in the next generation.  
Create members for the next generation by choosing some surface control points from 
one parent and the remainder from the other parent. Occasionally include a small amount 
of random control point movement to provide some mutation from generation to 
generation. 
 
The result is a population that progressively gets closer to an ideal solution of the 
problem, with poor solutions being eliminated. The highest ranked individual in the final 
generation is the best solution. 
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Advantages Over Prefit 
Prefit is already capable of quickly fitting a simple surface to a table of offsets, however 
it has several disadvantages: 

• Ordered data points. 
Prefit requires that data points be ordered in consecutive columns from the stern to 
the bow. Points within each column should be in the correct order. 
• Density of data points. 
Prefit has problems if the data points are unevenly distributed over the surface. 
• Poor net of control points. 
The resulting net of control points from the Prefit fitting process is often not 
suitable for modification in normal design work. Columns and rows may be 
skewed and be irregular in their layout. 
• Poor fairness. 
Even when the Prefit surface fits the data closely, it is possible for it to contain 
significant unfairness. 
 
Although much slower, the Genetic Algorithm fitting method has several 
advantages over Prefit. 
• Data may be unordered. 
It is not necessary to organise data into rows or columns, nor is it necessary for 
points to be sorted into a particular order. The GA fitting method can handle 
randomly ordered data with no problems. 
• Data may be of varying density 
It is possible to have more points concentrated in areas of greater curvature or 
detail. 
• Regular and smooth net 
Resulting control point net tends to be regular and smooth with even spacing of 
rows and columns that tend to be orthogonal to one another. 
• Fair and close fit 
The resulting surface tends to be fair as well as fitting the data points closely. 

Markers 
Before executing the fitting function it is necessary to set up the markers and create an 
initial surface. Fortunately, the conditions that the set of marker points have to meet are 
much less restrictive than those required by Prefit. 
 
It is important to have a reasonable number of data points defining the edges of the 
surface. If there is a discontinuity in an edge it is better to create some extra data points 
to form a fair edge and model the discontinuity using trimmed surfaces at a later time. 
 
There is no limit to the number of data points you can use, however the more points you 
use the longer it will take to find a solution. It is unlikely that using a very large number 
of points will improve the overall quality of fit, so it may be worth pruning down the 
original table of offsets data if there is more than about 100 points. 
 
When Maxsurf first scans the data points for fitting it automatically finds the edges of the 
implied surface. If you do a brief fit, say one generation, and then exit the dialog you will 
see that the edge points are coloured red while the interior points are coloured blue. If 
you see an interior point that is coloured red it means that Maxsurf has had difficulty 
with that point probably because it is nearly a duplicate of another point. 
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Duplicate points are automatically handled by the fitting process; however points that are 
simply very close together can cause a problem. It is not so easy for Maxsurf to detect 
and ignore these. If you see an interior point coloured red, it is usually best to delete that 
point and continue. 

Initial Surface 
It is also necessary to set up an initial surface for the fitting process. This should have 
what you think will be the right number of rows and columns as well as having 
transverse and longitudinal stiffness set appropriately. The surface should have its rows 
and columns spaced evenly and the corners of the surface placed close to their final 
positions.  
 
The Genetic Algorithm will use the initial surface as a starting point, so the closer it is to 
its final configuration the better. It is not essential to get it near to the data points as long 
as the overall layout of the net is regular.  
 
If you are able to set the corner control points to exactly the right location, or if you are 
able to manually fit the edges of the surface to your satisfaction, these can be locked 
during the fitting process with a resultant speeding up of the calculations.  

Fit Surface to Markers Command 
Please note that the Markers - Fit Surface to Markers command is only available if you 
own a licensed copy of Prefit (see below). 
 
Once the markers and the initial surface have been created it is time to fit a new surface. 
Selecting the Fit Surface To Markers Command from the Markers Menu brings up the 
following dialog box. 

 

As a first step it is necessary to specify which surface you want fitted to the available 
markers. If your design only has one surface than no options will be shown in the 
Surface pull down menu, however if your design already has more than one surface you 
will be able to choose between them. 
 
If the corners of the selected surface are always assumed to be in their correct locations 
and Maxsurf will not move them during the fitting procedure. You can use the Snap 
Control Point to Marker function in the Markers menu to help you fit the corners. 
  
If you do not wish Maxsurf to attempt to fit the surface edges, select Lock Edges. You 
would do this if you were happy that the surface is already adequately fitted to the edges 
of the data points. You can use the Fit Edge to Markers function in the Markers menu to 
help you fit the edges. 
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The two remaining options constrain the surface so that bottom concave and 
tumblehome at the hull side are not permitted. If you know that your design contains 
these features then one or both of these boxes should be unchecked. 
 
Once you have specified these options it is simply necessary to click on the Fit button. 
Once Maxsurf has fitted the surface it will add values to the RMS Error Achieved and 
Generations Tested fields.  
 
The RMS error value is the Root Mean Square error. This is the square root of the sum of 
the squares of all of the errors between every data point and the fitted surface. It is a 
good measure of overall fit, but it should be regarded as an average error rather than a 
worst error value. 
 
Once you have clicked the Finish button you will be returned to the Maxsurf viewing 
windows where you will see the new fitted surface. 
 
If the fitted surface has undesirable features, or if you think it can be improved by 
changing the control point layout, it is possible to modify it and use it as the starting 
point for further fitting. 
 
Modify the fitted surface to correct any problems that you have detected, and then 
choose Fit Surface to Markers again. The modified fitted surface will be used as the 
initial surface for any further fitting, and the Genetic Algorithm will attempt to 
incorporate your changes into the design. 
 
Once the fitting process has started and the initialisation has been completed, you may 
exit the fit before the specified time has elapsed by clicking on the Cancel button or 
hitting the Escape key. Note that the response to this may be a little slow. This is because 
Maxsurf must finish the current optimisation cycle before exiting. After exiting, you will 
have the current best-fit surface. If required you can re-start the fitting progress, or close 
the fitting dialog. 

Licensing of Fit Surface to Markers command 
Please note that the Markers - Fit Surface to Markers command is only available if you 
own a licensed copy of Prefit. 
 
If you own Prefit, you will probably want to enable the Fit Surface to Markers command 
in Maxsurf. Do this by starting Maxsurf and selecting Activate Prefit from the Edit 
menu. 
 
Now exit and restart Maxsurf. If you have a valid access code for Prefit, Maxsurf will 
start automatically and the Fit Surface to Markers command will be available in the 
Markers menu. If the current access code is not valid, you will be prompted for a new 
one. 
 
Type in your access code, and click OK. If the correct access code was entered, the Fit 
Surface to Markers command will be available in the Markers menu. 
 
If for any reason you wish to turn off the Fit Surface to Markers command, select 
Deactivate Prefit from the Edit menu. Note that you will have to exit and restart Maxsurf 
for this to take effect. The most likely time you might want to do this is if you are on a 
network, using a network copy protection device, and need to release a Prefit licence so 
that another person may use it. 
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Generating a Grid from Markers 
It is also useful to use the Generate Grid from Markers command to set up the grid 
(stations, buttocks and waterlines) for the surface you have just created from the marker 
point data. Stations are generated at the markers’ longitudinal position; buttocks at their 
transverse offset; and waterlines at their vertical location: 

 

You have the option of selecting which items of the grid to generate (stations, buttocks 
and waterlines). For each of these you have the option of deleting and replacing the 
existing grid data or adding to the existing grid data. You can also specify how many 
markers must be at the same longitudinal position, transverse offset or vertical location 
for a station, buttock or waterline (respectively) to be added. Finally, you can specify a 
tolerance for markers to be considered at the same plane: for example if the Marker plane 
separation tolerance were set to 0.001mm then markers up to 1mm apart (in longitudinal 
position, transverse offset or vertical location) would be considered to be in the same 
plane and the station, buttock or waterline location would be averaged. 
 
When Importing DXF Markers or GHS markers, Maxsurf can automatically generate the 
grid. The section grid is generated automatically only if no existing sections are defined. 
If sections are already defined then imported markers that lie within 1cm of a section will 
be allocated to that section, otherwise they will be left unallocated. 

Assisted Manual Fit to Markers 
The additional features which assist with manual fitting are described below: 

Snap Control Point to Marker 
This command may be used to snap a single control point to a marker. In any of the 
design views, select the marker, then select the control point (whilst holding down the 
Shift key). When you select Markers - Snap Control Point to Marker, the control point 
will be made coincident with the marker, in addition the marker's properties will be 
updated so that it is now linked to the surface to which the control point belongs; if the 
control point lies on a corner or edge, the marker will be linked to the corresponding 
corner or edge, otherwise the control point will be linked to the surface's interior. 
 
You may only snap one control point to one marker. 
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Fit Edge to Markers 
In a similar way that the Snap Control Point to Marker moved a single control point onto 
the marker, the Fit Edge to Markers will fit the selected edge to the selected markers. 
 
Select the markers that lie on the surface's edge. Note that the order in which you select 
the markers is important, as this will be the order in which the edge is fitted through the 
markers. However, you can override this ordering once you select the Fit Edge to 
Markers command: 
 

 

 
If you are fitting a longitudinal edge (control point row), then you must select the 
markers from left to right. If you are fitting a transverse edge (control point column) then 
you must select the markers from bottom to top. In the fitting process the control point in 
the first row or column of the edge will go to the first selected marker and the control 
point in the last row or column of the edge will go to the last selected marker. 
 
You may select any number of markers to define the edge, but you must select either 
only one edge or only one control point to define the edge (this cannot be a corner 
control point). 
 
When fitting the edge you can select whether you wish the corner points to remain where 
they are or to be included in the fit. 

 

You should add the required number of control points to the surface and select the 
required surface stiffness prior to fitting the surface edge to the markers. 
 
When a surface edge has been fitted to markers, the markers are associated with that 
particular surface edge. (You can also directly associate markers with a particular surface 
edge by editing the marker properties in the Markers table or Markers properties dialog.) 
Once markers have been associated with a particular surface edge, you can fit the surface 
edge to its markers by simply selecting a control point in the edge (other than a corner 
control point) and selecting Markers | Fit edge to markers. This is very useful as it allows 
you to easily change an edge’s properties (number of control points and stiffness) and 
refit the edge to obtain the best possible fit to the markers without having to always 
reselect the markers. It also makes it very easy to add or remove markers to those used 
for the edge fitting. 
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Again, the markers' properties are updated to reflect the surface and edge that have been 
fitted. 

Smooth Surface Interior 
Once you have fitted the surface's edges, the interior control points, displayed by turning 
on the surface net, may be very irregular. This command uses a three dimensional 
smoothing procedure to smooth the surface's interior control points to follow the shape 
defined by the surface's edges. This will give you a much better starting point for faring. 
 
Smoothing is done on the current surface; select a control point in the surface to make it 
the current surface. The net must be turned on for this command to become active. 

 

Before smoothing, having fitted the edges 

 

After smoothing the interior 
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Measure Surface Errors 
This function may be used to determine the quality of the fit of the surfaces to the 
markers. The marker's error is the distance between the marker and the closest point on 
the surface. A dialog with a summary of the RMS error (average error for all the markers 
linked to that surface), the maximum error and the marker where that occurs for each 
surface will be displayed. 

 

Also the error of each marker associated with a surface will be calculated and displayed 
in the Error column of the Markers Table. 

 

Measure Error can be called up with any of the drawing windows or the markers window 
topmost. Note that the error is calculated using the current surface precision setting. 

Procedure for Assisted Manual Fitting to Markers 
The steps for manually fitting to a set of markers is outlined below: 
 

• Create a new design and add a surface 

• Insert an appropriate number of control point columns and rows 

• Specify suitable longitudinal and transverse stiffness’s 

• Load the markers file 
 
This file can be either a DXF file (File - Import - DXF markers) or a table of offsets as a 
tab delimited text file. Remember that once you have specified how many markers you 
have, you can copy and paste from the Markers Table to other applications, such as 
spreadsheets. 
Alternatively, you can digitise your design, by loading a scanned image (File - Import - 
Background Image) and then manually adding markers using the scanned images as a 
guide. 

• Fit the corner points of the surface 
 
The corner points of your surface should be fitted to the markers chosen to be the corners 
of the set of markers. This can be done manually by dragging control points into 
position, but is most easily achieved using the “Snap Control Point to Marker” 
command. 
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At this point it is possible to go straight to the surface fitting procedure, however there 
are several steps that can be taken to improve the initial quality of the surface. These 
steps are not essential, but can dramatically speed up the surface fitting process. The 
steps include: 

• Fit surface edges to the markers at the edges of the set of markers. 
 
This may be done to any or all of the four surface edges. If necessary, compact the 
required number of control points at the location of knuckles and hard points in the 
surface. 

• Smooth the surface's interior using the Surfaces - Smooth Surface Interior 
command. 

 
The Smooth Surface Interior command uses the shape of the surface edges as a guide for 
smoothing the surface interior, so the surface edges should be a reasonable fit to the edge 
points before this command is used. 
 
You should also do the following to assist is viewing the output from the fitting process. 

• Define the station grid spacing to match that of the markers. 

• Link the markers to the correct stations 
 
It may help to do this in the plan or profile views with the grid and grid labels turned on. 
Turn on the Display - Markers - Markers for Current Station option. 

Background Images 
Maxsurf has the ability to display background images in each of the design views. Those 
in the Plan, Profile and Body Plan views may be re-positioned and resized to match the 
design and can then be used to assist in fairing to an existing design. The image in the 
perspective view is always displayed at full image size and from the top left corner; by 
using the zoom and pan control you can re-position your vessel in the scene.  
 
Maxsurf has no built-in image manipulating commands, other than to control the position 
and scale of the image. Hence you must ensure that the image is in the correct orientation 
prior to loading into Maxsurf. It is also helpful if you make the background colour of 
your image similar to that of the Maxsurf background colour, since it will be easier to see 
the control points and other lines which are drawn over the top of the image by Maxsurf. 
Some useful programs for image manipulation are listed below: 
 

L View Pro www.lview.com US$50 approx. 
Paint Shop Pro www.jasc.com US$99 approx. 
Photo Shop www.adobe.com US$609 approx. 

Importing an Image 
Maxsurf can load image files of the type jpg, gif, bmp and png. To open an image file, 
choose File - Import - Import Image Background (note you must have a design already 
open). If the image is not visible, check that the display option is turned on: Display - 
Background - Show Image. 



Chapter 5 Using Maxsurf 

Page  143  

 

When first opened, the image will be scaled so that it is displayed at full size at the 
current window zoom level. Once you have loaded the image, you can re-position it by 
locating the zero point in the image. The image will then be moved so that the image 
zero point is in the same position as the design zero point. 

Setting the Zero Point 
To set the image zero point, select Display - Background - Set Image Zero Point. Then 
click the mouse at the position in the image that is the design zero point: 

 

When you click the mouse, the background image will move so that the point you just 
clicked lines up with the design's zero point: 
 

 

Setting the Scale 
You can specify a known position on the image to scale the image. For instance, with the 
example shown, we know that the transom is 8.6m aft of the zero point. So to set the 
scale of the background image, select Display - Background - Set Image Reference Point 
and click on the transom in the image: 



Chapter 5 Using Maxsurf 

Page  144  

 

A dialog will now pop up and you can specify the known distance and also whether it is 
a transverse or vertical distance: 

 

Remember that in the Profile view, distances to the left of the zero point are negative, as 
are distances below the zero point; Maxsurf's positive directions are forward, starboard 
and up. Hence, in this case, we have specified that the distance to the transom is -8.6m 
from the zero point. The image is now re-scaled accordingly and the transom of the 
design matches that of the image: 

 

Note that the aspect ratio of the image is always maintained. In this case, the design 
would have to be stretched vertically to match the image. 
 
Remember that the images in all the views are independent so you can load a profile and 
buttock lines sketch into the Profile view, a sketch of the sections into the Body Plan 
view and a sketch of the waterlines into the Plan view. 

Images in the Perspective View 
The background image in the Perspective view can be used for generating presentation 
pictures. The background image remains in the centre of the screen, use the zoom and 
pan controls to place the Maxsurf design in the desired position over the background: 
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Note that the images are not saved with the design file, only the path name to the 
image file. If you change the directory of your images or their file names, Maxsurf 
will no longer be able to find them and the images will not be automatically loaded 
when the design is re-opened. 
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Modelling Developable Surfaces 
Developing surfaces in Maxsurf can be done using semi-automated procedure that is 
basically a combination of the following tools:  

• Generating Markers for Developable Surfaces on page 74, and 

• Surface Fitting with Genetic Algorithms on page 134. 
 
The following Developable Surfaces Example will show you how to develop a surface in 
Maxsurf. 

Developable Surfaces Example 
The example described below uses the chine hull design, 
WorkBoat_4Surface_BowCone.msd, which may be found in the Maxsurf\Sample 
Designs\Workboats\ directory. However, it is necessary to delete the middle row of 
control points in the TOPSIDES surface so that it only has control point rows along its 
longitudinal edges. 

Step 1: Creating Rulings 
The first step is to design a hull using normal B-spline surfaces that have no intermediate 
rows - in other words having control points only along the longitudinal edges. These 
edges should be made as fair as possible and should have the minimum of inflections. 
You should also set up a set of stations in the Grid dialog. Once you are generally happy 
with the hull form 

• Select the Surfaces | Surface Properties for the surface you wish to be 
developable. 

• Select Developable under Surface Type. 
 
This will display rulings on the hull shape and the aim should be to get these rulings as 
regular as possible. 

 

Maxsurf does not automatically create a developable B-spline surface - it generates 
ruling lines, which are used as guides to allow you to see where the developable surface 
will lie.  
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When the rulings are viewed in the Body Plan window, small indicator points are 
displayed where each ruling intersects a section. You will see a discrepancy between the 
solid section line from the existing B-spline surface and the indicator points from the 
developable surface - this shows you how much the B-spline surface will need to be 
distorted to make it developable. 
 
In other words, the indicator points are where the developable surface (between the two 
longitudinal edges) lies. The solid lines are where the B-spline surface actually lies. Your 
task, as the designer, is to add intermediate rows of control points to the B-spline surface 
so that you can make the B-spline surface match the developable surface to within 
acceptable tolerances. 
 
These points allow you to see what shape the sections of your hull will have. The higher 
the precision you are using, the more rulings there will be, and the more points will be 
shown at each station. If a station has very few or no points displayed, it is usually 
because the section at that point is nearly straight and few rulings intersect the station. 
You can increase the number of rulings by increasing the surface precision. 
 
If all sections are displayed using the contours dialog, all sections will be marked on the 
rulings. If only one section is displayed, only the corresponding intersections of that 
section with the rulings will be visible. Remember that the current section is selected 
using the station indicators in the Control Box in the Body Plan window. 

Step 2: End Ruling Line 
When Maxsurf displays the rulings on a hull surface, it displays the final valid ruling, or 
end ruling, at each end of the surface in blue (markers colour), while normal rulings are 
in yellow (datum waterline colour). If you wish to get the ends of the surface straight (for 
example you may wish the surface to bond to a straight edged bow cone), you should 
move the control points on the edges to get the end ruling as parallel to the end of the 
surface as possible. This will occur when the tangents to the ends of the two edge curves 
lie in the same plane. 
 
If the rulings cross through the end of the surface, then the end of the developable 
surface will not be straight (Remember that the rulings are straight lines in the 
developable surface.) 
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For example, if point C in the above diagram is moved away from the centreline of the 
vessel, the rulings will change so that they line up with the edge of the bow cone (AB). If 
point D was moved towards the centreline by a small distance the rulings would change 
in a similar way. This is because lines AD and lines BC are approaching co-planarity. If 
the points are moved too far the rulings will once again run off the end of the surface, but 
from the opposite edge, as the tangents will be out of plane once again. 

 

One simple way of getting rulings parallel to the end of a surface is to use the Align to 
Plane command. By selecting points A, B and D to define a plane and then selecting 
point C and choosing the Align to Plane command, point C will be moved into the plane 
defined by the first three points. 

Note 
We will now proceed to use the ruling lines to shape the internal surface 
into a developable shape. Because the ruling lines are created from the 
surface edges, it is important that you do not make any further changes to 
the surface edges since from this point onwards. 

Step 3: Fit Surface to Rulings 
Once an acceptable set of rulings has been created, the next step is to modify the B-
Spline surface to fit the rulings. To do this, we first need to generate marker points at the 
intersection of the ruling line and the transverse sections. 

• Select Generating Markers for Developable Surfaces from the Markers menu.  
 
Once the markers have been generated, change the surface from Developable to B-spline 
so that rulings are no longer visible. At this time it is necessary to insert between one and 
three rows to model the inside of the B-Spline surface. In many cases, only one row is 
needed, but if some sections have a lot of curvature, two or three rows may be needed. 
When the extra row of control points has been added, you should change the transverse 
stiffness from 2 (linear) to 3 (flexible). 
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Manual Fitting 
The markers can be used as guides for manipulating the surface to make it as 
developable as possible. Your aim should be to adjust the internal control points so 
that the sections of the B-spline surface match the markers you have created. (The 
markers indicate where the developable surface intersects the sections.) 

 
If the edges of the surface are changed, causing the rulings to be updated, a new 
set of markers should be created. Remember to delete any existing markers by 
selecting the Markers window and selecting Delete Markers from the Edit menu. 
Then, recreate the markers using the Generate Markers for Developable Surfaces 
command from the Markers menu. 

Automatic Fitting 
Since the markers have been generated using the Generate Markers for 
Developable Surfaces command, they have automatically been assigned to the 
correct surface and station. 

 

This means that we can now use the Fit Surface to Markers Command from the 
Markers menu (see page 136) to automatically fit the internal surface to the marker 
points. This command is only available when Prefit is activated. 



Chapter 5 Using Maxsurf 

Page  150  

 
Remember to lock the edges when you run this command. 

See:  
• Activate/Deactivate Prefit on page 201 for information on how to activate Prefit 

• Surface Fitting with Genetic Algorithms on page 134 for more information on how 
to use the Surface Fitting tools. 

Step 4: Checking the developability of the surface 
The level of developability of the surface can be checked in Maxsurf by rendering the 
surface and use the Gaussian curvature rendering mode.  
 
See:  

Surface Curvature on page 105 for information on the use of Gaussian curvature to 
isolate areas where the plate will be less developable. 
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Control Points 
Within Maxsurf, a design is defined purely by the movement and positioning of a 
number of control points in space. The facilities for the display and manipulation of these 
points are therefore the most important part of the program, and should be studied 
carefully. 
 
In the previous section we have seen how surfaces may be manipulated as whole objects. 
Here we will look at the tools available for manipulating a control point or group of 
control points to achieve the desired surface shapes. 

Adding Control Points 
To increase the density of a control point net, columns of control points may be added in 
the Plan and Profile windows, and rows may be added in the Body Plan window.  
 
To add a control point row or column 

• Select the Plan, Profile or Body Plan window, as appropriate. 
 
In the Body Plan window you will also need to select a current column in which to 
perform the insertion. The current surface’s current column is indicated by a highlighted 
column marker in the Control Box. You can select a different column by clicking on a 
different column marker, or by selecting a control point in the desired column. 

Note: 
In cases where there is ambiguity as to which surface is being added to, you 
can give Maxsurf a hint by first clicking on an existing point in the required 
surface. Selecting a point in this way tells Maxsurf to begin its search for the 
correct insertion point in this surface. 

• If necessary, select the surface and column into which you want to insert the new 
control point. 

• Select Add from the Controls menu. 
 
Position the Add cursor at the point where you wish to insert the new row or column. 

• Click the mouse button. 
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Maxsurf will insert the new control point and also insert all other points in the column or 
row based on an average of the positions of existing points in the net. The new shape of 
the current surface will then be calculated. 
 
If Maxsurf is unable to determine into which surface you wish to add the points, it is a 
good idea make all other surfaces invisible or to lock them to remove the source of 
ambiguity. 

Deleting Control Points 
The Delete command allows you delete a control point row or column to decrease the 
density of a control point net. Columns of points may be deleted from the Plan and 
Profile windows, while rows of points may be deleted from the Body Plan window.  
 
To delete a control point row or column 

• Select the Plan, Profile or Body Plan window as appropriate. 
 
Control point rows may be deleted in the Body Plan; control point columns may be 
deleted in the Plan or Profile windows. 

• Select Delete from the Controls menu. 
 
Position the jaws of the Delete cursor around the control point. 

  

• Click the mouse button. 
 
Maxsurf will delete the control point row or column and calculate the new shape of the 
current surface. 
 
Deleting a row or column that contains one or more control points in a bonded edge will 
impact the bonded surface. If a row or column, which is part of a bonded edge, is chosen 
for deletion, you will be alerted to this fact by a dialog, through which you may then 
choose between cancelling, and deleting the row or column from both surfaces. 

Moving Control Points 
Control points may be moved, either individually, or as a group. 
 
To move an individual control point: 

• Click and drag the control point to a new location. 
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To move multiple control points: 
• Select multiple control points using the selection box or the mouse and Shift key 

 

• Click on any control point from the selection and drag the selection to a new 
location. 

 

Constraining Movement  
Any group or individual control point may be constrained in its movement by holding 
down the Shift key while dragging the control points. The constraint restricts movement 
to the vertical or horizontal directions. If you release the shift key, you are returned to 
unconstrained movement. 
If a surface is symmetrical, its control points are constrained to lie all on one side of the 
centreline. You can override this constraint by holding down the Ctrl key while dragging 
the point. 

Control Point Properties 
It is possible to change values for control points numerically by double clicking on the 
control point. 

 

A small dialog box appears containing data about the control point. You may select and 
edit any of the control point's coordinates, or its weighting value. You can also change 
these values in the table in the Control Points window. 
 
It is also possible to change the properties of a selection of control points. To do this: 

• Select the control points, by either using the dragged selection box, or holding 
down the shift or control keys and selecting the individual points. 

• Select Control Properties from the Controls menu. 
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The same dialog will appear, but only those values that are common between all the 
selected control points will be filled in. You can change any of the values and all the 
selected control points will have their respective values updated. 
 
This function is useful for aligning columns of control points; see below: 

 

• Select the control points you wish to align: 

 

• Select Control Properties from the Controls menu: 

 

Any data fields, which are common for all the selected control points will be filled in; 
any data fields which differ for the selected control points will be left blank. In this case 
the surface name and column number are the same for all the selected control points. 

 

• Type in the longitudinal position you wish to set for all the control points and click 
OK. 

 

The selected control points are now all set to the same longitudinal position of –5.26m. 
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Snap to Grid 
Maxsurf has a built-in facility to allow you to have your control points automatically 
snap to an evenly spaced alignment grid while they are being moved. You can control the 
spacing and use of this alignment grid with the Snap To Grid command from the 
Controls menu. To specify an alignment grid: 

• Choose Snap To Grid from the Controls menu 

 

• Click the On button and enter a value for the spacing of the alignment grid 

• Click the OK button 
 
The alignment grid is based around the current Zero Point and will change as the Zero 
Point changes. For this reason it is advisable to lock the Zero Point when using the Snap 
to Grid option.  
 
Snap to Grid only affects control point movements made with the mouse or arrow keys. 
Fairing commands are not affected. 

Display of Control Points 
It is possible to display the Surface being designed together with a limited number of 
control points (the 'Shape' display), display the net of control points ('Net' display), or 
show both the shape and the net simultaneously. 

Shape Display 
When displaying the shape, the surfaces being modelled are shown with a limited 
number of control points. Surface contours may also be shown as required e.g. Sections, 
Waterlines, Buttocks, Diagonals, Intersections, Bonded Edges or Parametrics.  
 
In the Plan and Profile windows, the control points shown are the edges of each net, 
while in the Body Plan window the current column of each individual surface is shown. 
Control points may be moved, and the change in shape viewed, at the same time. Each 
time the movement pauses for more than about half a second, the new shape will be 
recalculated and drawn. The ideal technique is to keep the mouse in motion until you 
wish to see the shape of the design for that control point position.  
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Net display 
When displaying the Net the entire network of control points is shown by itself. Any 
control point or group of control points may be selected and moved. The resulting shape 
is not shown until the Shape display is chosen again. 
 
The Net display allows you to make rapid changes without reference to the hull shape, or 
to perform functions, such as aligning and smoothing, where a view of the net as a whole 
may be important. 
 
It is also possible to display only the net rows or only the net columns. To control the net 
display, select the items under the Net sub-menu in the Display menu. 

Masking the Net 
In cases where you are dealing with a complex net of control points, it is sometimes very 
helpful to be able to select a particular group of control points to remain visible while the 
remainder of the net is hidden. This is the function of the Mask command. 
 
It can be particularly useful to select the control points you wish to mask in one view and 
then to manipulate them in another view. For example, when fairing a bulbous bow, it 
can be helpful to mask the control points in the Perspective or Profile views and then 
manipulate the surface shape in the Plan view. 
 
When working with a control point net with a large number of columns, it may be very 
confusing to try to work on particular points in the Body Plan window. 
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By selecting all the points on one or two columns and then selecting Mask, only the 
portion of the net selected, and the area of the surface that it exerts an influence on, will 
be displayed. It will then be much easier to view and modify in the Body Plan or any 
other window. 

 

When the Unmask command is selected, the entire net will be made visible again. 

Manipulating Groups of Control Points 
There are several commands that are useful for fairing a design. These operate on groups 
of control points: either controls within a particular row or column; a patch of control 
points in a surface or across bonded surfaces, or arbitrary control points. 
 
The smoothing and straightening commands are particularly useful for manipulating the 
edges or features of a surface, e.g. creating a straight bow profile, producing a smooth, 
fair chine line, etc. 
 
Smoothing may also be useful when applied to a patch of control points for maintaining 
a fair net and hence a fair design. 
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The align functions are useful when you wish to place control points in the same vector 
or plane. The control points may be from the same or different surfaces. These functions 
are also useful for fairing across the edges of bonded surfaces.  If the Align to Plane or 
Align to Vector functions are called while holding the shift key down a constraints dialog 
box will appear.  In this dialog you may specify movement constraints in certain planes. 
 
The size function may be used to enlarge or reduce a portion of a design, by re-scaling a 
group of control points. In a similar way, certain areas of a design can be rotated by 
rotating the control points in that area. To re-size or rotate complete surfaces, please refer 
to the Size and Rotate commands in the Surfaces menu, these are described in the 
Surfaces section. 

Smoothing and Straightening - Rows or Columns 
Any complete or partial row or column of control points can be straightened into a 
straight line, or faired into a smooth curve.  

 

To smooth or straighten three or more control points 
• Click on the control point at one end of the group to be straightened. 

 
This control point will be the control point at one end of the selection to be smoothed or 
straightened. If after selecting one point you wish to change your selection, simply click 
anywhere in the background of the window.  

• Hold down the shift key. 

• Click on the control point at the other end of the group. 
 
This control point will be the control point at the other end of the selection to be 
smoothed or straightened. It should lie in the same row or column as the first selected 
control point. If you wish to change your selection after selecting a second point, release 
the shift button and start again with the first point. 

• To fair the control points, select Smooth Controls from the Controls menu and 
select the desired stiffness.  

 
The stiffer the smoothing, the straighter the line will become. Smoothing is done in three 
dimensions. 

• or to straighten the control points, select Straighten Controls from the Controls 
menu and select whether you wish to straighten in 2D or 3D. 

 
If you straighten in 2D, the control points will be forced to a straight line in the current 
view direction, leaving the third direction unchanged. This can be particularly useful for 
producing straight bow profiles or transoms; this is done by using the Straighten in 2D 
command in the profile view. Straighten in 3D will produce a straight line in all three 
dimensions. 
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You can choose to undo a smooth or align operation by selecting Undo from the Edit 
menu. 
 
Smoothing and Straightening may only be performed in a single surface; it may not be 
performed over two or more surfaces. 

Note 
The Straighten Controls and Smooth Controls commands only work for 
control points that belong to the same surface. 

Smoothing or Straightening a Patch 
The Smooth and Straighten commands in Maxsurf can also be applied to a patch of 
control points that spans more than a single row or column.  
 
A patch is a rectangular grid of control points that can be as small as one row or column, 
or as large as the entire surface. Not all the points to be smoothed need to be selected as 
Maxsurf will determine the size of the patch from the points that are selected. 

 

For example, in the diagram above, if only points A and B had been selected (instead of 
using the selection box) Maxsurf would have smoothed exactly the same group of 
control points, since points A and B define the limits of the patch. 
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To smooth or straighten a patch of control points, select them and choose Smooth 
Controls or Straighten Controls from the Controls Menu. An example of a smoothed 
patch is shown above. If straighten had been applied in the previous example, the control 
point rows and columns in the selected patch would lie on straight lines. 

Moving Control Points 
This command may be used to move an area of a surface. 

• Select the control points you wish to move. 

• Choose Move Controls from the Controls menu. 

• In the dialog type in the desired movements. 

• Click OK. 

 

Resizing Control Points 
The Size Controls command may be used to enlarge or reduce an area of a surface. 

• Select the control points you wish to resize. 

• Choose Size Controls from the Controls menu. 

• In the dialog type in the desired length, width and depth dimensions; proportional 
scaling may be achieved by ticking the Proportional Scaling boxes next to the 
dimensions. 

 
Note that the values that appear when the dialog is first displayed are the dimensions of 
the bounding box containing the desired control points. To scale the control points, type 
in the dimensions of the new bounding box you wish the control points to occupy. 

• Choose the origin for the re-scaling in the Size About fields. 
 
This will control the direction in which the control points are moved. The Size About 
point will remain unchanged when the control points are resized. 
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• Click OK. 

 

Rotating Control Points 
To rotate a group of control points: 

• Select the control points you wish to rotate. 

• Choose Rotate Controls from the Controls menu. 

• Type in the rotations about each of the axes. 

• Type in the rotation centre. 

• Click OK. 

 

 

Aligning Control Points 
The align commands are for making groups of control points co-linear or co-planar. The 
Align to Vector command aligns points along a 3D line in space, while the Align to 
Plane command aligns points to a specified plane.  
 
Align to Vector differs from Smooth and Straighten in that the points selected do not 
have to be in the same row or column, or even in the same surface. You may select any 
control points to define the vector or plane, and then align any control points with that 
vector or plane; the control points need not lie in the same surface. You must also select 
all the control points to be aligned, patches may not be selected as they are in the Smooth 
and Straighten commands. 
 
To use Align to Vector: 
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• Select two control points with the shift key held down. 

• While still holding down the shift key, select one or more additional points. 

• Select the Align to Vector command. 
 
The first two selected control points define the vector; all subsequently selected points 
are moved to the point on that vector closest to their original position: 

• Before aligning, endpoints with vector defined by two middle points 

 

• With shift key held down, select two middle points to define vector 

 

• With shift key held down, select two end points to be aligned 

 

• Select Align to Vector; end points are moved to closest corresponding points on 
the vector 
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This feature is very useful for ensuring co-linearity of control points either side of a 
bonded edge to ensure that the surface is slope continuous across that edge, or for 
creating a straight bow. Align to vector can also be used to ensure a smooth forefoot, 
going from the surface’s bottom edge to the bow; ensure that the corner control point and 
the two control points on each side, immediately adjacent to it, are co-linear: 

• Before alignment, discontinuity at forefoot 

 

• After alignment, smooth transition at forefoot 

 

 
Align to Plane works in a similar fashion to the Align to Vector command, except that 
the first three points selected define a plane in space that all subsequently selected points 
are moved on to.  
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Control points, other than those defining the plane, are moved to the closest position in 
the plane.  

 

This means that a line between the new and old positions of the point would form a line 
that was normal to the plane. 
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Compacting Control Points 
The Compact function is used when you wish to position one or more control points 
precisely over an existing control point. This can be used to create a knuckle or 
discontinuity in the surface or to collapse a side to a point e.g. at the bottom of a bow 
cone (see Discontinuities and Feature Lines on page 166). 
 
To compact two or more control points 

• Select one control point, 

 

This control point is the one that you wish all other control points to compact onto. It will 
remain stationary when you select the Compact function. 

• Hold down the Shift key and select one or more other control points. 

 

These are the control points that you wish to compact to the first selected control point.  
• Select Compact from the Controls menu or type Ctrl+K. 

 

This will compact all selected control points to the first selected point. 

Note:  
The Compact command does not hold the compacted points together 
permanently, i.e. if you select one with the mouse and move it, the other 
points in the same position will not move with it. If you wish all the points 
to move as one, select all the compacted points (with a selection box) and 
then select the Group command.  

Also see:  
Discontinuities and Feature Lines on page 166 



Chapter 5 Using Maxsurf 

Page  166  

Grouping Control Points 
Control point grouping is provided to help with the movement of multiple control points. 
Grouping allows the movement of a number of control points that move as a whole 
whenever a single control point from the group is moved. To group several control points 
simply select the points that you wish to be in the group and choose Group from the 
Controls menu or type Ctrl + G.  
 
Note: It is possible for you to group together several groups that have been previously 
created, to create a single group of control points. 
 
The Ungroup function performs the reverse of the Group function. Choose the group that 
you wish to ungroup by selecting a control point from within the group. Choose Ungroup 
from the Controls menu. 
 
Single control points cannot be marked as grouped – you must select at least two control 
points to group them. If a control point is grouped to another which is subsequently 
deleted (by, for example, deleting the surface, row or column in which the control point 
lies) the remaining control point will become ungrouped unless there are other, 
undeleted, control points in the same group. 

Group Versus Compact 
It is important not to confuse the functions of the Group command and the Compact 
command. Group allows you to move control points simultaneously, even if they occupy 
different positions in space. Compact forces several control points to the same position in 
space, but does not force them to move simultaneously. If you wish to have several 
control points occupy one position and move together, you will need to select the 
Compact command followed by the Group command. 

Discontinuities and Feature Lines 
It is possible to use compacted grouped control points as a means of introducing a 
discontinuity into a surface.  
 
Consider a surface whose stiffness is set to flexible (order 3) in the transverse (column) 
direction. The following example shows how the use of two rows of control points can 
form a discontinuity in the surface.  
 
Illustrated below is a Perspective view of the net and shape of a simple surface.  

 

If an additional control point row is added, and its points compacted directly on top of 
the existing intermediate control point row, a hard corner is created running along the 
surface, as shown in the following illustration. 
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The scope of the discontinuity may be changed by splitting the superimposed row in 
some of the columns.  
 
By splitting the row at the right hand edge of the surface as shown it is possible to fade 
the hard edge out. The surface shows a smoothly curved section at its right hand edge 
and a section with a hard corner at its left hand edge. 

 

To achieve a discontinuity of this type you need to compact several control points 
together. The number of points required to achieve a hard corner is always one less than 
the order of the surface in that direction. For example, if you have a surface that is 
flexible in the transverse direction (Order 3), you will only need to superimpose two 
control points to achieve a hard corner in the section. If, on the other hand, the transverse 
stiffness is set to stiff (Order 6), five control points will need to be compacted together to 
form the corner. 
 
If you wish to display the line along the corner you have created, select Feature Lines 
from the Contours menu item. The effect will be similar to the following: 

 

Note:  
Do not compact more control points than necessary to create a knuckle. The 
required number of control points is the surface stiffness minus 1. For 
example: a stiffness 4 surface requires 3 compacted control points to create 
a knuckle.  
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Advanced - Transpose 
The transpose function may be used to flip the column or row ordering and also swap the 
rows and columns of a surface. This operation will not affect the actual shape of the 
surface, merely the ordering of the control points. This can be particularly useful if you 
have imported a NURB surface which uses a different control point orientation from 
Maxsurf, or if you have rotated a surface and the column selection in the Body Plan view 
selects columns which are now closer to being longitudinal than transverse. 
 
The Reverse Row Ordering and Reverse Column Ordering functions change the order in 
which the control points in a row or column are indexed. 
 
The Swap Row and Column Axes function will make rows columns and columns rows. 
This can be useful if the columns have become longitudinal rather than transverse 
through surface rotations. 
 

 

 



Chapter 5 Using Maxsurf 

Page  169  

Calculations 
Maxsurf is able to calculate a variety of data from your design. Before making 
calculations with your Maxsurf design, it is essential that sections can be properly 
formed. This means that sections must be closed, or have only one opening which is then 
closed with a straight line. If you are using intersecting surfaces and trimming, ensure 
that all unwanted portions of all the surfaces are removed. 
This section explains how to calculate: 

• Hydrostatics 

• Calculate Girth 

• Calculate Areas 
 
For information on how to calculate offsets see:  

Offsets Window section on page 76.  
 

Also see:  
Calculations Window on page 82.  

Hydrostatics 
The hydrostatics dialog, in the Data menu, will compute the upright hydrostatics at the 
design waterline. More sections are used for the computations as the precision is 
increased. As well as the normal hydrostatics, the righting moment at one degree is also 
given. This is computed as: GMt Δ sin(1°). The precision at which the calculations were 
done and the number of sections used are given in the last row. 
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To change the density or VCG, type in the new value and press tab or the recalculate 
button to refresh the data. 

Note:  
The wetted surface area displayed in this dialog is calculated using the same 
method as that used in the Calculate Areas dialog in the Data menu. This 
method is more accurate than that used in Hydromax; Maxsurf divides the 
surfaces into triangular elements to calculate the surface area, whereas 
Hydromax does a lengthwise integration of section girth. 

When using the Calculate Hydrostatics dialog from the Data menu, Maxsurf displays the 
sections used to calculate the hydrostatic properties in the window in the background. 
You can move the hydrostatics dialog around on screen to view the sections to ensure 
that they are correct. Note that this dialog calculates based on your current settings of 
trimming, surface visibility and precision. 

Note: Skin thickness and hydrostatic calculations 
In Maxsurf skin thickness is used for creating the table of offsets. For 
hydrostatic calculation purposes, skin thickness is ignored. Hydromax can 
be used to calculate the effect of skin thickness on the vessel’s hydrostatics 
by selecting “include skin thickness” in the opening dialog. 

Hydrostatic Coefficient Calculation Parameters 
This dialog is available in Maxsurf in the Data menu. 

 

Default settings for coefficient length and LCB/LCF measurements 

The first part of the dialog is used to define the length to be used for calculating Block, 
Prismatic and Waterplane Area coefficients; the same length may also be used to non-
dimensionalise the LCB and LCF measurements. (In previous versions of Hydromax, the 
length had to be set before an analysis was carried out. In this version, the changes may 
be made at any time and the relevant results will update automatically without the need 
for redoing the analysis – this is the same behaviour as the Units options). 
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The second part of the dialog is used to define how LCB and LCF (but not LCG) 
measurements are presented. The range of origins for the measurements has been 
extended to include forward and aft perpendiculars. Also you may define whether 
positive values should be in the forward or aft direction (relative to the chosen origin); 
finally you may choose to non-dimensionalise the value by dividing by the coefficient 
length (chosen in the first part of the dialog) and displaying as a percentage. 
 
These options are used in all Hydromax results and in the Maxsurf Hydrostatics dialog. 
The LCB options are not used in the Maxsurf Parametric Transformation dialog (though 
the coefficient length is used for the coefficients in this dialog). 

Calculate Girth 
Girths may be found for all visible surfaces by using the Girth function from the Data 
Menu. 

 

To locate the longitudinal position where a given half girth occurs: 
• Enter the half girth length. 

• Click the Calculate Position button. 
 
To find a half girth length at a given longitudinal position: 

• Enter a position where the half girth is required. 

• Click the Calculate Half girth button. 
 
You may search from the bow or stern. When you have finished, click Finished. 

Calculate Areas 
The Calculate Areas function in the Data menu allows the area of surfaces to be 
accurately calculated, together with their longitudinal, transverse and vertical centre of 
gravity. The dialog also includes the surfaces' second moments of area about their centres 
of area. This can be useful when estimating gyradii of the designs. 
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It is possible to compute the total, above water or below water area and inertias. The 
values account for trimming and surface symmetry. The DWL, as defined by the Frame 
of Reference, is used. 
 
A fine mesh triangulation of the surface is used, so errors inherent in the use of 
Simpson's rule are avoided. The higher the precision selected, the denser the 
triangulation, and the more accurate the answer will be. The CG positions are given 
relative to the current zero point. 
 
The projected transverse areas and centroids may also be computed, and this is useful for 
estimating centres of pressures. Note that the total projected area is computed, so if you 
have a propeller tunnel for example, both sides of the tunnel will be included. 
 
It is important to distinguish between the CG of the surface area and the centre of lateral 
area provided by the Calculations window. In the first case the centre is of the entire 3D 
area, whereas in the second case the centre is of the 2D projection of the area. 
 
It is possible to copy the columns of data from the dialog by clicking and dragging over 
the cells you require and then using the Ctrl C Copy command to copy the data to the 
clipboard. 
 
Click the Finish button when you wish to close the dialog. 



Chapter 5 Using Maxsurf 

Page  173  

Using Parametric Transformation 
Maxsurf Pro has the ability to perform parametric transformations of hull shapes using 
the Parametric Transformation command in the Data menu. A key quality of this 
function is that it maintains the fairness of the hull to a very high degree during the 
transformation process.  
 
The Parametric Transformation command displays a dialog that is used to perform the 
transformation on the design's visible surfaces. 

 

The parameters that can be specified are divided into two groups: 
• Search Parameters 

• Scaling factors 
 
After doing a parametric transformation you will want to be able to do a Hull Shape 
Comparison. Also see the section on Parametric Transformation Restrictions on page 
178. 

Search Parameters 
Search Parameters are those that require a non-linear transformation of the hull shape. 
These are - 
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• Prismatic or Block coefficient 

• LCB – Longitudinal Centre of Buoyancy (also see the section on Parametric 
Transformation Restrictions on page 178. 

• Parallel Midbody – In a merchant vessel that has a parallel midbody it is important 
to be able to perform parametric transformations on the fore and aft portions of the 
vessel without affecting the midbody. To use this feature, enter the positions of the 
fore and aft limits of the parallel midbody. The Parametric transformation will not 
change the location of any control points between these two locations. 

• Midship Area Coefficient. This parameter determines the fullness of the midship 
section and the magnitude of any bilge radius. A change to the Midship Area 
Coefficient will also result in the sections in the bow and stern becoming fuller or 
slacker. 

• Topside Flare. This parameter is unlikely to be used for commercial ships but is 
useful in the design of leisure craft, both power and sail. The angle of the topsides 
at the position of greatest beam can be specified, resulting in more or less flare. 
This flare is also distributed in a fair manner forward and aft, tending to taper out 
near the extremities. 

 
To vary these values, some form of non-linear transformation of the hull must take place. 
Because the non-linear transformation is not an explicit function of these parameters, 
Maxsurf must perform an iterative search to achieve the specified values. 
 
Note that the only required search parameters are LCB, and either Prismatic or Block 
coefficients. All other parameters and scaling factors are optional and can be combined 
arbitrarily. 
 
Also note that the values for Waterplane Area coefficient and LCF are provided for 
informational purposes only; i.e. it is not possible for them to be specified as search 
parameters. 

Using the search parameters for a parametric transformation 
Before performing a parametric transformation of the hull, make sure you do the 
following steps first; 

 Ensure that you have a coherent model for which hydrostatic data can be 
calculated – see the Hydromax user manual section “Hydromax model". 

 Unlock all surfaces (tip: use the right click function in the Assembly 
Window to do this). 

 Hide all superstructure and other surfaces that are not used to describe 
the hullshape.  

You are now ready to do a parametric transformation. 

 Specify the new LCB position and either a new Block or Prismatic 
Coefficient, followed by constraint values for a maximum of three of 
Displacement, Waterline Length, Beam and Draft. 

 Once these values and constraints have been specified, click on the Search 
button.  

Maxsurf will iterate to achieve the required parameters and will display the results when 
it is finished. If the required parameter values could not be achieved, Maxsurf will beep 
at the conclusion of the calculation process. 

http://www.formsys.com/extras/FDS/webhelp/hydromax/hmmanual.htm#hydromax_model
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Example: LCB variation on fishing trawler 

 Open the Maxsurf Sample_Trawler.msd file from the sample designs 
folder on your hard drive.  

 Save the design to another location with a different filename  

Tip: it is generally good practice to save to another filename before doing a 
parametric transformation or working with the standard sample designs. 

  Go to Data | Parametric transformation 

 

 Type LCB = 49 to search for a LCB of 49% of Lwl aft of FP 

 Leave the Waterline Length, Beam and Draft and draft fixed, but allow 
the displacement to vary by using the “Scale to:” settings as in the image 
above. 

 Press Search and wait for the hourglass to disappear. 

 Press Ok to accept the new hullshape 

 Do a Data | Calculate hydrostatics to check the new LCB position 

Tip: use the following Data | Coefficients dialog settings: 
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 Go to profile view and do a Ctrl+Z to undo the parametric 
transformation and a Ctrl+Y to redo it. This quickly gives you an idea of 
what has changed. 

Also see:  
• Scaling factors 

• Hull Shape Comparison 

• Parametric Transformation Restrictions 
 

Scaling factors 
Scaling Factors are those parameters that can be calculated directly using a linear scaling 
of the hull, namely Displacement, Waterline Length, Waterline Beam and Draft. These 
parameters can be constrained to particular values, or left to vary as other parameters 
change by selecting the appropriate check boxes and setting the required values. 
 
As an example, if no scale factors are specified and the Block Coefficient is increased, 
the displacement will also increase, while the length, beam and draft will remain 
constant. If the displacement is the only constraint, the length, beam and draft will 
decrease proportionally to accommodate the redistributed volume. If displacement, 
length and beam are constrained to particular values the draft will be changed 
accordingly. 

Note 
It is not possible to constrain all the values simultaneously – of the four 
values, displacement, length, beam and draft, at least one must be allowed to 
vary at all times. 

Example: specifying the waterline dimensions 

 Open the Maxsurf Sample_Trawler.msd file from the sample designs 
folder on your hard drive.  

 Save the design to another location with a different filename  

Tip: it is generally good practice to save to another filename before doing a 
parametric transformation or working with the standard sample designs. 

  Go to Data | Parametric transformation 
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 Specify the following scaling factors and leave the displacement un-
constrained: 

 

 Press Search and wait for the hourglass to disappear. 

 Press Ok to accept the new hullshape 

 Do a Data | Calculate hydrostatics to check the changes have been made 
correctly.  

Note that the displacement has changed, but the LCB % and hull form coefficients 
are still the same. The draft to baseline is not updated until you specify the new 
baseline and you may also want to reset your AP and FP in the Frame of 
Reference dialog to match the new overall dimensions of the hull. 
 

Also see:  
• Search Parameters 

• Hull Shape Comparison 

• Parametric Transformation Restrictions 

• Hydrostatics 
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Hull Shape Comparison 

For comparison purposes it may be a good idea to duplicate the surfaces prior to 
modification (the duplicate surfaces can be made to lie exactly on top of the originals by 
specifying zero for all three spacings). The duplicate surfaces should then be made 
invisible so that they are not affected by the transformation. If, after the transformation, 
you make the original surfaces visible, you will have a direct comparison of changes to 
the waterlines, buttocks and sections.  
 
Tip: by holding the mouse cursor over the contour lines you can see the surface name 
and the contour line name in the bottom left of the Maxsurf window. Note that this 
method of comparison will not work if the model is trimmed as the coincident surfaces 
will corrupt the trimming information. 

 

Hull comparison after 2% change to Prismatic and 1% change to LCB 

Another quick way to compare the hull is by simply doing Ctrl+Z to undo the Parametric 
Transformation and Ctrl+Y to redo.  
 
It can also be a good idea to make a copy of the hydrostatic data before the parametric 
transformation into Excel and compare it with the data afterwards. 

Parametric Transformation Restrictions 
Transformations are applied to visible surfaces only. Surfaces selected should form a 
coherent model capable of being analysed in Hydromax. This means that care should be 
to taken to trim intersecting surfaces where necessary and make sure that potential 
ambiguities such as multiple openings in the hull are resolved. 
 
It is important that the parent model be reasonably close in form to the required final 
design as it is not feasible to make major changes to the search parameters before the hull 
starts becoming unreasonably distorted. Experience suggests that reasonable variations of 
Block, Prismatic or LCB are of the order of up to plus or minus 3 to 5%. These limits 
may be lower for vessels that have moderately high prismatic coefficients – as the 
prismatic increases the scope for variation seems to improve.  
 

  
Normal hullshape with relatively low prismatic 
coefficients allow 3 to 5% LCB variation. 

Highly prismatic hullshapes only allow small % LCB 
variations. 
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The parametric variation tool is ideal for making small adjustments from a suitable 
parent design. It is not intended to be used for gross design modifications. The scope for 
parameter variation is greatest for designs that are not extreme; as the design and its form 
parameters become more extreme the scope for parametric variation is reduced. 
 
Because of the non linear nature of the transformation and the requirement that fairness 
be maintained, it is often found that long fore and aft overhangs distort proportionally 
more than the underwater body. The shorter the overhangs of the vessel are the less 
noticeable this effect will be. 
 
It is not possible to constrain Displacement, Length, Beam and Draft simultaneously; the 
maximum permissible is any three parameters out of the four available. 

Americas Cup Yachts 
Special functionality has also been added specifically for the designers of Americas Cup 
class yachts. This is enabled only for purchasers of ACRule which can be accessed by 
entering an authorisation code in the Options dialog in the Windows | About Maxsurf 
dialog. 

 

In the case of Americas Cup class yachts the constraint applying to LWL has been 
replaced by one applying to the AC LBG value, a length measured 200mm above the 
DWL. In addition, the Parametric Transformation automatically constrains the forward 
and aft girths to the minimum allowable value, as measured by a chain girth at the 
forward and aft girth stations. 
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Input of Data 
Maxsurf can import a range of data formats to assist you in creating a Maxsurf design to 
match existing data. Point and line data can be imported via DXF, surface data can be 
imported via IGES and Rhino 3dm files and image data can be imported in a range of 
bitmap formats such as GIF, BMP and PNG. 
 
In this section:  

• Pasting (General) 

• Importing DXF  

• Importing DXF Markers 

• Importing IGES Surfaces 

• Importing Rhino .3dm files  
 
Also see:  

• Background Images on page 142 in the surface fitting section of chapter 5. 
 
Before continuing this section, you may wish to read the Maxsurf Coordinate System on 
page 36. 

Note 
If your File | Import submenu is greyed out, make sure you create a new 
design first from File | New. 

Pasting (General)  
You can paste data from any spreadsheet, word processor or text editor into the tables in 
Maxsurf. 
 
To paste data into Maxsurf 

• Copy the text to be pasted and switch to Maxsurf 

• Select the range of cells to be pasted into 

• Choose Paste from the Edit menu (or use Ctrl V). 
 

Importing DXF background 
Using the Import DXF Background command from the File menu enables you to import 
a DXF file into Maxsurf to use as construction lines. The DXF file will be displayed in 
all design views. DXF backgrounds can be really useful when you have a 3D lines plan 
in for example AutoCAD that you want to manually fit a surface to.  
 
Note: You can only have one DXF background for your Maxsurf design. This single 
DXF background will be displayed in all 4 design windows. In case you want the profile 
lines displayed in the Profile window, and the section lines displayed in the Body Plan 
window, you have to convert your 2D lines plan drawing to a 3D lines plan in AutoCAD 
before saving as a .DXF. 
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Note 
If your File | Import submenu is greyed out, make sure you create a new 
design first from File | New. 

See also:  
• Importing DXF Markers on page 181 

 

Importing DXF Markers 
The importing of marker information is possible from DXF as well as GHS and Seaway 
section data files. 
 
The Import DXF Markers command from the File menu can be used to import lines, arcs 
or polylines from a DXF file and display them as markers in the graphics views in 
Maxsurf. Each point at the end of a line or along a polyline will be converted into a 
marker. 
 
To import a DXF file as markers: 

• Choose Import->Import DXF Markers from the File menu 

 

• Set the XYZ orientation of the data in the file 

Note 
If your File | Import submenu is greyed out, make sure you create a new 
design first from File | New. 

You can use the radio buttons in the middle of the dialog to specify the orientation of the 
points in the file relative to the Maxsurf coordinate system. For example, choosing +ve 
(positive) and X in the Forward section means that +ve X coordinates in the DXF file 
will be aligned with the forward direction of the Maxsurf model.  
Also see: Maxsurf Coordinate System on page 36 
 
The coordinates in the file are positioned relative to the current Maxsurf zero point. 

• Set the units of the data in the file 
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Click on the radio button corresponding to the units of the data in the file. 
• Optionally set the arc segment length 

 
If you are importing arcs from the file, these will be converted into line segments before 
importing. This field can be used to specify the length of the line segments along the arc. 

Note: 
You can only import ARC objects in the DXF file. Arcs within polylines 
will not be imported, you should explode the polyline first before importing. 

• Optionally save the configuration 
 
You can use the Add button at the bottom left of the dialog to add a configuration and 
save the setting for future usage. For example, if you frequently import from AutoCAD, 
you might like to set up a configuration, named AutoCAD, to save your import settings. 

• Click OK to import the data 
 
Once imported the markers can be manipulated in the usual way, including assigning to a 
particular station or associating with a surface. See also Markers section. 

Importing IGES Surfaces 
To import NURB surfaces into Maxsurf, use the Import IGES Surfaces command from 
the File menu. If you are starting a new design by importing an IGES file, make sure you 
create a new design first from File | New. 
 
IGES stands for the Initial Graphics Exchange Standard. It is an extremely powerful 
format and is compatible with the majority of major CAD programs. IGES trimmed 
NURBS surfaces are represented as an entity 128, which contains the surface geometry, 
together with an entity 144, which contains only the trimming information.  
 
Maxsurf can only read the entity 128 data, but does not support importing the entity 144 
trimming data.  

Note: importing trimming surfaces 
Maxsurf does not support importing trimmed surfaces at the moment. All 
surfaces have to be re-trimmed manually.  

Each NURB surface found in the file will become a surface in Maxsurf. 



Chapter 5 Using Maxsurf 

Page  183  

 

The orientation of the imported model into the Maxsurf coordinate system depends on 
the orientation of the axis in the program where the .IGES file originates from.  

Note: 
See: Maxsurf Coordinate System on page 36 

The options at the bottom of the dialog can be used to correctly orientate the control 
point net with respect to Maxsurf’s usual conventions. 

Importing Rhino .3dm files 
To import NURB surfaces into Maxsurf, you can use the Import | Rhino .3dm file 
command from the File menu.  If you are starting a new design by importing a Rhino 
file, make sure you create a new design first from File | New. When importing a Rhino 
file which has trimmed surfaces a dialog box will appear asking you whether you wish to 
try and replicate the trimming.  
 
Each NURB surface found in the file will become a surface in Maxsurf. 
 
The orientation and dimensions of the imported model into the Maxsurf coordinate 
system depends on the orientation of the axis and units set in the 3dm file where the 
model originates from.  

Note: Importing trimming surfaces 
On importation of a trimmed model from Rhino, trimming curves that do 
not necessarily lie on a surface/surface intersection may be present.  These 
contours can be used to trim the surfaces as any normal intersection line.  
Visibility of these Rhino trimming contours may be turned on and off via 
the Display | Contours dialog. 
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Output of Data 
Maxsurf can output your design lines in a wide variety of file formats and hard copy. File 
formats available are 2D IGES, 3D IGES, 2D DXF, 3D DXF, 3DMF and VRML. Lines 
from any of the drawing windows may be saved as files or output directly to printers. 
Data from the Calculations, Markers, Control Points and Offsets files can be printed, 
saved to text files or copied into the clipboard for pasting into spreadsheets or other 
applications. Maxsurf also allows saving of animation files.  
 
This section will describe the following output options:  

• Printing 

• Copying 

• Offsets Data Output 

• Animation Files  

• Exporting a Maxsurf Design 

 
Also see: 

• Appendix A Data Export 
 

Printing 
Maxsurf prints the contents of the window that is topmost on the screen. Choosing Print 
from the File menu will display a print preview, allowing you to view the output, page-
by-page, on screen.  
 
Use Page Setup, also from the File menu, to adjust the paper size, margins, orientation 
etc. 

Standard Views 
When printing a standard view of the design, you will be asked select the scale at which 
you wish to print. There are a number of default scales but you may also enter your own 
custom scale factors. 

• Bring the window you wish to print to the front. 

• Choose Print from the File menu. 

• Choose the desired Scale. 

• If the print preview is as required, click the Print Button. 
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Printing from Maxsurf is straightforward and is usually a matter of setting the Page Setup 
parameters and selecting Print. If you encounter problems, check that the following have 
been done. 

• Make sure your printer is connected to the computer. 

• Make sure you have selected a default printer using the Printer control panel 
 

Rendered Perspective Views 
Printing a rendered perspective view is the same as printing a standard view except you 
will not be prompted for a custom scale.  Rendered perspective views can only be printed 
on one page. 
 
The image displayed in the print preview window may have some slight differences from 
the final printed version, this is only due to scaling in the print preview window. 
 
Also see:  

Exporting a Maxsurf Design, section: Bitmap Image on page 192. 

Colour Printing 
Maxsurf supports colour output to suitable devices. You may choose whether you wish 
to print in colour or black and white in the print preview by clicking the Colour button. 

Setting Page Size , Orientation and Margins, 
The paper size, paper orientation and margins may all be set in the Page Setup dialog 
accessed from the File menu. 

 

 
You may choose the printer you wish to print to by clicking the Printer button. 
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Further printer specific options may be chosen by clicking on the Properties button. The 
options available will depend on the printer and the printer driver you are using. 

 

Print Titles 
You can specify titles to be placed on the head and foot of each page you print. Use the 
Titles button in the print preview window: 

 

This will bring up the Titles dialog, which allows you to set your print titles. 
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Copying 
When copying from a drawing window 

• Select the window you wish to copy. 

• Select Copy from the Edit menu (or use Ctrl C). 

• Select the scale or enter your own custom scale and name. 

• Click OK. 
 
To paste this selection into a word processor or spreadsheet 

• Select Paste from the Edit menu (or use Ctrl V). 
 

Copying Numeric Data 
When copying from a data window: 

• Select the appropriate column by clicking in the column title bar. 
or 

• Select the appropriate row by clicking on the row number. 
or 

• Select the whole window by clicking in the top left hand corner. 

 

• Select Copy from the Edit menu (or use Ctrl C). 

• To copy the column titles as well as the selected data, hold down the Shift key 
while selecting Copy (or use Shift Ctrl C) 

 
It is also possible to select arbitrary blocks of text rather than complete rows or columns 
or individual cells.  

 

To achieve a rectangular selection, hold down the mouse button in the cell that you wish 
to be a corner of the required selection. Drag the mouse in any direction and multiple 
cells will highlight. If you drag the mouse outside of the table boundaries, the cells will 
automatically scroll in the correct direction. 
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Alternatively, click in one cell, than hold down the Shift key and click in a second cell. 
All cells between the two chosen will be selected. 
 
To paste into the selected cells, choose Paste from the Edit menu (or use Ctrl V). 

Offsets Data Output 
The following output option exist for offset data: 

• Copied and pasted into Excel 

• Saving the table of offsets as a text file from the Offsets window 

• Using Hydrolink. 
 

Using Hydrolink to Export Offsets Data 
Maxsurf supports saving of offset data in a format suitable for input to other analysis 
systems. This is done by Hydrolink, a separate application in the Maxsurf suite. 
Hydrolink can read in a Maxsurf design and save the offset data in a format suitable for 
input into many other analysis systems.  

Animation Files 
Animations generated in the perspective view may be saved in avi format for playback at 
a later date or for use in presentations etc. 
 
To generate an animation: 

• Go to the perspective view and adjust the display, rendering and colours to obtain 
the desired view. 

• Select Animate from the Display menu, set-up the desired animation options and 
tick the Save Animation to disk box. 

 

• Click OK and then choose a file name for the animation file. 

• Click Save and then select the Compressor type. 
 
Please note that some of the compressors will not work with all graphics settings. The 
Full Frames (Uncompressed option) should work with all graphics settings. 
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• Click OK 
 
The animation will now be generated and saved to the file. This may take a few seconds, 
particularly if there are many surfaces to be rendered in the model. 

Exporting a Maxsurf Design 
Maxsurf allows you to export your design file in different formats.  

• DXF File 

• IGES File 

• Rhino .3dm file 

• Maxsurf V8.0 , export to earlier Maxsurf file formats. Note that this may lead to 
some loss of data 

• Others 
 
You may export the following file formats to other platforms by selecting them from the 
Data Export dialog box in the File menu: 

• IGES 

• DXF 

• 3DMF 

• Vrml 

• 3dm  
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IGES 2D IGES 

3D IGES 

Polylines.igs, lines in 2D that can be controlled with 
control points. Similar to a spline in AutoCAD. 

Polylines.igs, a line in 3D that can be controlled with 
control points. Similar to a spline in AutoCAD. 

NURBS.igs, consists of the control points, control point 
weights, surface stiffness and possibly trimming. 

DXF DXF 

DXF 

Polylines.dxf, straight-line segments in 2D 
approximating the  NURB surface. Contour lines are 
exported as displayed on screen.

Polylines.dxf, straight-line segments in 3D 
approximating the NURB surface. Contour lines are 
exported as displayed on screen.

3D Face.dxf, Similar to polylines, but instead of 
approximating a curve, faces approximate a surface. 

3D Mesh.dxf, approximates a surface by dividing the 
surface up into a number of “faces” see 3d faces. 

3DMF 

Vrml 

3dm File format for Rhinoceros (.3dm files). 

Virtual Reality Modelling Language format. This is a 
file format especially designed for delivering 3D 

File format for Quickdraw3D. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

IGES File 
IGES stands for the International Graphics Exchange Standard. It is an extremely 
powerful format and is compatible with the majority of major CAD programs. Design 
information may be transferred using a 2D or 3D IGES file. If a 3D IGES file is chosen 
you have the option of transferring the lines that are visible in the drawing windows 
(polylines), or using the complete B-spline surface definition (NURBS surface). 
For more information on IGES export, please refer to Appendix A Data Export from 
page 213. 
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IGES export example. An .IGES file contains all NURBS surface information.  

DXF File 
DXF is the Drawing eXchange Format. Design information is transferred using a 2D or 
3D DXF file as either a polyline file or a 3D face or mesh.  

 
3D Polyline export example.  

  
3D Mesh export example. The number of segments used to display the surface is dependent on the surface 

precision. 
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3D Face export. The mesh is divided up into a number of faces. 

3DMF 
3DMF is the file format for Quickdraw3D. 

VRML 
Maxsurf is able to export models in the ISO standard VRML (Virtual Reality Modelling 
Language) format. This is a file format especially designed for delivering 3D models 
over the internet for their display in standard browsers such as Netscape Navigator or MS 
Internet Explorer. This feature means that Maxsurf models can be readily included in 
web pages; this facilitates sharing information on a global (internet) or internal (intranet) 
level. Further information on VRML is available from the Web3D consortium, whose 
web site may be found at: http://www.web3d.org/ 

Rhino .3dm file 
3dm is the file format for Rhinoceros NURBs modelling software. Both trimmed and 
untrimmed Maxsurf surfaces can be saved in Rhino file format. Because there is no 
concept of symmetrical surfaces in Rhino, any symmetrical surfaces in Maxsurf will be 
duplicated and mirrored about the centreline when exported to Rhino using the Export | 
Rhino .3dm file command from the File menu in Maxsurf. 

Bitmap Image 
Bitmap export gives you the ability to export Rendered Perspective Views to a bmp file. 
This is similar to Edit | Copy (Copy to Clipboard), however File | Export | Bitmap Image 
allows you to specify the size of the image; the larger the size, the better the quality.  
This is a useful feature for creating high resolution promotional material. 
 
This function is not available for the Simple Shading rendered mode. 

Note 
For additional information on data export from Maxsurf, see: Appendix A 
Data Export on page 213. 

http://www.web3d.org/
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Chapter 6 Maxsurf Reference 
This chapter describes the toolbars and menu commands available in Maxsurf. 

• Toolbars 

• Menus 
 
The functions available in the different Maxsurf windows are explained in Chapter 4 
Maxsurf Windows on page 35. 
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Toolbars 
Maxsurf has a number of icons arranged in toolbars to speed up access to some 
commonly used functions. You can hold your mouse over an icon to reveal a pop-up tip 
of what the icon does. 

Customising Toolbars 
All applications in the Maxsurf suite contain fully customisable toolbars. This enables 
you to make your most frequently used commands available with just one click and 
delete any toolbar buttons that you don’t need. The toolbar buttons themselves are also 
fully customisable, including text and button images.  

Adding/Deleting Standard Toolbar Buttons 
The standard toolbars available in each of the Maxsurf suite’s applications can easily be 
edited by clicking on the little triangle on the right side of any of the toolbars and select 
“Add or Remove buttons”. This allows you to select which button you wish to add or 
delete buttons by simply ticking or un-ticking the command.  

 

By selecting “Reset” the Standard toolbar will be restored to its default state. Note: this 
will delete any extra buttons you may have added to the standard toolbar.  

Creating Your Own Toolbars 
You can customise all toolbars in all Maxsurf applications via the customise toolbars 
function. This is available via the View | Toolbars | Customise Toolbars menu item or by 
clicking on the little triangle on the right side of each toolbar and selecting “Add or 
Remove buttons”. Alternatively simply right click on a blank space on the toolbar area of 
the application window and select “Customize”. This brings up the following tabbed 
dialog: 

 

Toolbars tab 
Use this tab to add or delete toolbars. Note: the standard toolbars that were 
installed with the applications cannot be deleted or renamed. 
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Commands tab 
On this tab you will find all commands available in the application sorted per 
menu. To add a command to a toolbar, simply select the command and drag and 
drop it onto the toolbar. Note: As long as the Customize dialog is open, you can 
drag and drop toolbar buttons between different toolbars and the toolbar buttons 
are inactive; i.e. they will not work. 

 

Dragging and dropping a command onto a new toolbar. 

Options tab  
This tab allows you to customise the menu and toolbar display. 
• Always show full menus will only show the most commonly used commands in the 

menu based on the command usage history. This command usage tracking 
function is not enabled in the Maxsurf applications; this means you can ignore the 
top half of this dialog. 

• Large icons displays the toolbar buttons larger.  

• Show ScreenTips on toolbars will enable the little text boxes that display which 
command is invoked by that toolbar button.  

• Show shortcut key in ScreenTips will also show you the shortcut key (if available). 
This can be quite handy for you to learn the shortcut keys which allow you to 
operate the program even faster. 

• Menu animations allows you to set how you want the menus to appear.  
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Editing Toolbars Buttons 
When the Customize dialog is open (from View | Toolbar |Customize Toolbars menu), 
you can right click on a toolbar button to edit it via a right click menu.  

 

A couple of interesting things that this allows you to do are: 
• Edit button image will pop up a dialog that allows you to draw your own toolbar 

button image. 

• Change the toolbar button image to one from the standard toolbar button images 
library. 

• Select how you want to display the toolbar button image. For example: if you have 
trouble distinguishing between different toolbar buttons, you can select the Image 
and Text option to display both the image and the toolbar button name (the image 
button name is the command name by default). 

Saving a Customised User Interface 
Each time you close any of the applications in the Maxsurf suite, the application will 
automatically save your toolbar settings and windows layout to an ##Settings.xml file in 
the Maxsurf root directory. The Maxsurf root directory is by default c:\program 
files\Maxsurf.  
 
For example: After closing Hydromax, your current user interface will be saved in 
c:\program files\maxsurf\HMSettings.xml. The next time you start up Hydromax, it will 
look for this file for the application user interface settings. 
 
If you want to save a copy of a user interface settings file, simply use windows explorer 
to locate the .xml file mentioned above, duplicate it and rename the duplicate to for 
example: HMSetting_Custom1.xml. 

Restoring a Customised User Interface 

Restoring a toolbar 
If you want to restore only one toolbar, use the View | Toolbars | Customise 
Toolbars command, select the Toolbar you wish to reset and then press Reset.  
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Restoring the user Interface 
Use the Restore default layout from the Windows menu to restore to the default 
windows and toolbar settings. Alternatively you can hold down the shift key at 
start-up. Note that the latter clears your Windows Registry. See the “Windows 
Registry” section for each application to find out which settings are stored in the 
windows registry before clearing it! 

Restoring to a saved settings file 
If you want to restore to a saved setting, use the following steps: 

1. Rename or delete your current ##Settings.xml in windows explorer. Your 
current user interface settings file is located in the Maxsurf root directory and is 
called MSSettings.xml for Maxsurf, HMSettings.xml for Hydromax etc. 

2. Rename the custom.xml file to the default name. For example to restore 
custom1 settings: rename HMSettings_Custom1.xml to HMSettings.xml.  

Maxsurf Toolbars 

File Toolbar 

 

The File toolbar contains icons that execute the following commands: 
New – Open – Save | Cut - Copy - Paste | Print | Help 

Edit Toolbar 

 

The Edit toolbar contains icons that execute the following commands: 
Undo – Redo 

View Toolbar 

 

The View toolbar contains icons that execute the following commands: 
Zoom – Shrink – Pan – Home View – Rotate | Assembly Window 

Markers Toolbar 

 

The Marker toolbar contains icons that execute the following commands: 
Add Marker, Delete Marker | Snap Control Point to Marker, Fit Edge to Markers 

Controls Toolbar 

 

The Controls toolbar contains icons that execute the following commands: 
Add Row/Column – Delete Row/Column | Align To Vector – Align To Plane – Compact 
– Group – Ungroup – Bond - Unbond | Mask – Unmask 
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Display Toolbar 

 

The Display toolbar contains icons that change the state of the following parts of the 
display: 
Shape – Net – Half – Compress – Outside Arrows | Hide Curvature – Show Curvature | 
Hide Markers – Show Markers for Current Station – Show All Markers – Connect 
Markers 

Window Toolbar 

 

The Window toolbar contains icons that make the corresponding window come to the 
front: 
Perspective – Plan – Profile – Body Plan | Calculations – Control Points – Markers – 
Surfaces – Graph – Offsets 

Render Toolbar 

 

The Render toolbar lets you switch rendering on/off and change light settings. These 
toolbar commands are only available when you are in the Perspective window. 
Render on/off – Light directions (4x) - Lighting Options 
 

Visibility Toolbar 

 

The Visibility toolbar contains icons that can be used to quickly toggle the display of 
certain contours: 
Stations – Waterlines – Buttocks | Edges – Bonded Edges – Feature Lines – Parametrics | 
Intersections. 

Surface Toolbar 

 

The Surface toolbar contains icons that are used to access the surface manipulation 
commands: 
Move – Duplicate – Flip – Rotate – Align 
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Menus 
Maxsurf uses the standard set of Windows menu commands for File, Edit and Window 
operations. It also has a range of menus for control point and surface manipulation and 
control of data and view displays. 

• File Menu 

• Edit Menu 

• View Menu 

• Marker Menu 

• Controls Menu 

• Surfaces Menu 

• Display Menu 

• Data Menu 

• Window Menu 

• Help Menu 
 

File Menu 
The File menu contains commands for opening and saving files, importing and exporting 
data, and printing. 

New  
Select New when you wish to commence a new design. Alternatively, if the Calculations 
window is uppermost a new calculations sheet will be created.  

Open 
Maxsurf has the ability to save designs to disk and recall them at a later date. By 
selecting Open, a dialog box appears with a list of available designs. Select the design 
you wish to recall, click the Open prompt, and the requested design will be read in. 
 
Open will remain active until you are using the maximum number of surfaces available 
in your version of Maxsurf. This allows you to read in multiple designs and overlay 
them, or to read in the same design twice so that any changes can be compared with the 
original. 
 
When the Calculations or Markers windows are active, Open will allow you to open a 
calculations sheet or a set of markers from a text file. 

Close 
Select Close when you wish to finish with the current design. Before closing, a dialog 
box will appear asking whether you wish to save the current design. If you select ‘Yes’ 
the current design will be saved onto the disk. 
 
When the Calculations window is uppermost Close will close the calculations sheet. 

Save 
Selecting Save will save the current design onto disk. 
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When the Calculations, Markers, Offsets, Control Points or Surfaces windows are active 
Save will allow you to save the calculations sheet or Markers, Offsets, Control Points or 
Surfaces data to a text file. 

Save As 
Selecting Save As enables you to save the current design under a new name. This is 
useful if you modify a design, but wish to keep a copy of the old version as well as the 
new. 
 
When the Calculations window is active Save As will allow you to save a new 
calculations sheet. 

Import 
Selecting Import enables you to import a DXF, GHS or Seaway file directly into 
Maxsurf as a set of markers, or an IGES file with surface entities directly into Maxsurf as 
a surface.  
 
Import DXF Background enables you to import a DXF file into Maxsurf to use as 
construction lines. The DXF file will be displayed in the design views. 
 
Note that if you intend to load DXF markers and a DXF background, the DXF 
background should be loaded after loading the DXF Markers. If a zero-point shift of the 
DXF background occurs due to loading DXF markers, the DXF background should be 
reloaded. 
 
Import Image Background enables you to import an image file (jpg, gif, bmp or png) file 
into the background of any of the Maxsurf design views. 

Export 
Selecting Export enables you to export a Maxsurf file as a variety of different file 
formats such as DXF or IGES. 
 
You may also export to earlier Maxsurf file formats. Note that this may lead to some loss 
of data.  

Page Setup 
The Page Setup dialog allows you to change page size and orientation for printing.  

Print 
Choosing the Print function prints out the contents of the active Maxsurf window.  

Exit 
When you have finished using Maxsurf choose Exit to close the program. If Maxsurf has 
a design open that has not been saved to disk, you will be asked whether you wish it to 
be saved. 

Edit Menu 
The Edit menu contains commands for copying and pasting data, and working with 
tables. 
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Undo 
The Undo function will reset the control point net back to its previous state after an 
accidental or experimental movement of a control point or group of control points. 

Redo 
The Redo function will reinstate the changes that were discarded with the Undo 
command. 

Cut  
Cut cannot be used in Maxsurf. 

Copy 
This function performs the standard Copy function. 

Paste 
Choose the Paste command to Paste data into a table. Paste may also be used with other 
applications, but cannot be used on Maxsurf drawing windows. 

Select 
Facilitates the selection of table cells, columns and rows. 

Fill Down 
Choose the Fill Down command when you want to change several cells in a column to 
the value of the first cell. This function may be used in most of the tables, and may also 
available by clicking the right mouse button, which brings up a context menu. 

Activate/Deactivate Prefit 
This command toggles the use of the Prefit licence for the automatic surface fitting 
function. You must restart Maxsurf for this to take effect. Contact info@formsys.com for 
information on how to get access to Prefit. 

View Menu 
The View menu contains commands for controlling the appearance of the display in the 
graphical windows. 

Zoom 
The Zoom function allows you to work on any part of your design by enlarging the 
selected area to fill the screen. 

Shrink 
Choosing Shrink will reduce the size of the displayed image in an active drawing 
window by a factor of two.  

Pan  
Choosing Pan allows you to move the image around within a drawing window.  

Home View 
Choosing Home View will set the image back to its Home View size. Maxsurf starts up 
with default Home View settings for all its drawing windows. However, the Home View 
may be set at any time by choosing the Set Home View function. 

mailto:info@formsys.com
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Set Home View 
Choosing Set Home View allows you to set the Home View in each drawing window.  
 
To set the Home View, use Zoom, Shrink, and Pan to arrange the view as you require, 
then select Set Home View from the View menu. 

Rotate 
Activates the Rotate command, which is a virtual trackball which lets you freely rotate a 
design in the perspective view. 
 
After selecting the Rotate tool, move the mouse to a location in the Perspective window 
and press the left mouse button. With the left button depressed, you can rotate the image 
by dragging the mouse around and the rotation is performed by projecting the 
movements onto a virtual sphere on the screen – essentially like a virtual trackball. 
Generally speaking, moving the mouse left and right rotates about a vertical axis while 
moving the mouse up and down rotates about a horizontal axis. The Rotate mode is 
exited when the left button is released. 

Colour 
The Colour function allows you to set the colour of lines, controls, and graphs. 

Font 
The Font command allows you to set the size and style of the text in the current window.  

Preferences 
The Preferences function allows you to customise some of Maxsurf's features. 

Toolbars 
Allows you to select which toolbars are visible. 

Assembly window 
Displays the Assembly window floating window. 

Status Bar 
Allows you to show or hide the Status Bar at the bottom of the main window. 
 

Marker Menu 
The Marker menu contains commands for managing markers and fitting surfaces to 
existing sets of markers. 

Add Marker 
The Add Marker command is used when you wish to place a reference marker in the 
Body Plan, Profile, Plan or Markers windows.  

Delete Marker 
This is used when you wish to delete a marker from the Markers window or from the 
Body Plan, Profile or Plan windows. 
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Generate Markers for Developable Surfaces 
This command generates markers from the ruling lines on the developable surfaces and 
is only available if the design contains surfaces with surface type “Developable”. See 
Surface Types on page 90 for more information. 

Generate Grid from Markers 
This command will generate the grid (stations, buttocks and waterlines) based on the 
marker data and also associate markers with the correct station index. See Generating a 
Grid from Markers on page 138 for more information. 

Sort Marker Stations 
After transverse sections have been defined and a Station Index for each marker has been 
assigned, the markers with the same station index may be sorted into order (using a 
nearest neighbour sort). See Sorting Markers on page 72 for more information. 

Re-order Selected Markers 
This command sorts all markers in a selection in the order of selection. Running this 
command twice will sort order the markers in the opposite order. See Sorting Markers on 
page 72 for more information. 

Snap Control Point to Marker 
Used to move the selected control point to exact the position of the selected marker. 

Fit Edge to Markers 
Fits the selected edge (the edge may be highlighted by clicking on the edge or by 
selecting a control point in it – similar to bonding surface edges) to the selected markers. 
The spline is fitted through the markers in the order they were selected. 

Smooth Interior Controls 
Smoothes the interior control points of the current surface based on the positions of the 
edge control points. The edges remain unchanged. Useful for getting an initial fitted 
surface once the edges have been fitted. 

Fit Surface to Markers 
This command is only available if you own a Prefit Licence. This activates the automatic 
surface fitting to markers. 

Measure Surface Error 
This command measures the distance between the marker and the closest point on the 
surface with which it has been associated. After measurement, the distance for each 
individual marker is entered in the Markers table, and summary data is displayed in a 
dialog. 

Marker Properties 
Allows you to edit the properties of the selected marker(s). 

Controls Menu 
This menu provides commands to manipulate control points. 
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Add 
To Add a control point, select the add command and click in the current view at the 
location desired. Control point columns may be added in the Plan and Profile windows; 
control point rows may be added in the Body Plan window. 

Delete  
The delete command allows you to delete a row or column of control points from a 
surface. Select the delete command and click on the desired control points using the 
delete cursor. Control point columns may be added in the Plan and Profile windows; 
control point rows may be added in the Body Plan window. 

Smooth Controls 
Smoothes a complete or partial row or column, or a patch of control points. Smooth is 
always applied in three dimensions, not simply in the current view. 

Straighten Controls 
Straightens a complete or partial row or column, or a patch of control points. Straighten 
can be applied in the plane of the current view, (e.g. straightening a sheer line only in the 
profile view, while leaving it curved in the plan view), or in all three views 
simultaneously. 

Move Controls 
This function allows you to move a group of control points by a specified amount. 

Size Controls 
This function allows you to scale and re-proportion a group of control points by their 
principle dimensions. 

Rotate Controls 
This function allows you to rotate a group of control points about a specified centre of 
rotation. 

Align to Vector 
Aligns a number of selected control points to the 3D vector defined by the first two 
control points selected. To constrain the movement in certain directions hold the shift 
key down whilst selecting this command. A dialog box will appear within which you 
define the constraints. 

Align to Plane 
Moves a number of selected control points into the plane defined by the first three 
control points selected. To constrain the movement in certain directions hold the shift 
key down whilst selecting this command. A dialog box will appear within which you 
define the constraints. 

Compact 
There may be occasions when a number of control points need to be placed at precisely 
the same point in space. To do this, select the points and choose Compact. The points are 
all compacted onto the first point in the selection. 
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Group 
Any number of control points may be selected from a surface or multiple surfaces and 
grouped to move as one by selecting the control points and grouping them with the 
Group command.  

Ungroup 
This function performs the opposite of the Group function. All control Points that were 
previously in the selected group will return to being individual control points. 

Bond Edges 
Two Surfaces may be bonded together by joining along a common edge. The two edges 
may be selected for bonding by clicking on the edges or by selecting a control point 
(other than corner points) from each edge. 
 
When Bond Edges is selected the two edges are bonded together and will show a single 
row or column of control points along their common edge. Bonded edges may be 
displayed by selecting Bonded Edges from the Contours dialog in the Display menu. 

Unbond Edge 
Any edge that is bonded may be unbonded. Choose any control point along the desired 
edge and select unbond. The selected edges will now be unbonded and may be moved 
independently. 

Mask 
The Mask command allows you to select a particular group of control points, which will 
remain visible while the remainder of the net is hidden. 

Unmask 
The Unmask command restores a masked surface display to one where all control points 
in a surface net are visible. 

Snap to Grid 
The Snap To Grid command allows you to specify a minimum value for movement of 
control points. (This only affects manual movement of control points using the mouse or 
arrow keys and not the fairing controls such as smooth.) 

Control Properties 
This command lets you change the control point properties for a group of selected 
control points. This command can be quite useful if you want to set a group of control 
points to the same position or plane; e.g. move a group to the centreline or a specific 
deck height. See Control Point Properties on page 153 for more information. 

Advanced 
This gives you advanced functions that may be used to adjust the control point net. Row 
and column indexing may be changed and rows and columns transposed. The actual 
surface shape remains unchanged. 

Surfaces Menu 
The Surface menu contains commands for manipulating surfaces. 
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Add Shape 
A number of basic shapes may be added, these include cylinders, boxes and spheres. 

Add Surface 
Select Add Surface to add a surface shape to your design. It may be renamed through the 
Properties dialog. 

Delete Surface 
Choosing Delete Surface displays a dialog that allows you to select the surfaces to be 
deleted. 

Duplicate Surfaces 
This command duplicates the selected surfaces. You may select the number and relative 
positioning of duplicates. 

Move Surface 
Choosing Move Surface allows movement of a whole surface to any position in the 
current view. This may be done by dragging the surface or specifying the movement 
numerically. 

Size Surfaces 
The Size function allows you to scale and re-proportion a surface or group of surfaces by 
their principle dimensions. This function is particularly useful when modelling 
geometrically similar variations from a parent design, and also allows precise 
specification of principle design parameters. 

Flip Surfaces 
This command allows you to flip, or mirror, a surface or group of surfaces about a 
specified longitudinal, transverse or horizontal plane. 

Rotate Surfaces 
Choosing Rotate Surface rotates one or several surfaces about a specific centre of 
rotation. The centre of rotation is specified numerically, and is displayed in the drawing 
windows as a small circle.  

Align Surfaces 
Choosing Align Surfaces allows you to select two surfaces for aligning by way of 
selecting a control point from each surface. Aligning takes place by movement of the 
complete surface such that the two control points are coincident. The surface whose 
control point was selected first is fixed. 

Visibility 
This function allows you to select which surfaces are visible. The visibility of any 
surface may also be changed in the Properties dialog and Surfaces window. 

Locking 
This function allows you to select which surfaces are locked. Locking hides all control 
points in the surface, which prevents modification of the shape. The locking of any 
surface may also be changed in the Properties dialog and Surfaces window. 
 
If you hold down the "Shift + Ctrl" keys when clicking OK in the Locking dialog, the 
surfaces are locked and made read-only forever! 
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Note that you can never unlock them, so be careful! You can use this to send a design to 
someone, where you do not want them to be able to modify the design or create a new 
design based on your model. Use Save As to create a new file before using this feature. 

Appearance 
This dialog allows you to select the surface colours that are used for rendering in the 
Perspective window, and displaying the surface's parametric curves. This may also be 
specified in the Surfaces window. 

Surface Properties 
Each surface that is created in a Maxsurf design has a unique set of properties associated 
with it. The Properties command allows you to view and modify these properties. The 
properties of all the surfaces may also be edited in the Surfaces window. 

Precision 
Maxsurf has five levels of calculation and display precision. The appropriate precision 
may be set at any time depending on the performance of your computer, the complexity 
of the design and the level of detail required. 

Start Trimming 
Select the name of the surface you wish to trim from this sub-menu and then click on the 
regions of the surface to turn trimming on and off. When you are happy with the trimmed 
state of the surface, or if you just want to stop trimming, choose the Trim command. 

Trim Surface <name> 
Select this command when you have finished clicking on the regions of the surface you 
are currently trimming, and you want to confirm your trimming changes. 

Untrim Surface <name> 
Removes all trimming information from the selected surface. 

Display Menu 
The Display menu contains commands for turning on and off items displayed in the 
graphics windows. 

Shape 
When the Shape option is selected, the contours and edges of all visible surfaces will be 
displayed.  
 
It is possible to display either the surfaces being worked on or their control point nets. 
Alternatively, it is possible to show both the shape and the net simultaneously. This 
allows for the modification of the entire control point net, while viewing the changes in 
the surface itself.  
 
It is a good idea to set the colour of the net and the surface contours to different hues so 
that you may distinguish them easily. 

Net  
The Net display shows the complete control point net for all visible and unlocked 
surfaces.  
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The net can be manipulated by clicking on a control point vertex and dragging it about 
the window. Once you are familiar with the results of modifying the net directly, it is an 
extremely efficient way of modifying a shape to effect global changes. 
 
Control points may be moved in any drawing window, but in the Perspective window the 
movement is limited to the plane that is most perpendicular to the angle of view. An 
indicator showing the most perpendicular plane is displayed in the lower right hand 
corner of the window.  

Half 
For symmetrical surfaces, the control point net exists only for one half of the 
symmetrical surface. The Half function controls whether the surface's mirror image is 
displayed across the longitudinal centreline. 
 
By choosing the 'Split Surface Display' option in the surface Properties dialog, the Body 
Plan window will display the forward half of a surface on the right hand side and the aft 
half on the left hand side, when the Half function is selected. 

Compress 
The vertical and transverse axes are increased by a factor of four relative to the 
longitudinal axis. This is useful for fairing longitudinal curvature. 

Curvature 
Displays curvature porcupines for any edge, section, waterline, buttock, diagonal or 
feature line by clicking on the curve and selecting Show Curvature. Porcupines are 
displayed perpendicular to the curve and their lengths are inversely proportional to the 
square root of the radius of curvature at that point on the curve. Note that the smallest 
radius on a given curve is displayed at the end of the porcupine corresponding to its 
position on the curve. 

Trimming 
Turns on or off the trimming option in Maxsurf. This command also lets you trim 
surfaces Invisible or Gray. 

Outside Arrows 
Displays the arrows which show the surface's current outside normal direction. All 
surfaces should point outwards. The direction of the surface normal may be flipped by 
clicking in the circle at the end of the arrowhead. This is important for rendering, skin 
thickness direction and correct interpretation of the design when it is loaded into 
Hydromax or Workshop. 

Markers 
You can choose to display all markers or no markers, or you may choose to only show 
those markers whose station number is the same as the current station. The Connect 
Marker Stations command displays a connecting line between markers on the same 
station. See Sorting Markers on page 72 for more information. 

Background 
Controls whether the background DXF construction lines and the background images are 
displayed or not. The background may be loaded from an existing DXF file using the 
Import function in the File menu. Tools for positioning and scaling the background 
image are also here. 
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The commands in the submenu are only available when a background image or DXF has 
been imported. See:  

• Importing DXF background on page 180 

• Background Images on page 142 
 
Hide DXF 

Hides the DXF background. 
Show DXF 

Shows the DXF background. 
Delete DXF background 

Deletes the DXF background.  
Hide Image 

Hides the background image in the current view window. 
Show Image 

Shows the image in the current view window. 
Set Image Zero Point 

Sets the image zero point. This command is not available for images in the 
perspective window. See Setting the Zero Point on page 143. 

Set Image Reference Point 
Sets the image reference point. See Setting the Scale on page 143. 

Delete Image 
Deletes the background image in the current view window. 

 

Grid 
When Show Grid Only is selected, the positions of the Sections, Waterlines, Buttocks 
and Diagonals as specified by the Grid Spacing function from the Data menu, will be 
drawn. 
 
When Show Grid and Labels is selected, the names assigned to each grid line in the Grid 
Spacing option will also be shown on the screen and hardcopy. 

Contours 
The Contours option allows you to select which contours are drawn on the screen at any 
given time. Any combination of contours may be chosen from the contours dialog. 

Render 
Render may only be selected when the Perspective window is active. Selecting Render 
performs hidden line removal on the design with a choice of surface shading and false 
colouring. 

Animate 
Animate may only be selected when the Perspective window is active. Maxsurf will 
attempt to draw as many views as possible with the available memory, up to the 
maximum number specified in the animate dialog.  
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 When these views have all been drawn they can be played back as a moving picture by 
moving the mouse from side to side. Clicking the mouse button will terminate the 
animation. 
 
Animations may be saved to AVI files for playback at a later time. 

Data Menu 
The Data menu contains commands for calculating and changing the numerical data that 
defines the design. 

Units 
A variety of metric and imperial units may be specified.  
 
Irrespective of the default units specified, the Size, Grid Spacing, Girth, and Markers 
options, and data input windows will accept dimensional data in any units. For example, 
if the default units were metres, all of the following input would be accepted and 
converted accordingly: 
 
3 (interprets as 3.00 meters) 
2.5c 
33cm 
328mm 
650.44 mil 
6ft 3.1in 
5f 5i 
11.25 feet 
5’4" 
4 inches 
3.25" 

Coefficients 
Allows you to specify how you want to display the LCB and LCF position and how the 
hydrostatic calculations should be carried out. 
 
See Hydrostatic Coefficient Calculation Parameters on page 170 for more information. 

Grid Spacing 
This menu function allows you to specify the positions of Sections, Waterlines, Buttocks, 
and Diagonals. 
 
See Setting up the Grid on page 40 for more information. 

Frame of Reference 
Choosing this function allows you to set the positions of the Fore and Aft Perpendiculars, 
the DWL and the Baseline of the design; the Midship position is altered indirectly since 
it is assumed to be mid way between the Fore and Aft Perpendiculars. All values are 
entered relative to the Zero Point. However, it may be that the Zero Point is set to the 
position of one of the elements in the Frame of Reference. In this case the Zero Point is 
not updated until you have clicked OK in the Frame of Reference dialog. 
 
See Setting the Frame of Reference on page 36 for more information. 
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Zero Point 
This function sets the longitudinal and vertical reference point for all measurements. 
 
See Setting the Zero Point on page 37 for more information. 

Vessel Type 
Lets you specify the type of vessel you are modelling. See Setting the Vessel Type on 
page 38 for more information.  

Girth 
Measures halfgirths or locates the position at which a particular halfgirth occurs.  
 
See Calculate Girth on page 171 for more information. 

Calculate Offsets 
When Calculate Offsets is selected, the Offsets window will be filled with offset data for 
the grid that has been specified via the Grid Spacing command. 
 
See Offsets Window on page 76 for more information. 

Go to Offset 
This command allows you to select the station for which the offsets are displayed in the 
Offsets window. This item is available only when the Offsets window is active. 

Calculate Areas 
Calculates the areas and centres of the surfaces in the design. 
 
See Calculate Areas on page 171. 

Calculate Hydrostatics 
Calculates the upright hydrostatics of the design at the DWL. 
 
See Hydrostatics on page 169 for more information. 

Solve Calculations 
Choose this command to solve the calculations currently displayed in the Calculations 
window. The dialog box that appears can be used to set the longitudinal extent of the hull 
to be used in the calculations. 
 
See Calculations Window on page 82 for more information. 

Parametric Transformation 
Activates the Parametric Transformation dialog, which allows you to manipulate an 
existing design. 
 
See Using Parametric Transformation on page 173 for more information. 

AC Rule 
If you have a license for the America's Cup Rule software, this menu item will be 
available. Maxsurf will automatically measure your hull and calculate its rating under the 
America's Cup Rule. 
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Window Menu 
The Window menu allows you to make any window selected from the menu the active 
window. 

Cascade 
Displays all the Windows behind the active Windows. 

Tile Horizontal 
Lays out all visible windows across the screen. 

Tile Vertical 
Lays out all visible windows down the screen. 

Arrange Icons 
Rearranges the icons of any minimised window so that they are collected together at the 
bottom of the Maxsurf program window. 

Help Menu 
Provides access to the Maxsurf manual. 

Maxsurf Help 
Invokes the Maxsurf manual PDF file. 

Maxsurf Automation Help 
Invokes the Maxsurf Automation Help PDF manual. 

Maxsurf Automation Reference 
Invokes the Automation Reference help system. 

Online Support 
Provides access to a wide range of support resources available on the internet. 

Check for Updates 
Provides access to our website with the most recent version listed. 

About Maxsurf 
Displays information about the current version of Maxsurf you are using and other 
diagnostic information. Use this to obtain version and diagnostic information when 
reporting a problem to the Support Staff at Formation Design Systems. 
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Appendix A Data Export 
Maxsurf provides a number of alternative methods for transferring data between Maxsurf 
and other software applications on other computers. Each of the different methods of 
data transfer has various advantages and disadvantages. This appendix will help you 
determine which method is most suitable for your work. 
 
Broadly speaking the data interchange can be divided into five types. 

• Pictures and Text 

• 2D Drafting Data 

• 3D Drafting Data 

• 3D Surface Definition 
 

Pictures and Text 

Copying the drawing 
The drawing in any of the views may be copied in two ways: 
 
The first method will copy a scaled drawing to the clipboard which may then be pasted 
into another application such as MS Word. To do this select Copy from the Edit menu. 
 
Maxsurf supports the transfer of pictures and tables of text on the clipboard for use by 
other applications. (If you are not familiar with copying information to the clipboard, 
consult your computer's owner's guide.) In Maxsurf you can copy pictures by using the 
Copy command from the Edit menu or by using Ctrl C. 
 
When copying a design, the Copy dialog allows you to choose what scale you would like 
to copy the picture at. A picture on the clipboard can be pasted into word processors, 
page layout applications or drawing applications.  
 
The main disadvantage of pictures is their limited resolution. This effect may be 
minimized by copying at a large scale and then reducing the size of the picture in the 
destination application. Some CAD programs have a 'Re-scale when Pasting' option that 
allows you to reduce a set of lines copied into the Clipboard from Maxsurf at a 1:1 scale, 
down to the scale you are using at the time. 
 
The second method makes a copy of the actual screen image (similar to a copy made by 
screen capturing software or the print screen button). To activate this method, press Ctrl I 
whist in the view. Alternatively you can directly save the window image to a bitmap file 
by holding down the Shit key whilst pressing Ctrl I. This will then prompt you for the 
file name (by default the file name contains the design name and the view name). 

Copying Text 
As well as copying pictures to the clipboard, Maxsurf allows you to copy text from the 
Control Points, Markers and Offsets windows or any of the tables in the dialogs to the 
clipboard. It is also possible to Paste text into these windows. 
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Before copying or pasting you must select the range of data you wish to copy from or 
paste into. You can select a single cell, row, column, arbitrary rectangular range of cells 
or the whole table of data. You can click at the top of a column to select the whole 
column, click at the left of a row to select a whole row, and click at the top left of a table 
to select the whole table. 
 
Text copied from Maxsurf will be placed on the clipboard in "Tab Delimited Format". 
This means each number is separated from the next number in the row by a Tab 
character, and each row of numbers is terminated by a Return character. If you paste this 
text into a word processor or text editor such as Microsoft Word, the data will be 
displayed with each row on a separate line, and tabs between the numbers. If you paste 
the text into a spreadsheet such as Excel, the numbers will be displayed in individual 
cells exactly as they are shown in the tables in Maxsurf.  
 
If you hold down the Shift key while using the Copy command in a table, the headings of 
the columns will also be included in the clipboard. 
 
It is also possible to save the contents of the Control Points, Markers and Offsets 
windows as text files. With the appropriate window frontmost on the screen, choose Save 
As… from the File menu and Maxsurf will save the contents of the window into a text 
file. This data will also be in Tab Delimited Format, i.e. the contents of the text file will 
be exactly the same as the text placed on the clipboard if you copy the whole table. Text 
files created in this way can be read into a word processor, text editor or spreadsheet. 
 
If you wish to write a program that reads data from Maxsurf, these text files are an easy 
way to access the data. If you want to reconstruct a Maxsurf surface exactly, you can 
read in the control point positions and use them to generate the surface coordinates from 
the standard B-spline algorithm (see Appendix B Surface Algorithms on page 217).  

Note: 
Surface stiffness and other properties may be saved from the Surfaces 
window. 

2D Drafting Data 
Maxsurf includes support for IGES and DXF files, the two most commonly used 
interchange formats for computer-generated drawings. These files are the most effective 
way of transferring lines drawings to a CAD system for further drafting work. 
 
Two-dimensional output is always in the z=0 plane. The positive y-axis corresponds to 
the upward vertical screen axis and the positive x-axis to the right-hand-side horizontal 
screen axis. 
 
DXF (Drawing Exchange File) was originated by AutoCAD and is supported by almost 
all CAD systems on most platforms.  
 
IGES (Initial Graphics Exchange Standard) is a widely supported by CAD systems on all 
types of computers and is published by the US Dept of Commerce, National Bureau of 
Standards. IGES is widely supported by workstation and mainframe based CAD systems. 
 
These files are the most accurate way to transfer lines drawings from Maxsurf to a CAD 
system with data accurate to 5 decimal digits.  
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Note: 
Maxsurf designs exported in this way are at the current Maxsurf precision. 
For best quality, set the Maxsurf precision to High or Highest before writing 
the file.  

When you choose Export from the File menu, with a drawing window frontmost, 
Maxsurf will present you with the export dialog, allowing you to choose whether you 
wish to save DXF or IGES format data. If you choose either of these options and click 
OK, Maxsurf will ask you for the name of the file and allow you to save it to disk. This 
file will contain the DXF or IGES format data, which can then be read into your CAD 
system (e.g. using the DXFIN command in AutoCAD). Use the 2D option in the Export 
dialog to copy drawings in this way. 

Note:  
Many programs (such as AutoCAD) require a file extension for both DXF 
and IGES files. File names should have either the .DXF or .IGS extension 
appended to them. 

Maxsurf supports the DXF format and is compatible backwards to release 10. It supports 
the Line and Polyline entities. Each contour from Maxsurf will be saved as a polyline in 
the DXF file. 
 
Maxsurf supports IGES, version 4.0. It supports IGES entity number 106, the copious 
data entity. Each contour from Maxsurf is saved as a linear path of copious data, with x, 
y and z coordinates. 

3D Drafting Data 
If you use your CAD system in 3D, you can use the DXF or IGES methods to save the 
lines from the Maxsurf design as three-dimensional lines rather than just 2D. This allows 
you to do things like interior space planning in three dimensions. Choose the 3D IGES or 
3D DXF file format as required. 
 
Maxsurf exports 3D poly-line and surface data so that it will be correctly interpreted by a 
cad system which has the following right-handed co-ordinate system: x-axis, positive 
along the forward longitudinal axis of the vessel; y-axis, positive along the port 
transverse axis of the vessel; and z-axis, positive along the upward vertical axis. This 
means that the y-ordinates will be the negative of the Maxsurf “Offset” values since, in 
Maxsurf, “Offsets” are measured transversely, but positive to starboard. 
 
Maxsurf supports the 3DLine and 3DPolyline entities. Each contour from Maxsurf will 
be saved as a 3D polyline in the DXF file. 
 
Maxsurf supports IGES entity number 106. Each contour from Maxsurf is saved as a 
linear path of copious data, with x, y and z coordinates. 
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3D Surface Definition 
Maxsurf supports IGES entities, which allow you to transfer an exact surface description 
from Maxsurf, if you use a high end CAD system, such as Intergraph EMS, which 
supports B-spline surfaces. This is the most advanced and accurate way to transfer the 
model and ensures that accuracy is preserved. Use the Export function to export an IGES 
NURBS surface model in 3D. When your CAD system reads in the data it will accept the 
surfaces and will then allow you to manipulate them in any way that the system allows. 
 
As well as the usual contours, which are saved as IGES entity number 106, Maxsurf will 
save an IGES entity number 128 for each Maxsurf surface and any associated trimming 
data as entity 144. This entity is a NURB (Non Uniform Rational B-spline) surface, 
which has the positions of the control points and the stiffness of the surface stored within 
it. 
 
If you wish to write custom software that needs to read accurate Maxsurf surface 
descriptions, we recommend that you support input of the IGES file and this entity in 
particular as the most effective way of accessing the Maxsurf surface description. 
 
Please note that there are some surface topologies that may cause difficulties when they 
are exported as trimmed IGES surfaces. In these cases the trimming may have to be re-
done in the importing application. In most cases the trimmed IGES export should work 
correctly: For example the topology shown below with multiple edge and interior trims, 
including intersecting trim regions, will work correctly. 

 

There are two cases where IGES NURBS surface trimming is known to break down. The 
topology shown below (right), where a trim region contains an untrimmed region, will 
display correctly in Maxsurf but may not transfer correctly through IGES – this may be 
dependent on the receiving program. 
 
The major limitation of IGES NURBS transfer is in the interpretation of a surface that 
has been divided into two or more independent regions, as in the following examples: 
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Appendix B Surface Algorithms 
This appendix describes the mathematical basis of the Maxsurf models, and will be of 
interest to users who wish to write software to recreate Maxsurf surfaces. 
 
Maxsurf constructs its shapes using the Rational B-spline formulation as described by the 
IGES standard. Maxsurf uses a uniform knot vector. However, non-uniform knot vectors 
are permissible. 
 
B-spline curves and surfaces are dependent on a set of basis functions, which define the 
influence of each control point at any given point on the curve. The basis functions are 
determined by a vector of knots T where T = {t0,...,ti,ti+1,...,tm} and m = number of control 
points + order of the curve. The parameter t varies from zero to n – k + 2. In general, the 
B-spline basis function on a curve of degree p (order k = p + 1) is given by 
 
   1 if ti ≤ t < ti+1 and ti < ti+1 
 Ni,0((t) = 
   0 otherwise 
 
 Ni,p(t) = t - ti   Ni,p-1(t)   +       ti+p+1 - t    Ni+1,p-1(t)    
                  ti+p-ti                                                  ti+p+1 - ti+1                 assuming  0/0=0. 

 
The elements of the open uniform knot vector, ti , are given by 
 ti = 0    1 ≤ i ≤ k 
 ti = i - k  k + 1 ≤  i  ≤ n + 1 
 ti = n – k + 2 n + 2 ≤  i  ≤ n + k + 1 
 
where there are n+1 control points on the curve, and k  is the order of the curve   
(k = p + 1). 
 
A rational B-spline surface is given by  
 
                    m        n 

                    Σ  Σ  Ni,p(u)  Nj,q(v)  Wij Pij 
                    i=0      j=0 
 S(u,v) =   ______________________   _ 
                       m        n 

                      Σ  Σ  Ni,p(u) Nj,q(v) Wij 
                      i=0      j=0  
 
where S(u,v) is a point on the B-spline surface at parametric coordinates u,v, 
Ni,p(u) and Nj,q(v) are the B-spline basis functions, Wij  are the rational weighting values, 
and Pij are the control point positions.  
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The Pascal code to implement the uniform rational B-spline surface follows the setting 
up of the following variables - 

 
Read a Maxsurf Control Point File into the Cont_Points array. 
 
Set LimitU to the number of control point Columns used. 
Set LimitV to the number of control point Rows used. 
 
Set KValU to the Row Stiffness. 
Set KValV to the Column Stiffness. 
 
Stiffness: 

Linear: Order 2, Degree 1 (Linear)  
Flexible: Order 3, Degree 2 (Quadratic)  
 Order 4, Degree 3 (Cubic) 
 Order 5, Degree 4 (Quartic) 
Stiff: Order 6, Degree 5 (Quintic) 

 
Call CalcSurface to create B spline parametric surface 

 
{**********************************************************
******* 
PROGRAM B_Spline;  { © FORMATION DESIGN SYSTEMS LTD. 1990 } 
   
  TYPE 
  Point_3D = RECORD 
        x   : REAL; 
        y   : REAL; 
        z   : REAL 
       END; 
 
  ControlPoint4D = RECORD 
          x   : 
REAL; 
          y   : 
REAL; 
          z   : 
REAL 
    h  : REAL; 
         END; 
 VAR 
     knotN,knotK,I_Main  :INTEGER; 
  limitU,limitV    :INTEGER; 
  KValU,KValV     :INTEGER; 
  Cont_Points     
 :ARRAY[0..15,0..15] OF ControlPoint4D; 
   
{*****************************************************} 
FUNCTION Knot(i:INTEGER):INTEGER; 
 
 {CALCULATES UNIFORM KNOT VECTOR} 
{*****************************************************} 
  VAR 
    KnotVal      :INTEGER; 
  BEGIN 
    IF i < knotK THEN 
        KnotVal := 0 
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    ELSE 
        IF i > knotN THEN 
            KnotVal := knotN - knotK + 2 
        ELSE 
KnotVal := i - knotK + 1; 
Knot := KnotVal; 
 END; 
 
{*****************************************************} 
FUNCTION Bspline (i,k:INTEGER;u:REAL):REAL; 
 
{RECURSIVE BSPLINE BASIS VALUE CALCULATION} 
 
{*****************************************************} 
  VAR 
    t       :LONGINT; 
    v      :REAL; 
  BEGIN 
    IF k = 1 THEN 
      BEGIN 
        v := 0; 
        IF (Knot(i) <= u) & (u < Knot(i + 1)) THEN 
            v := 1; 
        IF (u = knotN - knotK + 2) & (I_Main = KnotN) THEN 
            v := 1; 
      END 
    ELSE 
      BEGIN 
        v := 0; 
        t := Knot(i + k - 1) - Knot(i); 
        IF t <> 0 THEN 
            v := (u - Knot(i)) * Bspline (i,(k - 1),u)/ t; 
        t := Knot(i + k) - Knot(i + 1); 
        IF t <> 0 THEN 
            v := v + (Knot(i + k) - u) * Bspline(i + 1,(k - 
1),u)/t; 
      END; 
    Bspline := v; 
  END; 
 
 
{*****************************************************} 
FUNCTION Calc_Bval(k,i,n:INTEGER;u:REAL):REAL; 
 
{CALCULATES BSPLINE BASIS VALUES} 
 
{*****************************************************} 
  BEGIN 
    IF K > n + 1 THEN 
        K := n + 1; 
    u := u * (n - K + 2); 
    I_Main := i;         {SET UP GLOBALS PRIOR TO 
RECURSION} 
    KnotK := K; 
    KnotN := n; 
    Calc_Bval := Bspline(i,K,u); 
  END; 
 
{*****************************************************} 
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FUNCTION Calc_Point(U,V:REAL):Point_3D; 
 
 {CALCULATES A PARTICULAR POINT ON A SURFACE} 
{*****************************************************} 
 
  VAR 
     i,j         :INTEGER; 
     B       :REAL; 
  shape_pt     :Point_3D; 
  BEGIN 
    shape_pt.x := 0; 
shape_pt.y := 0; 
    shape_pt.z := 0; 
  D:= 0; 
  FOR i := 0 to limitU DO 
    FOR j := 0 to limitV DO 
     BEGIN 
      B := 
Calc_Bval(KValU,i,limitU,U) *  
       
 Calc_Bval(KValV,j,limitV,V) *  
        Cont_Points[i,j].w; 
      D := D + B; 
      shape_pt.x := shape_pt.x + 
Cont_Points [i,j].x * B; 
      shape_pt.y := shape_pt.y + 
Cont_Points [i,j].y * B; 
      shape_pt.z := shape_pt.z + 
Cont_Points [i,j].z * B; 
     END; 
  shape_pt.x := shape_pt.x / D; 
  shape_pt.y := shape_pt.y / D; 
  shape_pt.z := shape_pt.z / D; 
  Calc_Point := shape_pt; 
  END; 
 
PROCEDURE CalcSurface; 
{*****************************************************} 
 
{CALCULATES ALL POINTS ON A SURFACE} 
{*****************************************************} 
 CONST 
  Res = 32; 
   VAR 
  Surface            :ARRAY[0..Res,0..Res] OF 
Point_3D; 
     l,m                :INTEGER; 
   
   BEGIN 
   FOR l := 0 to Res DO 
    FOR m := 0 to Res DO 
     Surface[l,m] := 
Calc_Point(l/Res,m/Res); 
   END; 
END. 
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Appendix C Command Keys 
There are several functions in Maxsurf that are not obvious to the user as they rely on 
key combinations to activate them.  
 
This is a summary of the various key combinations and their effects: 

• Modifier Keys 

• Special Keys 

• Control Point Weights 

• Menu Shortcuts 
 

Modifier Keys 
The following keys modify a function while they are held down. 
 
Shift or Ctrl - select of points.  
Adds or removes control points from the current selection. 
 
Shift - drag of points.  
Constrains movement to horizontal or vertical planes. 
 
Ctrl - drag of points.  
Lets you drag control points on a symmetrical surface over the centreline. 
 
Ctrl - while developable surface is drawing 
Calculates markers which can later be used as guides for designing a developable 
surface. 
 
Shift + Ctrl + C 
Copies the column headings along with the data in a data window such as control points 
or markers. 
 
Shift - While starting Maxsurf 
Will prompt you to reset the Maxsurf preferences. This will reset the windows registry. 
For more information see Windows Registry. 

Special Keys 
The following keys launch special commands 
 

Key Function 
Space bar Force a redraw of the front window 
F1 Help/Contents 
Ctrl+F6 Next Window 
Ctrl+Shift+F6 Previous Window 
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Control Point Weights  
The following keys change the weights of the currently selected control points. 
 

Key Keyboard symbol Function 
MultKey * Increase current weight by factor of 2.0 
DivKey / Divide current weight by 2.0 
PlusKey + Add 0.1 to current weight 
MinusKey - Subtract 0.1 from current weight 
ZeroKey 0 Set weight to 0.7071 (value required for mid 

point on a 3-point circular arc) 
1..9 1..9 Set weight to 1.0 to 9.0 respectively 

 

Menu Shortcuts 
The following keyboard shortcuts access menu commands 
Key Menu Function 
Ctrl+A Controls Add Column/Row 
Ctrl+C Edit Copy 
Ctrl+Shft+C Edit Copy, including the column headers 
Ctrl+D Controls Delete Column/Row 
Ctrl+E View Zoom 
Ctrl+F Edit Fill Down 
Ctrl+G Controls Group 
Ctrl+H View Home View 
Ctrl+I - Copy the design screen to a clipboard image 
Shift+Ctrl+I - Copy the design screen to a bitmap file 
Ctrl+K Controls Compact 
Ctrl+L Edit Delete Marker 
Ctrl+M Edit Add Marker 
Ctrl+N File New 
Ctrl+O File Open 
Ctrl+P File Print Preview 
Ctrl+R View Shrink 
Ctrl+S File Save 
Ctrl+T Surfaces Trim 
Ctrl+U Controls Ungroup 
Ctrl+V Edit Paste 
Ctrl+W View Pan 
Ctrl+X Edit Cut 
Ctrl+Y Edit Redo 
Ctrl+Z Edit Undo 
Ctrl+Insert Edit Copy 
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Shift+Insert Edit Paste 
Alt+Backspace Edit Undo 
Shift+Delete Edit Cut 



Appendix D Moving Files Across Platforms 

Page  224  

Appendix D Moving Files Across 
Platforms 
Maxsurf design and data files may be moved easily between PC an Macintosh 
computers. The data file structure used by the two formats is identical on both platforms. 
The changes required when moving files from Macintosh to PC are only to allow the 
Open File dialogs to determine the contents of the file. 

• Moving Files From Macintosh to Windows 

• Moving Files from Windows to Macintosh 
 

Moving Files From Macintosh to Windows 
Copy your Macintosh file to your Windows computer, either via a network or by 
inserting a DOS formatted floppy disk into your Macintosh computer and copying the 
required files onto the floppy disk. Put the disk into your PC and copy the files to the 
desired location on your PC's hard disk. 
 
It is necessary to add a file extension to the file name so that your PC can determine the 
contents of the file. If you already have Maxsurf installed on your PC, once you have 
added the correct .msd file extension to your Maxsurf design files, these files will have 
the Maxsurf icon associated with them. 
 
The following file extensions are given to files saved on the PC. Macintosh users 
copying files from Macintosh to PC should add the appropriate file extension so that the 
files are recognised correctly. 

 
Maxsurf  File Extension 
Maxsurf Design Files  .msd 

Maxsurf Calculation Files  .msc 

Marker, Offsets, Control Points Files .txt 

Data eXchange Files  .dxf 

Iges Files  .igs 

    
Hydromax   
Hydromax Loadcase Files  .hml 

Damage Case Files .dcs 

Tank Definition Files  .htk 

Down Flooding Points, Margin Line Points, 
Modulus Points, Output Data Files 

.txt 

Report(Rich Text Format)  .rtf 

    
Hydrolink   
USNA, IMSA NURBs, Output Data Files .txt 

Nakashima Stereo Files  .nst 
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Workshop   
Workshop Design Files  .wsd 

Materials Library Files  .wsl 

    
Hullspeed   
Hullspeed Measurement Files  .hsd 

    
Prefit   
Prefit Offsets Files  .pfd 

    
Span   
Span Data Files  .spd 

    
Seakeeper   
Seakeeper Data Files .sld 

    
Image Formats   
Quickdraw 3D Metafiles  .3dmf 

PICT Files  .pic 

Renderman Files  .rib 

Video for Windows  .avi 

    
Other   
Rich Text Format  .rtf 

Text Files .txt 

Temporary Files  .tmp 

EPS (expanded PostScript) Files  .eps 

 

Moving Files from Windows to Macintosh 
Windows Maxsurf designs with the file extension .msd will automatically open on the 
Macintosh. Other files must have their type and creator attributes changed once they 
have been copied to the Macintosh. This may be done with software such as ResEdit. 
The following type and creator attributes are required: 
 

Application and File type Type Creator 
Maxsurf   
Maxsurf Design Files  SHA3 SURF 
Maxsurf Calculation Files  TEXT SURF 
Marker, Offsets, Control Points Files TEXT MWRT 
Data eXchange Files  TEXT ???? 
Iges Files  TEXT ???? 
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Hydromax   
Hydromax Loadcase Files  CGDA SHED 
Tank Definition Files  TKDF STAB 
Down Flooding Points, Margin Line 
Points, Modulus Points, Output Data 
Files 

TEXT MWRT 

Report RPRT STAB 
   
Workshop   
Workshop Design Files  SHOP SHOP 
Materials Library Files  WSLB SHOP 
   
Hullspeed   
Hullspeed Measurement Files  ZIS1 ZIST 
   
Prefit   
Prefit Offsets Files  PFIN PFIT 
   
Span   
Span Data Files  QKS1 QKSL 
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